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Product comparison
The product is available in the following configurations.

HP LaserJet M2727nf mfp HP LaserJet M2727nfs mfp

● Prints letter-size pages at speeds up to 27 pages per
minute (ppm) and A4-size pages at speeds up to 26 ppm.

● PCL 5 and PCL 6 printer drivers and HP postscript level
3 emulation.

● Tray 1 holds up to 50 sheets of print media or up to 5
envelopes.

● Tray 2 holds up to 250 sheets of print media.

● Optional 250-sheet input tray (tray 3) available.

● Automatic two-sided (duplex) printing, fax receiving, and
copying.

● Average yield for the standard black print cartridge is
3,000 pages in accordance with ISO/IEC 19752. Actual
yield depends on specific use.

● Average yield for the high-capacity print cartridge is 7,000
pages in accordance with ISO/IEC 19752. Actual yield
depends on specific use.

● Hi-Speed USB 2.0 port and 10/100 Base-T network port.

● V.34 fax modem and 8-megabyte (MB) flash fax-storage
memory.

● Two RJ-11 fax phone line ports

● 64-MB random-access memory (RAM).

● Flatbed scanner and 50-page automatic document
feeder (ADF).

● One available DIMM slot for memory expansion (up to
320 MB).

HP LaserJet M2727nf mfp, plus:

● Additional 250-sheet input tray (tray 3) included.

● Convenience stapler.
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Product features
Performance ● Prints up to 27 ppm (letter) or 26 ppm (A4).

Print quality ● 1,200 dots per inch (dpi) with Image REt 2400 text and graphics.

● Adjustable settings to optimize print quality.

● The HP UltraPrecise print cartridge has a finer toner formulation that provides sharper text
and graphics.

Fax ● Full-functionality fax capabilities with a V.34 fax; includes a phone book, fax/tel, and
delayed-fax features.

Copy ● Includes ADF that allows faster, more efficient copy jobs with multiple-page documents.

Scan ● The product provides 1,200 pixels per inch (ppi), 24-bit full-color scanning from letter/A4-
size scanner glass.

● The product provides 300 ppi, 24-bit full-color scanning from the automatic document
feeder (ADF).

● Includes an ADF that allows faster, more efficient scan jobs with multiple-page documents.

Staple ● The HP LaserJet M2727nfs includes a convenience stapler for fast and convenient
stapling of up to 20 sheets of 80 g/m2 or 20 lb media at the product.

● Large-capacity replaceable staple cassette holds 1,500 staples.

Networking ● TCP/IP

◦ IPv4

◦ IPv6

Printer driver features ● Fast printing performance, built-in Intellifont and TrueType scaling technologies, and
advanced imaging capabilities are benefits of the PCL 6 printer language.

Interface connections ● Hi-Speed USB 2.0 port.

● 10/100 Base-T ethernet network port (RJ-45).

● RJ-11 fax/phone cable ports.

Economical printing ● N-up printing (printing more than one page on a sheet).

● Two-sided printing using the automatic duplexer.

● EconoMode setting.

Supplies ● A supplies status page that displays the amount of life remaining in the print cartridge.

● Authentication for HP print cartridges.

● Enabled supplies-ordering capability.

Accessibility ● Online user guide that is compatible with text screen-readers.

● Print cartridges can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.
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Product walkaround
Front view

1 Tray 2

2 Tray 1

3 Print-cartridge door latch

4 Top (face-down) output bin

5 Control panel

6 Automatic document feeder (ADF) input tray

7 Automatic document feeder (ADF) output bin

8 Convenience stapler (HP LaserJet M2727nfs mfp only)

9 Power switch

10 Optional tray 3 (standard on the HP LaserJet M2727nfs mfp)

Back view

14

13

12

11

11 Power connector

12 Rear output door (face-up output bin for the straight-through output path)

13 DIMM door

14 Interface ports
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Interface ports
The product has a 10/100 Base-T (RJ-45) network port, a Hi-Speed USB 2.0 port, and fax ports.

2 31

1 Hi-Speed USB 2.0 port

2 Network port

3 Fax ports

Serial number and model number location
The serial number and product model number label is on the rear output bin door at the back of the
product.
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Supported operating systems
The product supports the following operating systems:

Full software installation

● Windows XP (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Mac OS X v10.3, v10.4, and later

Print and scan driver

● Windows 2000

● Windows 2003 Server (32-bit and
64-bit)

Printer driver only

● Linux (Web only)

● UNIX model scripts (Web only)

NOTE: For Mac OS X v10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported product software
Software included with the product

There are several options for completing a recommended install. Easy Install will complete the
installation with default settings. Advanced Install allows you to select custom settings and choose the
components that are installed.

Recommended installation for Windows

● HP drivers

◦ PCL 6 printer driver

◦ Scan driver

● HP MFP software

◦ HP ToolboxFX

◦ HP LaserJet Scan program

◦ HP Send Fax program and driver

◦ HP Fax Setup Wizard

◦ Uninstall program

● HP Update program

● HP Customer Participation Program

● Shop for HP Supplies program

● Other programs

◦ Readiris OCR (not installed with other software; separate installation is required)
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Express installation (USB or network)
The following software is included with an Express installation:

● PCL 6 printer driver

● HP LaserJet Scan program and driver

NOTE: Express installation supports faxing by using the control panel.

NOTE: PCL 5 and HP postscript level 3 emulation drivers can be installed using the Microsoft Add
Printer wizard.

Macintosh software

● HP Product Setup Assistant

● HP Device Configuration

● HP Uninstaller

● HP LaserJet software

◦ HP Scan

◦ HP Director

◦ Fax program

◦ Scan to e-mail program

◦ HP Photosmart

Supported printer drivers

Operating system PCL 5 PCL 6 HP postscript level 3
emulation

Windows
1 1

Mac OS X v10.3, v10.4, and later

Linux2

1 Driver can be installed by using the Microsoft Add Printer wizard, too.
2 For Linux, download the HP postscript level 3 emulation driver from www.hp.com/go/linuxprinting.

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.

ENWW Supported product software 7
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2 Control panel

● Control-panel walkaround

● Control-panel menus
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Control-panel walkaround
51 32 4

05

06

07

08

Shift

1 Fax controls. Use the fax controls to change commonly used fax settings.

2 Alphanumeric buttons. Use the alphanumeric buttons to type data into the product control-panel display and dial
telephone numbers for faxing.

3 Setup and cancel controls. Use these controls to select menu options, determine the product status, and cancel the
current job.

4 Copy controls. Use these controls to change commonly used default settings and to start copying.

5 Scan controls. Use these controls to scan to e-mail or to a folder.
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Control-panel menus
Use the control-panel menus

To gain access to the control-panel menus, use the following steps.

1. Press Setup.

2. Use the arrow buttons to navigate the listings.

● Press OK to select the appropriate option.

● Press Cancel to cancel an action or return to the Ready state.

Control-panel main menus
These menus are available from the control-panel main menu:

● Use the Fax Job status menu to display a list of all faxes that are waiting to be sent, or have been
received but are waiting to be printed, forwarded, or uploaded to the computer.

● Use the Fax functions menu to configure fax functions such as scheduling a delayed fax,
cancelling the Receive to PC mode, reprinting faxes that were previously printed, or printing faxes
that are stored in memory.

● Use the Copy setup menu to configure basic copy default settings such as contrast, collation, or
the number of copies printed.

● Use the Reports menu to print reports that provide information about the product.

● Use the Fax setup menu to configure the fax phone book, the outgoing and incoming fax options,
and the basic settings for all faxes.

● Use the System setup menu to establish basic product settings such as language, print quality,
or volume levels.

● Use the Network config menu to configure network settings such as TCP/IP configuration.

● Use the Service menu to restore default settings, clean the product, and activate special modes
that affect print output.

NOTE: To print a detailed list of the entire control-panel menu and its structure, print a menu map.
See Information pages on page 142.

Table 2-1  Fax Job status menu

Menu item Description

Fax Job status Displays pending fax jobs, and allows you to cancel pending fax jobs.

Table 2-2  Fax functions menu

Menu item Description

Send fax later Allows a fax to be sent at a later time and date.

Stop Recv to PC Disables the Receive to PC setting that allows a computer to upload all current faxes that have
not been printed and all future faxes received by the product.
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Menu item Description

Reprint last Reprints the faxes that are stored in the product memory.

Polling receive Allows the product to call another fax machine that has polling send enabled.

Clear saved faxs Clears all faxes in the product memory.

Table 2-3  Copy setup menu

Menu item Sub-menu item Description

Default Quality Mixed

Picture

Film photo

Text

Sets the default copy quality.

Def. light/dark  Sets the default contrast option.

Def. Collation On

Off

Sets the default collation option.

Def. # of copies (Range: 1-99) Sets the default number of copies.

Def. Reduce/Enlrg Original=100%

Lgl->Ltr=78%

Lgl->A4=83%

A4–>Ltr=94%

Ltr->A4=97%

Full Page=91%

Fit to page

2 pages/sheet

4 pages/sheet

Custom:25-400%

Sets the default percentage to reduce or enlarge a copied
document.

Def. Tray Select Auto select

Tray 1

Tray 2

Tray 3 (if the tray is installed)

Sets the default input paper tray.

Default 2-sided 1 to 1 sided

1 to 2 sided

2 to 2 sided

2 to 1 sided

Sets the default input scan format and the default output
format. Two-sided printing is supported from the ADF only.

Def. Copy Draft On Sets the default draft mode option.

Table 2-2  Fax functions menu (continued)
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Menu item Sub-menu item Description

Off

Def. Multi-page On

Off

Sets the default multi-page flatbed copy option.

Restore defaults  Sets all customized copy settings to the factory default
values.

Table 2-4  Reports menu

Menu Item Sub-menu item Sub-menu item Description

Demo page   Prints a page that demonstrates print quality.

Fax Reports Fax Confirmation Never

Every fax

Send fax only

Receive fax

Sets whether or not the product prints a confirmation report
after a successful sending or receiving job.

Include 1st page On

Off

Sets whether or not the product includes a thumbnail image
of the first page of the fax on the report.

Fax Error Report Every error

Send Error

Receive Error

Never

Sets whether or not the product prints a report after a failed
sending or receiving job.

Last Call Report  Prints a detailed report of the last fax operation, either sent
or received.

Fax Activity log Print log now

Auto Log Print

Print log now: Prints a list of the faxes that have been sent
from or received by this product.

Auto Log Print: Select On to automatically print a report
after every fax job. Select Off to turn off the automatic print
feature.

PhoneBook report  Prints a list of the speed dials that have been set up for this
product.

Block Fax list  Prints a list of phone numbers that are blocked from sending
faxes to this product.

Billing report  Prints a list of billing codes that have been used for outgoing
faxes. This report shows how many sent faxes were billed
to each code. This menu item appears only when the billing
codes feature is turned on.

All fax reports  Prints all fax-related reports.

Menu structure   Prints a control-panel menu layout map. The active settings
for each menu are listed.

Config report   Prints a list of all the product settings. Includes network
information when the product is connected to the network.

Table 2-3  Copy setup menu (continued)
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Menu Item Sub-menu item Sub-menu item Description

Supplies status   Prints the print-cartridge status. Includes the following
information:

● Estimated pages remaining

● Serial number

● Number of pages printed

Network report   Displays status for:

● Network hardware configuration

● Enabled features

● TCP/IP and SNMP information

● Network statistics

Usage page   Displays the number of pages printed, faxed, copied, and
scanned by the product.

PCL font list   Prints a list of all installed PCL 5 fonts.

PS font list   Prints a list of all installed PS fonts.

PCL6 font list   Prints a list of all installed PCL 6 fonts.

Service page   Displays supported paper types, copy settings, and
miscellaneous product settings.

Table 2-5  Fax setup menu

Menu Item Sub-menu item Sub-menu item Description

Fax Header Your fax number

Company name

 Sets the identifying information that is sent to the receiving
product.

Phone Book Individual setup Add/Edit

Delete

Edits the fax phone book speed dials and group-dial entries.
The product supports up to 120 phone book entries, which
can be either individual or group entries.

Group setup Add/Edit group

Delete group

Del. # in group

Delete all  

Table 2-4  Reports menu (continued)
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Menu Item Sub-menu item Sub-menu item Description

Fax Send setup Def. Resolution Fine

Superfine

Photo

Standard

Sets the resolution for sent documents. Higher resolution
images have more dots per inch (dpi), so they show more
detail. Lower resolution images have fewer dots per inch and
show less detail, but the file size is smaller.

Def. light/dark  Sets the darkness of outgoing faxes.

Def. glass size Letter

A4

Sets the default paper size for documents being scanned
from the flatbed scanner.

Dialing Mode Tone

Pulse

Sets whether the product should use tone or pulse dialing.

Redial if busy On

Off

Sets whether or not the product should attempt to redial if
the line is busy.

Redial-no answer On

Off

Sets whether the product should attempt to dial if the
recipient fax number does not answer.

Redial Comm Err. On

Off

Sets whether the product should attempt to redial the
recipient fax number if a communication error occurs.

Dial Prefix On

Off

Specifies a prefix number that must be dialed when sending
faxes from the product.

Detect dial tone On

Off

Sets whether the product should check for a dial tone before
sending a fax.

Billing codes On

Off

Enables the use of billing codes when set to On. A prompt
will appear that asks you to enter the billing code for an
outgoing fax.

Table 2-5  Fax setup menu (continued)
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Menu Item Sub-menu item Sub-menu item Description

Fax Recv. setup Answer mode Automatic

TAM

Fax/Tel

Manual

Sets the type of answer mode. The following options are
available:

● Automatic: The product automatically answers an
incoming call on the configured number of rings.

● TAM: A telephone answering machine (TAM) is
attached to the Aux phone port of the product. The
product will not pick up any incoming call, but only listen
for fax tones after the answering machine has picked
up the call.

● Fax/Tel: The product must automatically pick up the
call and determine if the call is a voice or fax call. If the
call is a fax call, the product handles the call as usual.
If the call is a voice call, an audible synthesized ring is
generated to alert the user of an incoming voice call.

● Manual : The user must press the Start Fax button or
use an extension phone to make the product answer
the incoming call.

Rings to answer (Range of 1-9) Sets the number of rings that must occur before the fax
modem answers.

Answer Ring Type All Rings

Single

Double

Triple

Double&Triple

Allows a user to have two or three phone numbers on a
single line, each with a different ring pattern (on a phone
system with distinctive-ring service).

● All Rings: The product answers any calls that come
through the telephone line.

● Single: The product answers any calls that produce a
single-ring pattern.

● Double: The product answers any calls that produce a
double-ring pattern.

● Triple: The product answers any calls that produce a
triple-ring pattern.

● Double&Triple: The product answers any calls that
produce a double-ring or triple-ring pattern.

Extension Phone On

Off

When this feature is enabled, the user can press the 1-2-3
buttons on the extension phone to cause the product to
answer an incoming fax call.

Silence Detect On

Off

Sets whether the product can receive faxes from older
model fax machines that do not emit the initial fax tones used
during fax transmission.

Fit to page On

Off

Shrinks faxes that are larger than Letter-size or A4-size so
that they can fit onto a Letter-size or A4-size page. If this
feature is set to Off, faxes larger than Letter or A4 will print
on multiple pages.

Stamp faxes On

Off

Sets product to add the date, time, sender's phone number,
and page number to each page of the faxes that this product
receives.

Forward fax On

Off

Sets product to send all received faxes to another fax
machine.

Table 2-5  Fax setup menu (continued)
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Menu Item Sub-menu item Sub-menu item Description

 Block faxes Add entry

Delete entry

Clear all

Modifies the blocked fax list. The blocked fax list can contain
up to 30 numbers. When the product receives a call from
one of the blocked fax numbers, it deletes the incoming fax.
It also logs the blocked fax in the activity log along with job-
accounting information.

Private receive On

Off

Setting Private receive to On requires the user to have set
a password in product security. After the password is set,
the following options are set:

● Private receive is turned on.

● All old faxes are deleted from memory.

● Fax forwarding or Receive to PC are set to On and
are not allowed to be set.

● All incoming faxes are stored in memory.

Print faxes Prints stored faxes when the private-receive feature is on.
This menu item appears only when the private-receive
feature is turned on.

Reprint faxes On

Off

Sets whether all received faxes stored in available memory
can be reprinted.

F/T ring time 20

30

40

70

Sets when the product should stop sounding the Fax/Tel
audible ring to notify the user of an incoming voice call.

Print duplex On

Off

Sets whether all received faxes are printed using both sides
of the paper.

All faxes Error correction On

Off

Sets whether the product sends or receives the error portion
again when a fax transmission error occurs.

Fax Speed Fast(V.34)

Medium(V.17)

Slow(V.29)

Increases or decreases the allowed fax communication
speed.

Table 2-6  System setup menu

Menu Item Sub-menu item Sub-menu item Description

Language (List of available
control-panel
display languages.)

 Sets the language in which the control panel displays
messages and product reports.

Table 2-5  Fax setup menu (continued)
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Menu Item Sub-menu item Sub-menu item Description

Paper setup Def. paper size Letter

A4

Legal

Sets the size for printing internal reports or any print job that
does not specify a size.

Def. paper type Lists available
media types.

Sets the type for printing internal reports or any print job that
does not specify a type.

Tray 1 Paper type

Paper size

Sets the default size and type for tray 1.

Tray 2 Sets the default size and type for tray 2.

Tray 3 Sets the default size and type for optional tray 3. This menu
item appears only if tray 3 is installed.

Paper out action Wait forever

Cancel

Override

Determines how the product reacts when a print job requires
a media size or type that is unavailable or when a specified
tray is empty.

● Select Wait forever to make the product wait until the
correct media is loaded.

● Select Override to print on a different size paper after
a specified delay.

● Select Cancel to automatically cancel the print job after
a specified delay.

● If either Override or Cancel is chosen, the control
panel prompts for the number of seconds to delay. Use
the arrow keys to either decrease the time or increase
the time up to 3600 seconds.

Print quality Cartridge low (Range of 1-20) Sets the percentage at which the control panel generates a
low-toner message.

Replace supplies Stop at Out

Override out

 Sets how the product reacts when it detects that the print
cartridge is out.

Print Density (Range of 1-5)  Sets how much toner the product should apply to thicken
lines and edges.

Volume settings Alarm volume Soft

Medium

Loud

Off

Sets the volume levels for the product.

Ring volume

Key-press volume

Phoneline volume

Time/Date (Settings for time
format, current time,
date format, and
current date.)

 Sets the time and date setting for the product.

Product security On

Off

 Sets the product-security feature. When the setting is set to
On, you must set a personal identification number (PIN).

Courier font Regular

Dark

 Sets Courier font values.

Table 2-6  System setup menu (continued)
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Table 2-7  Service menu

Menu item Sub-menu item Description

Print T.30 trace Never

If error

At end of call

Now

Prints or schedules a report that is used to troubleshoot fax
transmission issues.

Cleaning mode  Cleans the product when specks or other marks appear on printed
output. The cleaning process removes dust and excess toner from
the paper path.

When selected, the product prompts you to load plain Letter or A4
paper in tray 1. Press OK to begin the cleaning process. Wait until
the process completes. Discard the page that prints.

USB speed High

Full

Sets the USB speed.

Less paper curl On

Off

When printed pages are consistently curled, this option sets the
product to a mode that reduces curl.

The default setting is Off.

Archive print On

Off

When printing pages that will be stored for a long time, this option
sets the product to a mode that reduces toner smearing and
dusting.

The default setting is Off.

Restore defaults  Sets all customized settings to the factory default values.

Table 2-8  Network config menu

Menu item Sub-menu item Description

TCP/IP config Automatic

Manual

Automatic automatically configures all the TCP/IP settings via
DHCP, BootP or AutoIP.

Manual requires you to manually configure the IP address, subnet
mask, and default gateway.

The control panel prompts you to specify values for each address
section. Use the arrow buttons to increase or decrease the value.
Press OK to accept the value and move the cursor to the next field.

As each address is completed, the product prompts for address
confirmation before moving to the next one. After all three
addresses are set, the product automatically restarts.

Link speed Automatic

10T Full

10T Half

100TX Full

100TX Half

Sets the link speed manually if needed.

After setting the link speed, the product automatically restarts.

Auto crossover On Sets the auto crossover function.
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Menu item Sub-menu item Description

Off

Network services IPv4

IPv6

Sets whether the product will use either IPv4 or IPv6 protocol.

Show IP Address Yes

No

Sets whether the product displays the IP address on the control
panel.

Restore defaults  Resets all network configurations to their factory defaults.

Table 2-8  Network config menu (continued)
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3 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● Select the correct printer driver for Windows

● Priority for print settings

● Change printer-driver settings for Windows

● Software installation types for Windows

● Remove software for Windows

● Supported utilities for Windows

● Software for other operating systems
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Supported operating systems for Windows
The product supports the following Windows operating systems:

Full software installation

● Windows XP (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

Print and scan driver

● Windows 2000

● Windows 2003 Server (32-bit and 64-bit)

Supported printer drivers for Windows
● PCL 5

● PCL 6

● PS level 3 emulation

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.

Select the correct printer driver for Windows
Printer drivers allow you to gain access to the device features and allow the computer to communicate
with the device (using a printer language). Check the installation notes and readme files on the device
CD for additional software and languages.

● Use the PCL 6 printer driver for the best overall performance.

● Use the PCL 5 printer driver for general office printing.

● Use the HP postscript level 3 emulation driver for printing from postscript level 3 emulation needs,
or for postscript flash font support.
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Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

Change printer-driver settings for Windows
To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

1. On the File menu in the software
program, click Print.

2. Select the driver, and then click
Properties or Preferences.

The steps can vary; this procedure is
most common.

1. Click Start, click Settings, and then
click Printers (Windows 2000) or
Printers and Faxes (Windows XP
Professional and Server 2003) or
Printers and Other Hardware
Devices (Windows XP Home).

For Windows Vista, click Start, click
Control Panel, and then click
Printer.

2. Right-click the driver icon, and then
select Printing Preferences.

1. Click Start, click Settings, and then
click Printers (Windows 2000) or
Printers and Faxes (Windows XP
Professional and Server 2003) or
Printers and Other Hardware
Devices (Windows XP Home).

For Windows Vista, click Start, click
Control Panel, and then click
Printer.

2. Right-click the driver icon, and then
select Properties.

3. Click the Device Settings tab.
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Software installation types for Windows
The following software installation types are available:

● Recommended. Installs the full software solution.

● Express. Installs the printer drivers only. There is an express option for USB-connected products
and another express option for network-connected products.

● Custom. Use the Custom installation to select which software and drivers to install.

Remove software for Windows
1. Click Start, and then click Programs or All Programs.

2. Click HP, and then click HP LaserJet M2727.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.
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Supported utilities for Windows
HP ToolboxFX

The HP ToolboxFX is a program that you can use for the following tasks:

● Checking the device status

● Checking the supplies status

● Setting up alerts

● Viewing device documentation

● Gaining access to troubleshooting and maintenance tools

HP ToolboxFX is installed during the Recommended software installation from the product CD-ROM.

For more information, see View HP ToolboxFX on page 144.

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages on page 142.)

For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server on page 153.

HP Web Jetadmin
HP Web Jetadmin is a browser-based management tool for network-connected printers within an
intranet, and it should be installed only on the network administrator’s computer.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer 4.x or Netscape Navigator 4.x or later)
by navigating to the HP Web Jetadmin host.

Other Windows components and utilities
● Software installer — automates the printing system installation

● Online Web registration
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● HP Customer Participation Program

● HP Update

Software for other operating systems
OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/support/net_printing to download the
HP Jetdirect printer installer for UNIX.

Linux For information, go to www.hp.com/go/linuxprinting.
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4 Use the product with Macintosh

● Software for Macintosh

● Use features in the Macintosh printer driver

● Scan from the product and HP Director (Macintosh)

● Fax a document from a Macintosh computer
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Software for Macintosh
Supported operating systems for Macintosh

The device supports the following Macintosh operating systems:

● Mac OS X v10.3, v10.4 and later

NOTE: For Mac OS v10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported printer drivers for Macintosh
The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.

The PPDs, in combination with the Apple PostScript printer drivers, provide access to device features.
Use the Apple PostScript printer driver that comes with the computer.

Priority for print settings for Macintosh
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

Change printer-driver settings for Macintosh

To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

1. On the File menu, click Print.

2. Change the settings that you want
on the various pop-up menus.

1. On the File menu, click Print.

2. Change the settings that you want
on the various pop-up menus.

3. On the Presets pop-up menu, click
Save as and type a name for the
preset.

1. In the Finder, on the Go menu, click
Applications.

2. Open Utilities, and then open
Printer Setup Utility.

3. Click on the print queue.
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To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

These settings are saved in the
Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print.

4. On the Printers menu, click Show
Info.

5. Click the Installable Options
menu.

NOTE: Configuration settings might
not be available in Classic mode.

Software installation types for Macintosh

Install Macintosh software for direct connections (USB)
1. Connect a USB cable between the device USB port and the computer USB port. Use a standard

2-meter (6.56-foot) USB cable.

2. Insert the device CD into the CD-ROM drive and run the installer. If the CD menu does not run
automatically, double-click the CD icon on the desktop.

3. Double-click the Installer icon in the HP LaserJet Installer folder.

4. Follow the instructions on the computer screen.

USB printer queues are created automatically when the device is attached to the computer.
However, the queue will use a generic PPD if the installer has not been run before the USB cable
is connected. Complete the following steps to change the queue PPD.

5. On the computer hard drive, open Applications, open Utilities, and then open Printer Setup
Utility.

6. Select the correct printer queue, and then click Show Info to open the Printer Info dialog box.

7. In the pop-up menu, select Printer Model, and then, in the pop-up menu in which Generic is
selected, select the correct PPD for the device.

8. Print a test page from any software program to make sure that the software is correctly installed.

If installation fails, reinstall the software. If this fails, see the installation notes or late-breaking
readme files on the device CD or the flyer that came in the box for help.

Install Macintosh software for networks
1. Connect the network cable between the HP Jetdirect print server and a network port.

2. Insert the CD into the CD-ROM drive. If the CD does not run automatically, double-click the CD
icon on the desktop.

3. Double-click the Installer icon in the HP LaserJet Installer folder.

4. Follow the instructions on the computer screen.

5. On the computer hard drive, open Applications, open Utilities, and then open Printer Setup
Utility.
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6. Click Add Printer.

7. Select Rendezvous or Bonjour as the connection type.

NOTE: Depending on product configuration, Appletalk or IP Printing might also be available.

8. Select the device from the list.

9. Click Add Printer.

10. Close the Print Center or the Printer Setup Utility.

Remove software from Macintosh operating systems
To remove the software from a Macintosh computer, drag the PPD files to the trash can.

Supported utilities for Macintosh

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages on page 142.)

For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server on page 153.

Macintosh Configure Device
Macintosh Configure Device is a Web-based program that provides access to information about the
product (for example, information about supplies status and product settings). Use Macintosh Configure
Device to monitor and manage the product from the computer

NOTE: You must perform a complete software installation to use Macintosh Configure Device.

● Check the product status and print information pages.

● Check and change product system settings.

● Check default print settings.

● Check and change fax settings, including fax send, fax receive, fax phone book and speed-dial
settings, and fax reports.

● Check and change network settings, including IP configuration, Advanced, mDNS, SNMP, network
configuration, and password.

You can view Macintosh Configure Device when the product is directly connected to your computer or
when it is connected to the network.
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NOTE: You do not have to have Internet access to open and use Macintosh Configure Device.

View Macintosh Configure Device when the product is directly connected to the computer

1. Open HP Director by clicking the HP Director icon in the dock.

2. In HP Director, click Settings.

3. Select Configure device to open the Macintosh Configure Device home page in a browser.

View Macintosh Configure Device when the product is connected to a network

1. Open one of the following supported Web browsers:

● Safari 1.2 or later

● Microsoft Internet Explorer 5.0 or later

● Netscape Navigator 4.75 or later

● Opera 6.05 or later

2. Enter the IP address of the product into the Web browser to open the Macintosh Configure Device
home page.
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Use features in the Macintosh printer driver
Print

Create and use printing presets in Macintosh
Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click Print.

2. Select the driver.

3. Select the print settings.

4. In the Presets box, click Save As..., and type a name for the preset.

5. Click OK.

Use printing presets

1. On the File menu, click Print.

2. Select the driver.

3. In the Presets box, select the printing preset that you want to use.

NOTE: To use printer-driver default settings, select Factory Default.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.

1. On the File menu, click Print.

2. Open the Paper Handling menu.

3. In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).

1. On the File menu, click Print.

2. Select the driver.

3. Open the Cover Page pop-up menu, and then select whether to print the cover page Before
Document or After Document.

4. In the Cover Page Type pop-up menu, select the message that you want to print on the cover
page.

NOTE: To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.

1. On the File menu, click Print.

2. Open the Watermarks menu.

3. Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4. Next to Pages, select whether to print the watermark on all pages or on the first page only.

5. Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6. Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1. On the File menu, click Print.

2. Select the driver.

3. Open the Layout pop-up menu.

4. Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

5. Next to Layout Direction, select the order and placement of the pages on the sheet.

6. Next to Borders, select the type of border to print around each page on the sheet.
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Print on both sides of the page (duplex printing)

Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

● For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

2. On the File menu, click Print.

3. Open the Layout pop-up menu.

4. Next to Two-Sided, select either Long-Edge Binding or Short-Edge Binding.

5. Click Print.

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

● For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28-lb bond).

2. On the File menu, click Print.

3. On the Finishing pop-up menu, select the Manual Duplex option.

4. Click Print. Follow the instructions in the pop-up window that appears on the computer screen
before replacing the output stack in tray 1 for printing the second half.

5. Go to the printer, and remove any blank paper that is in tray 1.

6. Insert the printed stack face-up with the bottom edge feeding into the printer first in tray 1. You
must print the second side from tray 1.

7. If prompted, press the appropriate control-panel button to continue.

Use the Services menu
If the device is connected to a network, use the Services menu to obtain device and supply-status
information.

1. On the File menu, click Print.

2. Open the Services menu.

3. Select a maintenance task from the drop-down list, and then click Launch. The embedded Web
server opens to the page that provides the information for the task that you selected.

4. To go to various support Web sites for this device, select an Internet Services option from the drop-
down list, and then click Go!.
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Scan from the product and HP Director (Macintosh)
For more information about tasks and settings described in this section, see the HP Director online Help.

Scanning tasks
To scan to a software program, scan an item using the program itself. Any TWAIN-compliant program
can scan an image. If the program is not TWAIN-compliant, save the scanned image to a file then place,
open, or import the file in the software program.

Use page-by-page scanning

1. Lift the flatbed scanner lid and load the original that is to be scanned face-down on the flatbed
scanner with the upper-left corner of the document at the lower-right corner of the glass. Gently
close the lid.

2. Double-click the HP Director desktop alias.

3. Click the HP Director, and then click Scan to open the HP dialog box.

4. Click Scan.

5. To scan multiple pages, load the next page and click Scan. Repeat until all pages are scanned.

6. Click Finish, and then click Destinations.

Scan to file

1. In Destinations, choose Save To File(s).

2. Name the file and specify the destination location.

3. Click Save. The original is scanned and saved.

Scan to e-mail

1. In Destinations, chooseE-mail.

2. A blank e-mail opens with the scanned document as an attachment.

3. Enter an e-mail recipient, add text, or other attachments, then click Send.
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Fax a document from a Macintosh computer
1. In the software program, on the File menu, select Print.

2. Click PDF, and then select Fax PDF.

3. Enter a fax number in the To field.

4. To include a fax cover page, select Use Cover Page, and then enter the cover page subject and
message (optional).

5. Click Fax.
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5 Connectivity

● Connect the product directly to a computer with USB

● Printer sharing disclaimer

● Supported network operating systems

● Supported network protocols

● Install the product on a network

● Configure the network product

NOTE: Configuring TCP/IP settings is complicated and should be performed only by experienced
network administrators. BOOTP will require a server to configure specific TCP/IP settings for the
product. DHCP will also require a server, but the TCP/IP settings will not be fixed for the product. Finally,
the manual method to configure specific TCP/IP settings can be done from the control panel, the
embedded Web server, HP ToolboxFX, or HP Web Jetadmin. For additional help or network
configuration, contact your network provider.
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Connect the product directly to a computer with USB
NOTE: Do not connect the USB cable from the product to the computer until the installer prompts you
to do so.

1. Insert the product CD into your computer. If the software installer does not start, navigate to the
setup.exe file on the CD and double-click the file.

2. Follow the installer instructions.

3. Allow the installation process to complete, and then restart the computer.

Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Supported network operating systems
The following operating systems support network printing:

Full software installation

● Windows XP (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Mac OS X v10.3, v10.4, and later

Print and scan driver

● Windows 2000

● Windows 2003 Server (32-bit and
64-bit)

Printer driver only

● Linux (Web only)

● UNIX model scripts (Web only)
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Supported network protocols
The product supports the TCP/IP network protocol. It is the most widely used and accepted networking
protocol. Many networking services utilize this protocol. This product also supports IPv4 and IPv6. The
following tables list the networking services/protocols that are supported on the product.

Table 5-1  Printing

Service name Description

port9100 (Direct Mode) Printing service

Line printer daemon (LPD) Printing service

Table 5-2  Network product discovery

Service name Description

SLP (Service Location Protocol) Device Discovery Protocol, used to help find and configure
network devices. Used primarily by Microsoft-based software
programs.

mDNS (multicast Domain Name Service - also known as
“Rendezvous” or “Bonjour”)

Device Discovery Protocol, used to help find and configure
network devices. Used primarily by Apple Macintosh-based
software programs.

Table 5-3  Messaging and management

Service name Description

HTTP (hypertext transfer protocol) Allows Web browsers to communicate with embedded Web
server.

EWS (embedded Web server) Allows a user to manage the product through a Web browser.

SNMP (simple network management protocol) Used by network programs for product management. SNMP
V1 and standard MIB-II (Management Information Base)
objects are supported.

Table 5-4  IP addressing

Service name Description

DHCP (dynamic host configuration protocol) For Automatic IP address assignment. DHCP server provides
the product with an IP address. Generally requires no user
intervention for product to obtain IP address from a DHCP
server.

BOOTP (bootstrap protocol) For Automatic IP address assignment. BOOTP server
provides the product with an IP address. Requires
administrator to input the product MAC hardware address on
BOOTP server in order for product to obtain an IP address from
that server.

Auto IP For Automatic IP address assignment. If neither a DHCP
server nor a BOOTP server is present, this service allows the
product to generate a unique IP address.
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Install the product on a network
In this configuration, the product is connected directly to the network and can be configured to allow all
computers on the network to print directly to the product.

NOTE: This mode is the recommended network configuration for the product.

1. Before turning on the product, connect the product directly to the network by inserting a network
cable into the product network port.

2. Turn on the product, wait 2 minutes, and then use the control panel to print a configuration page. .

NOTE: Make sure that an IP address is listed on the configuration page before proceeding to the
next step. If an IP address is not present, reprint the configuration page.

3. Insert the product CD into the computer. If the software installer does not start, navigate to the
setup.exe file on the CD and double-click the file.

4. Follow the installer instructions.

NOTE: When the installer prompts for a network address, provide the IP address listed on the
configuration page that you printed before starting the installer program, or search for the product
on the network.

5. Allow the installation process to complete, and then restart the computer.
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Configure the network product
View settings

Network configuration page
The network configuration page lists the current settings and properties of the product network card. To
print the network configuration page from the product, complete the following steps.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Network report, and then press OK.

Configuration page
The configuration page lists the current settings and properties of the product. You can print a
configuration page from the product or HP ToolboxFX. To print the configuration page from the product,
complete the following steps.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Config report, and then press OK.

A second page also prints. On that page, the Fax Settings and Imaging Settings sections provide
details about the product fax settings.

Change settings
You can use the embedded Web server (EWS) or HP ToolboxFX to view or change the IP configuration
settings. To gain access to the embedded Web server, type the product IP address in the address line
of a Web browser.

You can view HP ToolboxFX when the product is directly connected to a computer or when it is
connected to the network. You must perform a complete software installation to use HP ToolboxFX.

Open HP ToolboxFX in one of these ways:

● In the Windows system tray, double-click the HP ToolboxFX icon.

● On the Windows Start menu, click Programs (or All Programs in Windows XP), click HP, click
the product name, and then click HP ToolboxFX.

In HP ToolboxFX, click the Network Settings tab.

From the Networking tab (EWS) or the Network Settings tab (HP ToolboxFX), you can change the
following configurations:

● Host Name

● Manual IP Address

● Manual Subnet Mask

● Manual Default Gateway
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NOTE: Changing the network configuration might require you to change the browser URL before you
can communicate with the product again. The product will be unavailable for a few seconds while the
network resets.

IP address
The product IP address can be set manually, or it can be configured automatically via DHCP, BootP, or
AutoIP.

Manual configuration
1. On the control panel, press Setup.

2. Use the arrow buttons to select Network config, and then press OK.

3. Use the arrow buttons to select TCP/IP config, and then press OK.

4. Use the arrow buttons to select Manual, and then press OK.

5. Use the alphanumeric buttons to type the IP address, and then press OK.

6. If the IP address is incorrect, use the arrow buttons to select No, and then press OK. Repeat step
5 with the correct IP address, and then repeat step 5 for the subnet mask and default gateway
settings.

Automatic configuration
1. On the control panel, press Setup.

2. Use the arrow buttons to select Network config, and then press OK.

3. Use the arrow buttons to select TCP/IP config, and then press OK.

4. Use the arrow buttons to select Automatic, and then press OK.

It may take several minutes before the automatic IP address is ready for use.

NOTE: If you want to disable or enable specific automatic IP modes (such as BOOTP, DHCP, or
AutoIP), these settings can be changed by using the embedded Web server or HP ToolboxFX only.

IPv4 and IPv6 settings
Only the IPv4 protocol can be configured manually. The IPv4 protocol can be set from HP ToolboxFX
or from the product control panel. The IPv6 protocol can be selected only from the product control panel.

Link speed setting
NOTE: Incorrect changes to the link speed setting might prevent the product from communicating with
other network devices. For most situations, the product should be left in automatic mode. Changes can
cause the product to power cycle. Changes should be made only while the product is idle.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Network config, and then press OK.

3. Use the arrow buttons to select Link speed, and then press OK.

42 Chapter 5   Connectivity ENWW



4. Use the arrow buttons to select one of the following settings.

● Automatic

● 10T Full

● 10T Half

● 100TX Full

● 100TX Half

NOTE: The setting must match with the network product to which you are connecting (a network
hub, switch, gateway, router, or computer).

5. Press OK. The product will power cycle.
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6 Paper and print media

● Understand paper and print media use

● Supported paper and print media sizes

● Special paper or print media guidelines

● Load paper and print media

● Configure trays

● Change tray selection
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Understand paper and print media use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:

● Poor print quality

● Increased jams

● Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Supported paper and print media sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best print results, select the appropriate paper size and type in the print driver before
printing.

Table 6-1  Supported paper and print media sizes

Size Dimensions Tray 1 Trays 2 and 3

Letter 216 x 279 mm (8.5 x 11 inches)

Legal 216 x 356 mm (8.5 x 14 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Executive 184 x 267 mm (7.24 x 10.51 inches)

A3 297 x 420 mm (11.69 x 16.54 inches)   

A5 148 x 210 mm (5.83 x 8.27 inches)

A6 105 x 148 mm (4.13 x 5.83 inches)  

B5 (JIS) 182 x 257 mm (7.17 x 10.12 inches)

16k 197 x 273 mm (7.75 x 10.75 inches)  

16k 195 x 270 mm (7.7 x 10.6 inches)  

16k 184 x 260 mm (7.25 x 10.25 inches)  

8.5 x 13 216 x 330 mm (8.5 x 13 inches)

4 x 61 107 x 152 mm (4 x 6 inches)  

5 x 81 127 x 203 mm (5 x 8 inches)  

10 x 15 cm1 100 x 150 mm (3.9 x 5.9 inches)  

Custom Tray 1: Minimum—76 x127 mm (3 x 5 inches);
Maximum—216 x 356 mm (8.5 x 14 inches)

 

Trays 2 and 3: Minimum—148 x 210 mm (5.8 x
8.3 inches); Maximum—216 x 356 mm (8.5 x
14 inches)

 

1 These sizes are supported as custom sizes.

Table 6-2  Supported envelopes and postcards

Size Dimensions Tray 1 Trays 2 and 3

Envelope #10 105 x 241 mm (4.13 x 9.49 inches) Not supported.
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Size Dimensions Tray 1 Trays 2 and 3

Envelope DL 110 x 220 mm (4.33 x 8.66 inches) Not supported.

Envelope C5 162 x 229 mm (6.93 x 9.84 inches) Not supported.

Envelope B5 176 x 250 mm (6.7 x 9.8 inches) Not supported.

Envelope Monarch 98 x 191 mm (3.9 x 7.5 inches) Not supported.

Postcard 100 x 148 mm (3.94 x 5.83 inches) Not supported.

Double postcard 148 x 200 mm (5.83 x 7.87 inches) Not supported.

Special paper or print media guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.

CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this
technology could damage your printer.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use Labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles
or bubbles, or are damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in laser printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless

Table 6-2  Supported envelopes and postcards (continued)
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Media type Do Do not

it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.

Load paper and print media
Tray 1

Tray 1 is accessed from the front of the product. The product prints from tray 1 before attempting to print
from other trays.

Tray 1 holds up to 50 sheets of 75 g/m2 (20 lb) media or five envelopes, ten transparencies, or ten cards.
You can use tray 1 to print the first page on media different from the remainder of the document.

Media guides ensure that the media is correctly fed into the product and that the print is not skewed
(crooked on the media). When loading media, adjust the media guides to match the width of the media
that you are using.

ENWW Load paper and print media 49



Tray 2 or 3
Tray 2 and optional tray 3 hold up to 250 pages of 75 g/m2 (20 lb) paper, or fewer pages of heavier
media (25 mm (0.9 in) or less stack height). Load media with the top forward and the side to be printed
on facing down.

Media guides ensure that the media feeds correctly into the product and that the print is not skewed.
Tray 2 has side and rear media guides. When loading media, adjust the media guides to match the
length and width of the media that you are using.

NOTE: When you add new media, make sure that you remove all of the media from the input tray and
straighten the stack of new media. Do not fan the media. This reduces jams by preventing multiple
sheets of media from feeding through the product at one time.
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Configure trays
When using one of the trays for specific size of paper, you can set the default size for the tray in
HP ToolboxFX or from the control panel. In HP ToolboxFX, select Paper handling, and then select the
size for the tray you want to set. When you select that size of paper for a print job in the print dialog, the
product automatically selects that tray for printing.

To set the default paper size or type from the control panel, complete the following steps.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the arrow keys to select Paper setup, and then press OK.

4. Use the arrow keys to select the tray to be configured, and then press OK.

5. Use the arrow keys to select either Paper type or Paper size, and then press OK.

6. Use the arrow keys to select a default type or size for the tray, and then press OK.

Change tray selection
The product is set to automatically pull media from trays that contain media. The product always pulls
media from tray 1 if you insert media into tray 1. If there is no media in tray 1, the product attempts to
pull media from tray 3, if installed, and then from tray 2.

You can specify which tray you want to use by changing the tray selection. Auto select, Tray 1, Tray
2, and Tray 3 are available settings. Auto select will pull media from the first available tray with the
appropriate matching media loaded.

NOTE: Tray 3 is only available if a tray 3 is installed.

Change the tray selection for the current job

1. On the product control panel, press Tray Select.

2. Use the arrow buttons to select the input tray that you want to use.

3. Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.

Change the default tray selection

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Def. Tray Select, and then press OK.

4. Use the arrow buttons to select a tray setting, and then press OK.
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7 Print tasks

This section provides information about common printing tasks.

● Change the print driver to match the media type and size

● Get help for any print option

● Cancel a print job

● Create booklets

● Change print-quality settings

● Change print density

● Print on special media

● Use different paper and print covers

● Print a blank first page

● Resize documents

● Select a paper size

● Select a paper source

● Select a paper type

● Set the print orientation

● Use watermarks

● Save toner

● Create and use printing shortcuts in Windows

● Print on both sides of the paper (duplex printing)

● Print multiple pages on one sheet of paper in Windows

● Economy settings

● Fonts

NOTE: Many of the functions that are described in this chapter also can be performed by using
HP ToolboxFX. For instructions, see the HP ToolboxFX online Help.

ENWW 53



Change the print driver to match the media type and size
Selecting media by type and size results in significantly better print quality for heavy paper, glossy paper,
and overhead transparencies. Using the wrong setting can result in unsatisfactory print quality. Always
print by Type for special print media, such as labels or transparencies. Always print by Size for
envelopes.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Paper Type or Paper Size list box, select the correct media type or size.

5. Click OK.

Supported paper types and tray capacity
This product has the following tray priority for feeding print media:

1. Tray 1 (if open)

2. Tray 2

3. Optional tray 3 (if attached)

Minimum media dimensions are 76 x 127 mm (3 x 5 in).

Maximum media dimensions are 216 x 356 mm (8.5 x 14 in).

To obtain the best print results, change the paper size and paper type settings in the printer driver before
printing.

Type is Media specifications Tray 1 capacity1 Tray 2 and optional tray 3
capacity2

Plain

Color

Preprinted

Prepunched

Recycled

75 g/m2 (20 lb) to 104 g/m2 (27
lb)

Up to 50 sheets Up to 250 sheets

Light 60 g/m2 (16 lb) to 75 g/m2 (20 lb) Up to 50 sheets Up to 250 sheets

Envelopes Less than 90 g/m2 (24 lb) Up to 5 envelopes Not supported.

Labels Standard Up to 10 sheets Not supported.

Bond 75 g/m2 (20 lb) to 104 g/m2 (27
lb)

Up to 10 sheets Up to 250 sheets

Rough 75 g/m2 (20 lb) to 104 g/m2 (27
lb)

Up to 10 sheets Up to 200 sheets

Transparencies 4 mm (0.1 inches) Monochrome
Overhead

Up to 10 sheets Not supported.
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Type is Media specifications Tray 1 capacity1 Tray 2 and optional tray 3
capacity2

Mid weight 95 g/m2 (25 lb) to 110 g/m2 (29
lb)

Up to 10 sheets Up to 200 sheets

Heavy 110 g/m2 (29 lb) to 125 g/m2 (33
lb)

Up to 10 sheets Not supported.

Extra heavy 125 g/m2 (33 lb) to 176 g/m2 (47
lb)

Up to 10 sheets Not supported.

Letterhead 75 g/m2 (20 lb) to 104 g/m2 (27
lb)

Up to 10 sheets Up to 250 sheets

1 The maximum stack height for tray 1 is 5 mm (0.2 inches).
2 The maximum stack height for tray 2 is 25 mm (1 inch).

Get help for any print option
Printer-driver Help is separate from program Help. The printer-driver help provides explanations for the
buttons, check boxes, and drop-down lists that are in the printer driver. It also includes instructions for
performing common printing tasks, such as printing on both sides, printing multiple pages on one sheet,
and printing the first page or covers on different paper.

Activate the printer-driver Help screens in one of the following ways:

Windows Macintosh

● In the printer driver Properties dialog box, click the
Help button.

● Press the F1 key on the computer keyboard.

● Click the question-mark symbol in the upper-right corner
of the printer driver.

● Right-click on any item in the driver, and then click What's
This?.

In the Print dialog box, click the ? button.
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Cancel a print job
If the print job is currently printing, cancel it by pressing Cancel on the product control panel.

NOTE: Pressing Cancel clears the job that the product is currently processing. If more than one
process is running (for example, the product is printing a document while receiving a fax), pressing
Cancel clears the process that currently appears on the product control panel.

You can also cancel a print job from a software program or a print queue.

To stop the print job immediately, remove the remaining print media from the product. After printing
stops, use one of the following options:

● Device control panel: To cancel the print job, press and release Cancel on the product control
panel.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing you
to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or print spooler,
delete the job there.

◦ Windows 2000: Go to the Printer dialog box. Click Start, click Settings, and then click
Printers. Double-click the product icon to open the window, select the print job, and then click
Delete.

◦ Windows XP: Click Start, click Settings, and then click Printers and Faxes. Double-click
the product icon to open the window, right-click the print job that you want to cancel, and then
click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware and Sound,
click Printer. Double-click the product icon to open the window, right-click the print job that
you want to cancel, and then click Cancel.

● Macintosh print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.
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Create booklets
You can copy two pages on one sheet of paper so you can fold the pages in the center to form a booklet.
The device arranges the pages in the correct order. For example, if the original document has eight
pages, the device prints pages 1 and 8 on the same sheet.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Finishing tab.

4. Select Print On Both Sides.

5. In the drop-down box for Booklet Layout, select either Left Edge Binding or Right Edge
Binding. The Pages per Sheet setting automatically changes to 2 pages per sheet.

6. Click OK.

Change print-quality settings
1. On the File menu in the software program, click Print.

2. On the Paper/Quality tab, select the resolution or print-quality settings that you want from the Print
Quality drop-down menu.

3. Click OK.

Change print density
Increasing the print density at the product control panel darkens the print on the page.

1. On the control panel, press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the arrow buttons to select Print Density, and then press OK.

4. Use the arrow buttons to increase or decrease the density setting, and then press OK.
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Print on special media
Make sure that the paper or print media that you are using meets HP specifications. Generally, smoother
paper provides better results.

1. Open the media input tray and remove any media.

2. Load the media. Make sure that the top of the media is forward and the side to be printed on is
facing up.

3. Adjust the media guides to the length and width of the media.

4. On the printer driver, on the Paper tab or the Paper/Quality tab, select the media type from the
Paper Type drop-down list.

CAUTION: Be sure to set the correct media type in the product settings. The product adjusts the
fuser temperature according to the media type setting. When printing on special media such as
transparencies or labels, this adjustment prevents the fuser from damaging the media as it passes
through the product.

5. Print the document.
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Use different paper and print covers
Follow these instructions for printing a first page that is different from other pages in the print job.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Special pages list box, click Print pages on different paper.

5. Click Settings.

6. Select the settings that you want to use to print specific pages on different paper. Click Add.

7. Click OK to return to the Paper/Quality tab.

8. Click OK.

NOTE: The paper size must be the same for all pages of the print job.

Print a blank first page
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Special pages list box, click Covers.

5. Click Settings.

6. Select the settings that you want to use to add blank or preprinted covers. Click Add.

7. Click OK to return to the Paper/Quality tab.

8. Click OK.
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Resize documents
Use the document resizing options to scale a document to a percentage of its normal size. You can also
choose to print a document on a different size paper, with or without scaling.

Reduce or enlarge a document

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Effects tab, select % of actual size, and then type the percentage by which you want to
reduce or enlarge the document.

You can also use the scroll bar to adjust the percentage.

4. Click OK.

Print a document onto a different paper size

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Effects tab, click Print Document On.

4. Select the paper size to print on.

5. To print the document without scaling it to fit, make sure that the Scale to Fit option is not selected.

6. Click OK.

Select a paper size
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Paper/Quality tab, select the size from the Paper Size drop-down list.

4. Click OK.

Select a paper source
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Paper/Quality tab, select the source from the Paper Source drop-down list.

4. Click OK.

Select a paper type
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.
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3. On the Paper/Quality tab, select the type from the Paper Type drop-down list.

4. Click OK.

Set the print orientation
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Finishing tab, select either Portrait or Landscape in the Orientation section.

4. Click OK.

Use watermarks
A watermark is a notice, such as "Confidential," that is printed in the background of each page of a
document.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. From the Effects tab, click the Watermarks drop-down list.

4. Click the watermark that you want to use. To create a new watermark, click Edit.

5. If you want the watermark to appear only on the first page of the document, click First Page
Only.

6. Click OK.

To remove the watermark, click (none) in the Watermarks drop-down list.

Save toner
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Paper/Quality tab, click EconoMode.

4. Click OK.
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Create and use printing shortcuts in Windows
Use printing shortcuts to save the current driver settings for reuse. Shortcuts are available on most
printer-driver tabs. You can save up to 25 printing shortcuts.

Create a printing shortcut

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Printing Shortcuts tab, select the print settings that you want to use. Click Save As.

4. In the Printing Shortcuts box, type a name for the shortcut.

5. Click OK.

Use printing shortcuts

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Printing Shortcuts tab, select the shortcut that you want to use from the Printing
shortcuts box.

4. Click OK.

NOTE: To use printer-driver default settings, select Factory Defaults.
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Print on both sides of the paper (duplex printing)
Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper with the front side up, bottom-edge first.

● For all other trays, load the letterhead paper with front side down, and the top edge at the
back of the tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28 lb bond).

2. On the File menu in the software program, click Print.

3. Select the driver, and then click Properties or Preferences.

4. On the Finishing tab, click Print on both sides.

● If necessary, select Flip pages up to change the manner in which pages are turned, or select
a binding option in the Booklet layout list box.

5. Click OK.

Print on both sides manually
1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special

paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper with the front side down, bottom-edge first.

● For all other trays, load letterhead paper with front side up, and the top edge at the back of
the tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28 lb bond).

2. On the File menu in the software program, click Print.

3. Select the driver, and then click Properties or Preferences.

4. On the Finishing tab, select Correct order for straight paper path, select Print on both sides
(manually), and then open the rear output bin door.

5. Click OK.

6. Send the print job to the product. Follow the instructions in the pop-up window that appears before
feeding the output stack into tray 1 for printing the second half.

7. Go to the product. Remove any blank paper that is in tray 1. Insert the printed stack with the printed
side up, and the bottom-edge feeding into the product first. You must print the second side from
tray 1.

8. At the control panel, press OK to continue.
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Print multiple pages on one sheet of paper in Windows
You can print more than one page on a single sheet of paper.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Finishing tab.

4. In the Pages per sheet drop-down list, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. If the number of pages is greater than 1, select the correct options for Print page borders and
Page order.

● If you need to change the page orientation, click Portrait or Landscape.

6. Click OK. The product is now set to print the number of pages per sheet that you have selected.
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Economy settings
EconoMode

The EconoMode setting in the product printer driver conserves toner. For instructions about using the
EconoMode setting, see Save toner on page 61.

Archive print
Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print
to create documents that you want to preserve or archive.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Service, and then press OK.

3. Use the arrow buttons to select Archive print, select On or Off, and then press OK.

Fonts
Select fonts

Use HP ToolboxFX to change product fonts by clicking the Print Settings tab, and then clicking the
PCL5e page. Click Apply to save the changes.

Print lists of available fonts
Print lists of the fonts available from the product control panel. See Information pages on page 142.
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8 Copy

● Load originals

● Use copy

● Copy settings

● Copy a book

● Copy photos

● Copy mixed-size originals

● Duplex (two-sided) copy jobs
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Load originals
Automatic document feeder (ADF)

NOTE: The ADF capacity is up to 50 sheets of 80 g/m2 or 20 lb media.

CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF. Use the flatbed glass to scan these items.

1. Insert the top-end of the stack of originals into the ADF input tray, with the media stack face-up
and the first page to be copied on top of the stack.

If the media is longer than letter- or A4-sized paper, pull out the ADF input tray extension to support
the media.

2. Slide the stack into the ADF until it does not move any farther.

Document loaded appears on the control-panel display.

3. Adjust the media guides until they are snug against the media.

Flatbed scanner

NOTE: The maximum media size for flatbed scanning is letter. Use the ADF for scanning media larger
than letter.

1. Make sure that the automatic document feeder (ADF) contains no media.

2. Lift the flatbed scanner cover.
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3. Place the original document face-down on the flatbed scanner with the upper-left corner of the
document at the corner indicated by the icon on the scanner.

4. Gently close the lid.

Use copy
One-touch copy

1. Load the document into the automatic document feeder (ADF) input tray or onto the flatbed
scanner.

2. Press Start Copy on the product control panel to start copying.

3. Repeat the process for each copy.

Multiple copies
You can choose to have the default number of copies be any number from 1 to 99.

Change the number of copies for the current job

1. On the product control panel, press # of Copies.

2. Use the alphanumeric buttons to type the number of copies (between 1 and 99) that you want to
make for your current job.

3. Press Start Copy to begin copying your job.

NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Change the default number of copies

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Def. # of copies, and then press OK.

4. Use the alphanumeric buttons to type the number of copies (between 1 and 99) that you want as
the default.

5. Press OK to save your selection.

NOTE: The factory-set default for the number of copies is 1.
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Cancel a copy job
To cancel a copy job, press Cancel on the product control panel. If more than one process is running,
pressing Cancel clears the process that currently appears on the product control-panel display.

NOTE: If you cancel a copy job, clear the document from the flatbed scanner or from the automatic
document feeder.

Reduce or enlarge copies

Reduce or enlarge copies for the current job

1. On the product control panel, press Reduce/Enlarge.

2. Select the size to which you would like to reduce or enlarge the copies in this job.

NOTE: If you select Custom: 25-400%, type a percentage by using the alphanumeric buttons.

If you select 2 pages/sheet or 4 pages/sheet, select the orientation (portrait or landscape).

3. Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.

NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

You must change the default media size in the media input tray to match the output size, or part of your
copy might be cut off.

Adjust the default copy size

NOTE: The default copy size is the size to which copies are normally reduced or enlarged. If you keep
the factory default size setting of Original=100%, all copies will be the same size as the original
document.

1. Press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Def. Redu/Enlrg, and then press OK.

4. Use the arrow buttons to select the option for how you normally want to reduce or enlarge copies.

NOTE: If you select Custom: 25-400%, type in the percentage of the original size that you
normally want for copies.

If you select 2 pages/sheet or 4 pages/sheet, select the orientation (portrait or landscape).

5. Press OK to save the selection.

The product can reduce copies to as little as 25% of the original size or enlarge copies to as much as
400% of the original size.

Reduction/enlargement settings

● Original=100%

● Lgl > Ltr=78%

70 Chapter 8   Copy ENWW



● Lgl > A4=83%

● A4 > Ltr=94%

● Ltr > A4=97%

● Full Page=91%

● Fit to page

● 2 pages/sheet

● 4 pages/sheet

● Custom: 25-400%

NOTE: When using the Fit to page setting, copy from the flatbed scanner only.

When using the 2 pages/sheet or 4 pages/sheet setting, copy from the automatic document feeder
only. Also, after selecting the 2 pages/sheet or 4 pages/sheet option, you must select the page
orientation (portrait or landscape).

Change the copy-collation setting
You can set the product to automatically collate multiple copies into sets. For example, if you are making
two copies of three pages and the automatic collation is on, the pages print in this order: 1,2,3,1,2,3. If
automatic collation is off, the pages print in this order: 1,1,2,2,3,3.

To use the automatic collation, the original document size must fit into the memory. If it does not, the
product makes only one copy and a message appears notifying you of the change. If that happens, use
one of the following methods to finish the job:

● Split the job into smaller jobs that contain fewer pages.

● Make only one copy of the document at a time.

● Turn off the automatic collation.

Change the copy-collation setting for the current job

1. On the product control panel, press Collate.

2. Use the arrow buttons to select On or Off.

3. Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.

Change the default copy-collation setting

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Def. Collation, and then press OK.

4. Use the arrow buttons to select On or Off.

5. Press OK to save the selection.
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NOTE: The factory-set default for automatic copy collation is On.

The Collate LED on the control panel is on when collation is on.

Copy settings
Copy quality

Four copy-quality settings are available: Text, Mixed, Film photo, and Picture.

The factory-set default for copy quality is Text. This setting is the best for items that contain mostly text.

When making a copy of a photo or graphic, you can select the Film photo setting for photos or the
Picture setting for other graphics to increase the quality of your copy. Select the Mixed setting for
documents that include both text and graphics.

Adjust the copy quality for the current job

1. On the product control panel, press Quality to see the current quality setting for the copy.

2. Use the arrow buttons to scroll through the quality setting options.

3. Select a setting, and then press Start Copy to save the selection and immediately start the copy
job, or press OK to save the selection without starting the job.

NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Adjust the default copy quality

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Default quality, and then press OK.

4. Use the arrow buttons to select the copy quality, and then press OK to save the selection.

Clean the scanner glass
Dirty glass, from fingerprints, smudges, hair, and so on, slows down performance and affects the
accuracy of special features such as fit-to-page and copy.

NOTE: If streaks or other defects appear only on copies produced using the automatic document
feeder (ADF), clean the scanner strip (step 3). It is not necessary to clean the scanner glass.

1. Turn off the product, unplug the power cord from the electrical socket, and raise the lid.

72 Chapter 8   Copy ENWW



2. Clean the glass by using a soft, lint-free cloth or sponge that has been moistened with nonabrasive
glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids directly
on the glass. They might seep under it and damage the product.

3. Clean the scanner strip by using a soft, lint-free cloth or sponge that has been moistened with
nonabrasive glass cleaner..

4. To prevent spotting, dry the glass by using a chamois or cellulose sponge.

Adjust the lighter/darker (contrast) setting
The lighter/darker setting affects the lightness or darkness (contrast) of the copy. Use the following
procedure to change the contrast for the current copy job only.

Adjust the lighter/darker setting for the current job

1. On the product control panel, press Lighter/Darker to see the current contrast setting.

2. Use the arrow buttons to adjust the setting. Move the slider to the left to make the copy lighter than
the original, or move the slider to the right to make the copy darker than the original.

3. Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.

NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Adjust the default lighter/darker setting

NOTE: The default lighter/darker setting affects all copy jobs.

1. On the product control panel, press Setup.

2. Use the arrow buttons button to select Copy setup, and then press OK.
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3. Use the arrow buttons button to select Def. Light/dark, and then press OK.

4. Use the arrow buttons button to adjust the setting. Move the slider to the left to make all of the
copies lighter than the original, or move the slider to the right to make all of the copies darker than
the original.

5. Press OK to save the selection.

Set the copy draft setting
Use the control panel to set the product to print copies in draft mode.

NOTE: This setting affects copy quality only. Print quality is not affected.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Def. Copy Draft, and then press OK.

4. Use the arrow buttons to select On or Off.

5. Press OK to save the selection.

Define custom copy settings
When you change the copy settings at the control panel, Custom settings appears on the control-panel
display. The custom settings remain in effect for approximately 2 minutes, and then the product returns
to the default settings. To immediately return to the default settings, press Cancel.

Print or copy edge-to-edge
The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x 13.7 in),
leaving a 4 mm unprintable border around the page.

Copy onto media of different types and sizes
The product is set to copy on either letter- or A4-size paper, depending on the country/region in which
it was purchased. You can change the size and type of media that you copy to for the current copy job
or for all copy jobs.

Media-size settings

● Letter

● Legal

● A4

Media-type settings

● Plain

● Light

● Heavy

● Transparency
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● Labels

● Letterhead

● Envelope

● Preprinted

● Prepunched

● Colored

● Bond

● Recycled

● Mid weight

● Extra heavy

● Rough

Change the media size and type for the current job

NOTE: Change the default media size and type settings to change the media size and type.

1. On the product control panel, press Paper.

2. Use the arrow buttons to select a media size, and then press OK.

3. Use the arrow buttons button to select a media type, and then press OK.

4. Press Start Copy.

Change the default media-size setting

1. On the product control panel, press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the arrow buttons to select Paper setup, and then press OK.

4. Use the arrow buttons to select Def. paper size, and then press OK.

5. Use the arrow buttons to select a media size, and then press OK.

6. Press OK to save the selection.

Change the default media-type setting

1. On the product control panel, press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the arrow buttons to select Paper setup, and then press OK.

4. Use the arrow buttons to select Def. paper type, and then press OK.

5. Use the arrow buttons to select a media type, and then press OK.

6. Press OK to save the selection.
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Restore the copy-settings defaults
Use the control panel to restore the copy settings to the factory-set default values.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Restore defaults, and then press OK.

Copy a book
1. Lift the lid and place the book on the flatbed scanner with the page that you want to copy at the

lower-right corner of the glass.

2. Gently close the lid.

3. Gently press down on the lid to press the book to the flatbed scanner surface.

CAUTION: Pressing on the flatbed cover with too much force can break the lid hinges.

4. Press Start Copy.

Copy photos

76 Chapter 8   Copy ENWW



NOTE: Photographs should be copied from the product flatbed scanner, not from the automatic
document feeder (ADF).

1. Lift the lid and place the photo on the flatbed scanner with the picture-side down and the upper-
left corner of the photo in the lower-right corner of the glass.

2. Gently close the lid.

3. Press Start Copy.
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Copy mixed-size originals
Use the flatbed scanner when making copies of mixed-size originals. Do not use the ADF.

Duplex (two-sided) copy jobs
Copy two-sided documents automatically

Use the 2-Sided button on the control panel display to use duplexing to achieve various results.

NOTE: The default setting is 1–1. The 2-Sided LED on the control panel turns on when another setting
is used.

Table 8-1  2-Sided settings

Document type 2-Sided setting Resulting copies 2-Sided LED

One-sided 1–1 One-sided Off

One-sided 1–2 Two-sided On

Two-sided 2–2 Two-sided On

Two-sided 2–1 One-sided On

Make two-sided copies from one-sided documents

1. Load the documents to be copied into the automatic document feeder (ADF) input tray with the first
page facing up, and with the top of the page leading into the ADF.

2. On the product control panel, press 2-Sided.

3. Use the arrow buttons to select Copy to 1 to 2 sided,, and then press OK.

4. Press Start Copy.

Make two-sided copies from two-sided documents

1. Load the documents to be copied into the automatic document feeder (ADF) input tray with the first
page facing up, and with the top of the page leading into the ADF.

2. On the product control panel, press 2-Sided.

3. Use the arrow buttons to select Copy to 2 to 2 sided, and then press OK.

4. Press Start Copy.
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Change the default 2-Sided setting

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Default 2-sided, and then press OK.

4. Use the arrow buttons to select the option for how you normally want to use the automatic duplexer
when you copy documents.

5. Press OK to save the selection.

Copy two-sided documents manually

Set the multiple-page flatbed copy setting

The multiple-page flatbed copy setting must be set to On before the product will produce two-sided
copies from the flatbed scanner.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Press OK to select Def. Multi-page.

4. Use the arrow buttons to select On or Off.

5. Press OK to save the selection.

NOTE: The factory-set default for automatic copy collation is On.

The Collate LED on the control panel is on when collation is on.

Copy two-sided documents manually

1. Load the first page of the document on the flatbed scanner.

2. Press 2-Sided, and then use the arrow buttons to select the correct setting.

3. Press OK, and then press Start Copy.

4. Remove the first page, and then load the second page onto the flatbed scanner.

5. Press OK, and then repeat the process until all of the pages in the original have been copied.

6. When the copy job is completed, press Start Copy to return the product to Ready mode.
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9 Scan

● Load originals for scanning

● Use scan

● Scan settings

● Scan a book

● Scan a photo
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Load originals for scanning
Automatic document feeder (ADF)

NOTE: The ADF capacity is up to 50 sheets of 80 g/m2 or 20 lb media.

CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF. Use the flatbed glass to scan these items.

1. Insert the top-end of the stack of originals into the ADF input tray, with the media stack face-up
and the first page to be copied on top of the stack.

If the media is longer than letter- or A4-sized paper, pull out the ADF input tray extension to support
the media.

2. Slide the stack into the ADF until it does not move any farther.

Document loaded appears on the control-panel display.

3. Adjust the media guides until they are snug against the media.

Flatbed scanner

NOTE: The maximum media size for flatbed scanning is letter. For media larger than letter, use the
ADF.

1. Make sure that the automatic document feeder (ADF) contains no media.

2. Lift the flatbed scanner cover.
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3. Place the original document face-down on the flatbed scanner with the upper-left corner of the
document at the corner indicated by the icon on the scanner.

4. Gently close the lid.

Use scan
Scan methods

Scan jobs can be performed in the following ways.

● Scan from the computer by using HP LaserJet Scan (Windows)

● Scanning by using HP Director (Macintosh). See Scan from the product and HP Director
(Macintosh) on page 35.

● Scan from the product

● Scan from TWAIN-compliant or Windows Imaging Application (WIA)-compliant software

NOTE: To learn about and use text-recognition software, install the Readiris program from the
software CD-ROM. Text-recognition software is also known as optical character recognition (OCR)
software.

Scan by using HP LaserJet Scan (Windows)
1. In the HP program group, select Scan to start HP LaserJet Scan.

NOTE: Pressing Start Scan on the product control panel also starts HP LaserJet Scan.

2. Choose the action that you want to accomplish.

● Select a destination to begin scanning immediately.

● Select Scan after prompting me for settings to specify additional settings before you begin
scanning.

● Select Set up the device to program the Scan To button.

3. Click OK.

NOTE: OK should indicate the action that you want to accomplish.
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Scan from the product
NOTE: In order to use the Scan To button, you must have performed the recommended installation,
and the button must have destinations set. See Set up the product Scan To button on page 85.

In order to use the Start Scan button, the product must be connected to a computer via USB or a network.

Scan directly from the product by using the control-panel scan buttons. Press Start Scan or Scan To to
scan to a folder (Windows only) or to scan to e-mail.

Scan by using other software
The product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. The product works
with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning devices and
with Macintosh-based programs that support TWAIN-compliant scanning devices.

While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or the
documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the program
is compliant or you do not know what the command is called, see the software program Help or
documentation.

When scanning from a TWAIN-compliant program, the HP LaserJet Scan software program might start
automatically. If the HP LaserJet Scan program starts, you can make changes while previewing the
image. If the program does not start automatically, the image goes to the TWAIN-compliant program
immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

Scan from a WIA-compliant program (Windows XP and Vista only)

WIA is another way to scan an image directly into a software program, such as Microsoft Word. WIA
uses Microsoft software to scan, instead of HP LaserJet Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From Scanner
or Camera in the Insert or File menu. If you are unsure whether the program is WIA-compliant, see the
software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or documentation
for information about the commands and steps to use.

-Or-

In the Cameras and Scanner folder, double-click the product icon. This opens the standard Microsoft
WIA Wizard, which enables you to scan to a file.

Scanning by using optical character recognition (OCR) software
You can use third-party OCR software to import scanned text into your preferred word-processing
program for editing.
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Readiris

The Readiris OCR program is included on a separate CD-ROM that shipped with the product. To use
the Readiris program, install it from the appropriate software CD-ROM, and then follow the instructions
in the online Help.

Use the Scan To feature
● Scanning from the product control panel is only supported with a full software installation.

HP ToolboxFX must be running to scan by using the Scan To button or the Start Scan button.

● For the best scan quality, place your originals onto the flatbed scanner, rather than loading them
into the automatic document feeder (ADF) input tray.

● The computer that is connected to the product must be turned on.

Set up the product Scan To button
Destinations must be set up prior to using the Scan To button on the control panel. Use HP LaserJet
Scan to program the folder, e-mail, and program destinations for scanning.

Set up destinations on the product

1. Click Start, click Programs (or All Programs in Windows XP), click HP, click the product, click
Scan, and then click Settings.

2. Select Change the destinations that show up on the all-in-one control panel.

3. The product is pre-configured with the following three destinations in the dialog box.

● Scan a document and attach it to an e-mail

● Scan a photo and attach it to an e-mail

● Scan a photo and save it as a file

4. Highlight a destination and click the arrow to move to the destinations currently on the dialog box.
Repeat for all three destinations.

5. Click Update.

Add destinations

1. Click Start, click Programs (or All Programs in Windows XP), click HP, click the product, click
Scan, and then click Settings.

2. Select Create a new destination with settings that I specify.

3. Do one of the following:

● For folders, select Save it to my computer, and then click Next.

● For e-mail, select Attach to a new e-mail, and then click Next.

● For programs, select Open it in another software application, and then click Next.

4. Enter the file destination name or check to set up the destination on the product. Name the default
destination, and then click Next.
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5. Select the quality and click Next.

6. Verify the selections, and then click Save.

Delete destinations

1. From the Set up the <Scan To> list for the All-in-One, select one of the Available Destinations
on this PC and click Delete. The Delete Destination dialog box displays.

2. From the Delete Destination dialog box, highlight the destination to delete and click Next. The
Confirmation dialog box displays.

3. Click Delete to perform the deletion, or click Cancel to choose another destination.

Scan to a file, e-mail, or software program
NOTE: To use this feature in Windows, a destination must be programmed in the scan setup before
scanning to a destination. See Set up the product Scan To button on page 85.

1. Load the originals that are to be scanned face-up in the automatic document feeder (ADF) input
tray, with the top of the document forward, and adjust the media guides.

-or-

Lift the flatbed scanner lid and load the original that is to be scanned face-down on the flatbed
scanner with the top, left corner of the document located in the lower-right corner of the glass.
Gently close the lid.

2. On the product control panel, press Scan To.

3. Use the arrow buttons to select a file destination.

4. Press Start Scan or OK to scan the document to a file.

NOTE: Scanning to e-mail is supported by any e-mail program that supports the Messaging
Application Programming Interface (MAPI) protocol. Many versions of popular e-mail programs seem
to be MAPI-compliant. See the support information for your e-mail program to determine whether or not
it is MAPI-compliant.

Canceling a scan job
To cancel a scan job, use one of the following procedures.

● On the product control panel, press Cancel.

● Click the Cancel button in the onscreen dialog box.

If you cancel a scan job, remove the original from the flatbed scanner or from the automatic document
feeder (ADF) input tray.

86 Chapter 9   Scan ENWW



Scan settings
Scan file format

The file format of a scanned document or photo depends on the scan type as well as the object being
scanned.

● Scanning a document or a photo to a computer results in the file being saved as a .TIF file.

● Scanning a document to email results in the file being saved as a .PDF file.

● Scanning a photo to e-mail results in the file being saved as a .JPEG file.

NOTE: Different file types can be selected when using the scan software program.

Scanner resolution and color
If you are printing a scanned image, and the quality is not what you expected, you might have selected
a resolution or color setting in the scanner software that does not match your needs. Resolution and
color affect the following features of scanned images:

● Image clarity

● Texture of gradations (smooth or rough)

● Scan time

● File size

Scanning resolution is measured in pixels per inch (ppi).

NOTE: Scanning ppi levels are not interchangeable with printing dpi (dots per inch) levels.

Color, grayscale, and black and white define the number of colors possible. You can adjust the scanner
hardware resolution to up to 1200 ppi. The software can perform an enhanced resolution up to
19,200 ppi. You can set color and grayscale at 1 bit (black and white), or at 8 bit (256 levels of gray or
color) to 24 bit (true color).

The resolution and color guidelines table lists simple tips that you can follow to meet your scanning
needs.

NOTE: Setting the resolution and color to a high value can create large files that take up disk space
and slow the scanning process. Before setting the resolution and color, determine how you are going
to use the scanned image.

NOTE: The best resolution for color and grayscale images is achieved by scanning from the flatbed
scanner rather than from the automatic document feeder (ADF).
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Resolution and color guidelines
The following table describes the recommended resolution and color settings for different types of scan
jobs.

Intended use Recommended resolution Recommended color settings

Fax 150 ppi ● Black and White

E-mail 150 ppi ● Black and White, if the image does
not require smooth gradation

● Grayscale, if the image requires
smooth gradation

● Color, if the image is in color

Edit text 300 ppi ● Black and White

Print (graphics or text) 600 ppi for complex graphics, or if you
want to significantly enlarge the
document

300 ppi for normal graphics and text

150 ppi for photos

● Black and White for text and line art

● Grayscale for shaded or colored
graphics and photos

● Color, if the image is in color

Display on screen 75 ppi ● Black and White for text

● Grayscale for graphics and photos

● Color, if the image is in color

Color
You can set the color values to the following settings when scanning.

Setting Recommended use

Color Use this setting for high-quality color photos or documents in
which the color is important.

Black and White Use this setting for text documents.

Grayscale Use this setting when file size is an issue or when you want a
document or photograph to be scanned quickly.

Scan quality

Clean the scanner glass

Dirty glass, from fingerprints, smudges, hair, and so on, slows down performance and affects the
accuracy of special features such as fit-to-page and copy.

NOTE: If streaks or other defects appear only on copies produced using the automatic document
feeder (ADF), clean the scanner strip (step 3). It is not necessary to clean the scanner glass.

1. Turn off the product, unplug the power cord from the electrical socket, and raise the lid.
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2. Clean the glass by using a soft cloth or sponge that has been moistened with nonabrasive glass
cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids directly
on the glass. They might seep under it and damage the product.

3. Clean the scanner strip by using a soft cloth or sponge that has been moistened with nonabrasive
glass cleaner.

4. To prevent spotting, dry the glass by using a chamois or cellulose sponge.
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Scan a book
1. Lift the lid and place the book on the flatbed scanner with the page that you want to copy at the

lower-right corner of the glass.

2. Gently close the lid.

3. Gently press down on the lid to press the book to the flatbed scanner surface.

CAUTION: Pressing on the flatbed cover with too much force can break the lid hinges.

4. Scan the book by using one of the scanning methods.
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Scan a photo
1. Place the photo on the flatbed scanner with the picture-side down and the upper-left corner of the

photo in the lower-right corner of the glass.

2. Gently close the lid.

3. Scan the photo by using one of the scanning methods.
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10 Fax

● Fax features

● Setup

● Change fax settings

● Use fax

● Solve fax problems

NOTE: Many of the functions that are described in this chapter also can be performed by using
HP ToolboxFX or the embedded Web server. For more information, see the HP ToolboxFX online Help
or Embedded Web server on page 153.

For information about the fax controls on the control panel, see Control panel on page 9.
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Fax features
The product has the following fax features, which are available from the control panel or from the product
software.

● Fax Setup Wizard for easy fax configuration

● Plain-paper analog fax with 50-page automatic document feeder (ADF) and output tray of up to
125-page paper capacity

● 120-entry phone book and 16 speed dials from the control panel

● Automatic redial

● Digital storage of up to 400 fax pages

● Fax forwarding

● Delayed sending of faxes

● Ring features: Configure rings to answer and distinctive ring compatibility (service required through
local telecommunications company)

● Fax confirmation report

● Junk fax blocking

● Fax security

● Eight cover page templates available

NOTE: Not all features are listed. The product software might need to be installed for some features
to be available.
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Setup
Install and connect the hardware

Connect to a telephone line
The product is an analog device. HP recommends using the product on a dedicated analog telephone
line. For information about using the product with other telephone environments, see Use fax on a DSL,
PBX, ISDN, or VoIP system on page 117.

Connect additional devices
The product includes two fax ports:

● The “line out” port ( ), which connects the product to the wall telephone jack.

● The “telephone” port ( ), which connects additional devices to the product.

Telephones used in conjunction with the product can be employed in two ways:

● An extension phone is a phone plugged into the same phone line at another location.

● A downstream phone is one that is plugged into the product or a device that is plugged into the
product.

Connect additional devices in the order that is described in the following steps. The output port for each
device is connected to the input port of the next, forming a "chain". If you do not want to connect a
specific device, skip the step that explains it and continue to the next device.

NOTE: Do not connect more than three devices to the telephone line.

NOTE: Voicemail is not supported with this product.

1. Unplug the power cords for all of the devices that you want to connect.

2. If the product is not yet connected to a telephone line, see the getting started guide before
proceeding. The product should already be connected to a telephone jack.

3. Remove the plastic insert from the "telephone" port (the port that is marked with the telephone
icon).

ENWW Setup 95



4. To connect an internal or external modem on a computer, plug one end of a telephone cord into

the product “telephone” port ( ). Plug the other end of the telephone cord into the modem “line”
port.

NOTE: Some modems have a second “line” port to connect to a dedicated voice line. If you have
two “line” ports, see your modem documentation to make sure that you connect to the correct “line”
port.

5. To connect a caller-ID box, plug a telephone cord into the previous device’s “telephone” port. Plug
the other end of the telephone cord into the caller-ID box “line” port.

6. To connect an answering machine, plug a telephone cord into the previous device’s “telephone”
port. Plug the other end of the telephone cord into the answering machine “line” port.
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7. To connect a telephone, plug a telephone cord into the previous device’s “telephone” port. Plug
the other end of the telephone cord into the telephone “line” port.

8. After you have finished connecting additional devices, plug all of the devices into their power
sources.

Set up fax with a telephone answering machine

● Set the product rings-to-answer setting for at least one ring more than the number of rings for which
the answering machine is set.

● If an answering machine is connected to the same telephone line but on a different jack (in another
room, for example), it might interfere with the product's ability to receive faxes.

Setup for stand-alone fax
1. Unpack and set up the product.

2. Set the time, date, and fax header. See Configure fax settings on page 97.

3. Set other settings as necessary to configure for the product environment.

Configure fax settings
The product fax settings can be set from the control panel, from HP ToolboxFX, or from the embedded
Web server. At the initial set-up process, the HP Fax Setup Wizard can be used to configure the settings.

In the United States and many other countries/regions, setting the time, date, and other fax header
information is a legal requirement.

Use the control panel to set the fax time, date, and header
To use the control panel to set the date, time, and header, complete the following steps:

1. At the control panel, press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the arrow buttons to select Time/Date. Press OK.

4. Use the arrow buttons to select the 12-hour clock or 24-hour clock, and then press OK.

5. Use the alphanumeric buttons to enter the current time.
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6. Complete one of the following:

● For the 12-hour clock, use the arrow buttons to move past the fourth character. Select 1 for
a.m. or 2 for p.m. Press OK.

● For the 24-hour clock, press OK.

7. Use the alphanumeric buttons to enter the current date. Use two digits to specify the month, day,
and year. Press OK.

8. Use the arrow buttons to select Fax setup, then press OK.

9. Use the arrow buttons to select Fax Header, then press OK.

10. Use the alphanumeric buttons to enter your fax number and your company name or header, and
then press OK.

NOTE: The maximum number of characters for the fax number is 20; use up to 25 characters for
the company name.

Use HP Fax Setup Wizard to set the fax time, date, and header
If you completed the software installation, you are ready to send faxes from your computer. If you did
not complete the fax setup process at the time you installed the software, you can complete it at any
time by using the Fax Setup Wizard.

1. Click Start, and then click Programs.

2. Click HP, click the name of the product, and then click HP Fax Setup Wizard.

3. Follow the onscreen instructions in the HP Fax Setup Wizard to set the time, date, and fax header,
as well as several other settings.

Use of common localized letters in fax headers
When using the control panel to enter your name in the header or to enter a name for a one-touch key,
speed-dial entry, or group-dial entry, press the appropriate alphanumeric button repeatedly until the
letter that you need appears. Then, press the > button to select that letter and move to the next space.
The following table shows which letters and numbers appear on each alphanumeric button.
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Key number Characters

1 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 0

* ( ) + - . / , “ * & @ R W

space # , #

NOTE: Use > to move the cursor on the control panel and use < to delete characters.

Manage the phone book
You can store frequently dialed fax numbers or groups of fax numbers as speed dials or group-dial
entries.

In the product phone book, a total of 120 entries are available for speed dials and group-dial entries.
For example, if you program 100 of the entries as speed-dials, the remaining 20 can be used for group-
dials.

NOTE: Speed dials and group-dial entries are more easily programmed from HP ToolboxFX or the
embedded Web server. For more information, see the HP ToolboxFX online Help or Embedded Web
server on page 153.

Use phone-book data from other programs
NOTE: Before a phone book from another program can be imported, you must use the export feature
in that other program.

HP ToolboxFX can import contact information from other software program phone books. The following
table shows which programs are supported for HP ToolboxFX.

Program Description

Microsoft Outlook Personal Address Book (PAB) entries, Contacts entries, or both combined may be selected.
Individuals and groups from the PAB are combined with individuals from Contacts only if the
combined option is selected.

If a Contacts entry has both a home and a business fax number, two entries will be displayed. The
“name” of these two entries will be modified. “:(B)” will be added to the name in the business entry
and “:(H)” will be added to the name in the home entry.

ENWW Setup 99



Program Description

If a duplicate entry occurs (one from Contacts and one from the PAB with the same name and fax
number), a single entry will be displayed. However, if an entry exists in the PAB with a duplicate in
Contacts, and the Contacts entry has both a business and a home fax number, all three entries will
be displayed.

Windows Address Book The Windows Address Book (WAB), used by Outlook Express and Internet Explorer, is supported.
If an individual has both a home and a business fax number, two entries will be displayed. The
“name” of these two entries will be modified. “:(B)” will be added to the name in the business entry
and “:(H)” will be added to the name in the home entry.

Goldmine Goldmine version 4.0 is supported. HP ToolboxFX imports the file last used by Goldmine.

Symantec Act! Act! versions 4.0 and 2000 are supported. HP ToolboxFX imports the database last used by Act!.

Complete the following steps to import a phone book:

1. Open HP ToolboxFX.

2. Click Fax, and then click Fax Phone Book.

3. Browse to the program phone book, and then click Import.

Delete phone book
You can delete all speed dials and group-dial entries that are programmed in the product.

CAUTION: After speed dials and group-dial entries are deleted, they cannot be recovered.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Press OK to select Phone Book.

4. Use the arrow buttons to select Delete All, and then press OK.

5. Press OK to confirm the deletion.

Special dialing symbols and options
You can insert pauses into a fax number that you are dialing or programming to a one-touch key, speed-
dial entry, or group-dial entry. Pauses are often needed when dialing internationally or connecting to an
outside line.

● Insert a dialing pause: Press # (Pause) repeatedly until a comma (,) appears on the control-panel
display, indicating that the pause will occur at that point in the dialing sequence.

● Insert a pause for dial tone: Press * (Symbols) repeatedly until W appears on the control-panel
display to have the product wait for a dial tone before dialing the remainder of the telephone
number.

● Insert a hook flash: Press * (Symbols) repeatedly until R appears on the control-panel display to
have the product perform a hook flash.
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Manage speed dials

Create and edit speed dials

Speed dials 1 through 16 are also associated with their corresponding one-touch keys on the control
panel. The one-touch keys can be used for speed dials or group-dial entries. A maximum of 50
characters can be entered for a single fax number.

NOTE: To gain access to all of the speed dials, you must use the Shift button. Speed dials 9 through
16 are all available by pressing Shift and the associated one-touch key on the control panel.

Complete the following steps to program speed dials from the control panel:

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Press OK to select Phone Book.

4. Press OK to select Individual Setup.

5. Press OK to select Add.

6. Use the alphanumeric buttons to specify the speed-dial entry number that you want to associate
with this fax number, and then press OK. Selecting a number from 1 to 16 also associates the fax
number with the corresponding one-touch key.

7. Use the alphanumeric buttons to enter the fax number. Include any pauses or other needed
numbers, such as an area code, an access code for numbers outside a PBX system (usually a 9
or 0), or a long distance prefix.

NOTE: When entering a fax number, press Pause until a comma (,) appears if you want to insert
a pause in the dialing sequence, or press * until W appears if you want the product to wait for a
dial tone.

8. Press OK.

9. Use the alphanumeric buttons to enter a name for the fax number. To do so, repeatedly press the
alphanumeric button for the letter that you need until the letter appears. (For a list of characters,
see Use of common localized letters in fax headers on page 98.)

NOTE: To insert punctuation, press the asterisk (*) button repeatedly until the character that you
want appears, and then press the > button to go to the next space.

10. Press OK to save the information.

11. If you have more speed dials to program, repeat steps 1 through 10.

Delete speed dials

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Press OK to select Phone Book.

4. Press OK to select Individual setup.

5. Use the arrow buttons button to select Delete, and then press OK.
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6. Use the alphanumeric buttons to enter the number of the speed-dial entry you want to delete, and
then press OK.

7. Press OK to confirm the deletion.

Manage group-dial entries

Create and edit group-dial entries

1. Assign a speed-dial entry to each fax number that you want in the group. (For instructions, see
Create and edit speed dials on page 101.)

2. On the control panel, press Setup.

3. Use the arrow buttons to select Fax setup, and then press OK.

4. Press OK to select Phone Book.

5. Use the arrow buttons to select Group setup, and then press OK.

6. Use the arrow buttons to select Add/Edit group, and then press OK.

7. Use the alphanumeric buttons to enter the number that you want to associate with this group, and
then press OK. Selecting 1 through 16 also associates the group with the corresponding one-touch
key.

8. Use the alphanumeric buttons to enter a name for the group, and then press OK.

9. Press a one-touch key, and then press OK again to confirm the addition. Repeat this step for each
group member you want to add.

-or-

Select Phone Book, and then select the speed-dial entry for the group member you want to add.
Press OK to confirm the addition. Repeat this step for each group member you want to add.

10. When you are finished, press OK.

11. If you have more group-dial entries to assign, press OK, and then repeat steps 1 through 10.

Delete group-dial entries

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Press OK to select Phone Book.

4. Use the arrow buttons to select Group setup, and then press OK.

5. Use the arrow buttons to select Delete group, and then press OK.

6. Using the alphanumeric buttons, enter the number of the group-dial that you want to delete, and
then press OK.

7. Press OK to confirm the deletion.
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Delete an individual from a group-dial entry

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Press OK to select Phone Book.

4. Use the arrow buttons to select Group setup, and then press OK.

5. Use the arrow buttons to select Del. # in group, and then press OK.

6. Use the arrow buttons to select the individual that you want to delete from the group.

7. Press OK to confirm the deletion.

8. Repeat steps 6 and 7 to delete other individuals from the group.

-or-

Press Cancel if you are finished.

NOTE: Deleting a speed-dial entry also deletes that entry from any group-dial entries that included
that speed-dial entry.

Set fax polling
If someone else has set up a fax to be polled, you can request that the fax be sent to your product. (This
is known as polling another machine).

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax functions, and then press OK.

3. Use the arrow buttons to select Polling receive, and then press OK.

The product dials the other fax machine and requests the fax.

Security
The product includes a password feature that restricts access to many settings features while allowing
basic functions to continue.

Private receive can be used to store faxes on the product until you are at the product to print them.

Turn on password protection
To set up the product security password, complete the following steps:

1. On the control panel, press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the alphanumeric buttons to enter the product password, and then press OK.

4. To confirm the product password, use the alphanumeric buttons to re-enter the password, and then
press OK.
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5. Use the arrow buttons to select Product security, and then press OK.

6. Use the arrow buttons to select On, and then press OK.

Turn on private receive feature
The password-protection feature must be turned on before the private-receive feature can be activated.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the alphanumeric buttons to enter the product security password, and then press OK.

4. To confirm the product security password, use the alphanumeric buttons to re-enter the product
security password, and then press OK.

5. Use the arrow buttons to select Fax Recv. setup, and then press OK.

6. Use the arrow buttons to select Private Receive, and then press OK.

7. Use the arrow buttons to select On, and then press OK.
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Change fax settings
Set the sound-volume settings

Control the volume of the fax sounds from the control panel. You can make changes to the following
sounds:

● The fax sounds that are associated with incoming and outgoing faxes

● The ring for incoming faxes

The factory-set default for the fax-sounds volume is Soft.

Set the fax-sounds (line-monitor) volume
Complete the following steps to change the fax-sounds volume.

1. Press Volume on the control panel.

2. Use the arrow buttons to select Off, Soft, Medium, or Loud.

3. Press OK to save the selection.

Set the ring volume
When the product is initially receiving a call, a ring alert is audible. The ring duration length is based on
the local telephone company ring-pattern length. The factory-set default for the ring volume is Soft.

1. Press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the arrow buttons to select  Volume settings, and then press OK.

4. Use the arrow buttons to select Ring volume, and then press OK.

5. Use the arrow buttons to select Off, Soft, Medium, or Loud.

6. Press OK to save the selection.

Send fax settings

Set a dial prefix
A dial prefix is a number or group of numbers that are automatically added to the beginning of every fax
number you enter at the control panel or from the software. The maximum number of characters for a
dial prefix is 50.

The default setting is Off. You might want to turn this setting on and enter a prefix if, for example, you
have to dial a number such as 9 to get a telephone line outside of your company telephone system.
While this setting is activated, you can dial a fax number without the dial prefix by using manual dial.
For instructions, see Manual dial faxing on page 120.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.
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4. Use the arrow buttons to select Dial Prefix, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

6. If you selected On, use the alphanumeric buttons to enter the prefix, and then press OK. You can
use numbers, pauses, and dialing symbols.

Set the dial-tone detection
Normally, the product begins dialing a fax number immediately. If you are using the product on the same
line as your telephone, turn on the detect-dial-tone setting. This prevents the product from sending a
fax while someone is on the telephone.

The factory-set default for detect dial tone is On for France and Hungary, and Off for all other countries/
regions.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Detect dial tone, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

Set autoredial
If the product was unable to send a fax because the receiving fax machine did not answer or was busy,
the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-
communication-error options. Use the procedures in this section to turn these options on or off.

Set the redial-on-busy option

If this option is turned on, the product redials automatically if it receives a busy signal. The factory-set
default for the redial-on-busy option is On.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Redial if busy, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

Set the redial-on-no-answer option

If this option is turned on, the product redials automatically if the receiving machine does not answer.
The factory-set default for the redial-on-no-answer option is Off.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.
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4. Use the arrow buttons to select Redial-no answer, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

Set the redial-on-communication-error option

If this option is turned on, the product redials automatically if some sort of communication error occurs.
The factory-set default for the redial-on-communication-error option is On.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Redial Comm Err., and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

Set light/dark and resolution

Set the default light/dark (contrast) setting

The contrast affects the lightness and darkness of an outgoing fax as it is being sent.

The default light/dark setting is the contrast that is normally applied to items that are being faxed. The
slider is set to the middle as the default setting.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Def. Light/dark, and then press OK.

5. Use the < button to move the slider to the left to make the fax lighter than the original, or use the
> button to move the slider to the right to make the fax darker than the original.

6. Press OK to save the selection.

Set resolution settings

NOTE: Increasing the resolution increases the fax size. Larger faxes increase the send time and could
exceed the available memory in the product.

The factory-set default resolution setting is Fine.

Use this procedure to change the default resolution for all fax jobs to one of the following settings:

● Standard: This setting provides the lowest quality and the fastest transmission time.

● Fine: This setting provides a higher resolution quality than Standard that is usually appropriate for
text documents.

● Superfine: This setting is best used for documents that mix text and images. The transmission
time is slower than Fine but faster than Photo.

● Photo: This setting produces the best images, but greatly increases the transmission time.
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Set the default resolution setting

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Def. Resolution, and then press OK.

5. Use the arrow buttons to change the resolution setting.

6. Press OK to save the selection.

Set the resolution for the current fax job

1. On the control panel, press Resolution to show the current resolution setting.

2. Use the arrow buttons to select the appropriate resolution setting.

3. Press OK to save the selection.

NOTE: This procedure changes the fax resolution for the current fax job. For instructions about
changing the default fax resolution, see Set the default resolution setting on page 108.

NOTE: To change the fax contrast or glass-scan size, you must change the default settings. See Set
the default light/dark (contrast) setting on page 107 or Set the default glass-size setting on page 108.

Set the default glass-size setting
This setting determines which paper size the flatbed scanner scans when you send a fax from the
scanner. The factory-set default is determined by the country/region in which you purchased the product.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Def. Glass size, and then press OK.

5. Use the arrow buttons to select the correct paper size setting: A4 or Letter.

6. Press OK to save the selection.

Set tone-dialing or pulse-dialing
Use this procedure to set the product to tone-dialing or pulse-dialing mode. The factory-set default is
Tone. Do not change this setting unless you know that the telephone line cannot use tone dialing.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Dialing Mode, and then press OK.

5. Use the arrow buttons to select Tone or Pulse, and then press OK to save the selection.
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NOTE: The pulse-dialing option is not available in all countries/regions.

Set billing codes
If the billing codes feature has been turned on, the user will be asked to enter a billing code for each
fax. The billing code count is increased for each fax page that is sent. This includes all types of faxes
except for poll-received, fax-forwarded, or computer-downloaded faxes. For an undefined group or a
group-dial fax, the billing code count is increased for each successful fax that is sent to each destination.
To print a report that shows the total for each billing code, see Print the billing-code report
on page 109.

The factory-set default for the billing-code setting is Off. The billing code can be any number from 1
through 250.

Set the billing-code setting

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Send setup, and then press OK.

4. Use the arrow buttons to select Billing codes, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

Use billing codes

1. Load the document in the automatic document feeder (ADF) input tray or on the flatbed scanner.

2. On the control panel, enter the phone number manually, by speed-dial, or by group-dial entry.

3. Press Start Fax.

4. Enter the billing code, and then press Start Fax.

The fax job is sent and recorded in the billing-code report. For information about printing the billing-code
report, see Print the billing-code report on page 109.

Print the billing-code report

The billing-code report is a printed list of all of the fax billing codes and the total number of faxes that
have been billed to each code.

NOTE: After this report is printed, all billing data is deleted.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Billing report, and then press OK. The product exits the menu
settings and prints the report.
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Receive fax settings

Set or change number of rings-to-answer
When the answer mode is set to Automatic, the product rings-to-answer setting determines the number
of times the telephone rings before the product answers an incoming call.

If the product is connected to a line that receives both fax and voice calls (a shared line) and that also
uses an answering machine, you might need to adjust the rings-to-answer setting. The number of rings-
to-answer for the product must be greater than the rings-to-answer on the answering machine. This
allows the answering machine to answer the incoming call and record a message if it is a voice call.
When the answering machine answers the call, the product listens to the call and automatically answers
it if it detects fax tones.

The default setting for rings-to-answer is five for the U.S. and Canada, and two for other countries/
regions.

Use the rings-to-answer setting

Use the following table to determine the number of rings-to-answer to use.

Type of telephone line Recommended rings-to-answer setting

Dedicated fax line (receiving only fax calls) Set to a number of rings within the range shown on the control-
panel display. (The minimum and maximum number of rings
allowed varies by country/region.)

One line with two separate numbers and a ring-pattern service One or two rings. (If you have an answering machine or
computer voicemail for the other telephone number, make sure
that the product is set to a greater number of rings than the
answering system. Also, use the distinctive-ring feature to
differentiate between voice and fax calls. See Set up distinctive
ring on page 112.)

Shared line (receiving both fax and voice calls) with only an
attached telephone

Five rings or more.

Shared line (receiving both fax and voice calls) with an
attached answering machine or computer voicemail

Two rings more than the answering machine or computer
voicemail.

Set the number of rings-to-answer

To set or change the number of rings-to-answer, use the following steps:

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Rings to answer, and then press OK.

5. Use the alphanumeric buttons to enter the number of rings-to-answer, and then press OK.
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Set the answer mode
Depending on the situation, set the product answer mode to Automatic or Manual. The factory-set
default is Automatic.

● Automatic: In this answer mode, the product answers incoming calls after a specified number of
rings or upon recognition of special fax tones. To specify the number of rings, see Set the number
of rings-to-answer on page 110.

● TAM: In this answer mode, the product has a telephone answering machine (TAM) attached to the
line-out port. The product does not answer incoming calls, but listens for fax call tones after the
TAM has answered the call.

● Fax/Tel: In this answer mode, the product answers an incoming call and determines if the call is
a voice call or fax call. If the call is a fax call, the product receives the fax from the call. If the call
is a voice call, the product generates an audible ring to indicate an incoming voice call that you
must answer on an extension phone.

● Manual: In this answer mode, the product never answers calls. You must start the fax-receiving
process yourself, either by pressing Start Fax on the control panel or by picking up a telephone
that is connected to that line and dialing 1-2-3.

To set or change the answer mode, complete the following steps:

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Press OK to select Answer mode.

5. Use the arrow buttons to select the answer mode, and then press OK.

The control-panel display shows the answer mode setting that you specified.

Set fax forwarding
You can set your product to forward incoming faxes to another fax number. When the fax arrives at your
product, it is stored in the memory. The product then dials the fax number that you have specified and
sends the fax. If the product cannot forward a fax because of an error (for example, the number is busy)
and repeated redial attempts are unsuccessful, your product prints the fax.

If the product runs out of memory while receiving a fax, it terminates the incoming fax and only forwards
the pages and partial pages that have been stored in the memory.

When it is using the fax-forwarding feature, the product (rather than the computer) must be receiving
the faxes, and the answer mode must be set to Automatic.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Forward fax, and then press OK.
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5. Use the arrow buttons to select On or Off, and then press OK.

6. If you turn on the fax-forwarding feature, use the alphanumeric buttons to specify the fax number
where the fax is to be sent, and then press OK to save the selection.

Set up distinctive ring
Ring-pattern or distinctive-ring service is available through some local telephone companies. The
service allows you to have more than one telephone number on a single line. Each telephone number
has a unique ring pattern, so that you can answer voice calls and the product can answer fax calls.

If you subscribe to a ring-pattern service with a telephone company, you must set the product to answer
the correct ring pattern. Not all countries/regions support unique ring patterns. Contact the telephone
company to determine if this service is available in your country/region.

NOTE: If you do not have ring-pattern service and you change the ring-pattern settings to something
other than the default, All Rings, the product might not be able to receive faxes.

The settings are as follows:

● All Rings: The product answers any calls that come through the telephone line.

● Single: The product answers any calls that produce a single-ring pattern.

● Double: The product answers any calls that produce a double-ring pattern.

● Triple: The product answers any calls that produce a triple-ring pattern.

● Double&Triple: The product answers any calls that produce a double-ring or triple-ring pattern.

To change ring patterns for call answering, complete the following steps:

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Answer Ring Type, and then press OK.

5. Use the arrow buttons to select the ring pattern that you want, and then press OK.

6. After product installation is complete, ask someone to send a fax to you in order to verify that the
ring-pattern service is working correctly.

Set up the computer to receive faxes
NOTE: Receiving faxes by using a computer is not supported for Macintosh.

Receiving faxes to a computer is available only if a full software installation was performed during initial
product setup.

To receive faxes to your computer, turn on the receive-to-PC setting in the software.

1. Open HP ToolboxFX.

2. Select the product.

3. Click Fax.
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4. Click Fax Tasks.

5. Under Fax Receive Mode, select Receive faxes to this computer.

Turn off the receive-to-PC setting from the control panel

The receive-to-PC setting can be activated only from one computer. If for any reason that computer is
no longer available, you can use the following procedure to turn the receive-to-PC setting off from the
control panel.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax functions, and then press OK.

3. Use the arrow buttons to select Stop Recv to PC, and then press OK.

Use autoreduction for incoming faxes
If the fit-to-page option is turned on, the product automatically reduces long faxes up to 75% to fit the
information on the default paper size (for example, the fax is reduced from legal to letter size).

If the fit-to-page option is turned off, long faxes print at full size on multiple pages. The factory-set default
for incoming fax autoreduction is On.

If you have the stamp-received faxes option turned on, you might also want to turn on autoreduction.
This reduces the size of the incoming faxes slightly, and prevents the page-stamp from forcing a fax
onto two pages.

NOTE: Make sure that the default media size setting matches the size of the media that is loaded in
the tray.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Fit to page, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK to save the selection.

Set the silence-detect mode
This setting controls whether or not you can receive faxes from older-model fax machines that do not
emit a fax signal during fax transmissions. At the time of this publication, these silent-model fax machines
represented very few of the fax machines in use. The default setting is Off. The silence-detect mode
setting should be changed only if you regularly receive faxes from someone who uses an older-model
fax machine.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Silence Detect, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK to save the selection.
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Set the default fax reprint settings
The default fax reprint setting is On. To change this setting from the control panel, complete the following
steps:

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Reprint faxes, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

Automatic two-sided printing (duplexing) of received faxes
When Print duplex is On, all faxes received are printed two-sided. The factory-set default for printing
faxes two-sided is Off.

Set the print duplex setting for faxes

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Print duplex, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK.

Create stamp-received faxes
The product prints the sender identification information at the top of each received fax. You can also
choose to have your own header information included on each received fax to confirm the date and time
that the fax was received. The factory-set default for stamp-received faxes is Off.

NOTE: This option applies only to received faxes that the product prints.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Stamp faxes, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK to save the selection.

Block or unblock fax numbers
If you do not want to receive faxes from specific people or businesses, you can block as many as 30
fax numbers by using the control panel. When you block a fax number and someone from that number
sends you a fax, the control-panel display indicates that the number is blocked, the fax does not print,
and the fax is not saved in memory. Faxes from blocked fax numbers appear in the fax activity log with
a “discarded” designation. You can unblock blocked fax numbers individually or all at one time.

NOTE: The sender of a blocked fax is not notified that the fax failed.
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To print a list of numbers that you have blocked or the fax activity log, see Print individual fax reports
on page 133.

Complete the following steps to block or unblock fax numbers by using the control panel:

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Block faxes, and then press OK.

5. To block a fax number, use the arrow buttons to select Add entry, and then press OK. Enter the
fax number exactly as it appears in the header (including spaces), and then press OK. Enter a
name for the blocked number, and then press OK.

To unblock a single fax number, use the arrow buttons to select Delete entry, and then press
OK. Use the arrow buttons to select the fax number that you want to delete, and then press OK to
confirm the deletions.

-or-

To unblock all blocked fax numbers, use the arrow buttons to select Clear all, and then press
OK. Press OK again to confirm the deletions.

Make an extension telephone available to receive faxes
With this setting turned on, you can alert the product to pick up the incoming fax call by pressing 1-2-3
sequentially on the telephone keypad. The default setting is On. Turn this setting off only if you use
pulse dialing or if you have a service from your telephone company that also uses the 1-2-3 sequence.
The telephone company service does not work if it conflicts with the product.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select Fax Recv. setup, and then press OK.

4. Use the arrow buttons to select Extension Phone, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK to save the selection.
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Use fax
Fax software

Supported fax programs
The PC fax program that came with the product is the only PC fax program that works with the product.
In order to continue to use a PC fax program previously installed on the computer, it must be used with
the modem that is already connected to the computer; it will not function through the product modem.

Available cover-page templates
Several business and personal fax cover-page templates are available in the HP LaserJet Send Fax
software program.

NOTE: Cover-sheet templates cannot be altered. While fields within the templates may be edited, the
templates themselves are fixed forms.

Customize a fax cover sheet
1. Open the HP LaserJet Send Fax software program.

2. In the Fax To section, provide the recipient fax number, name, and company.

3. In the Resolution section, select a resolution setting.

4. In the Include With Fax section, select Cover Page.

5. Add more information in the Notes and Subject text boxes.

6. In the Cover Page Template drop-down box, select a template, and then select Pages in
Document Tray.

7. Do one of the following:

● Click Send Now to send the fax without previewing the cover page.

● Click Preview to view the cover page prior to sending the fax.

Cancel a fax
Use these instructions to cancel a single fax that is currently dialing or a fax that is being transmitted or
received.

Cancel the current fax
Press Cancel on the control panel. Any pages that have not been transmitted are canceled. Pressing
Cancel also stops group-dial jobs.
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Cancel a pending fax job
Use this procedure to cancel a fax job in the following situations:

● The product is waiting to redial after encountering a busy signal, an unanswered call, or a
communication error.

● The fax is scheduled to be sent at a future time.

Use the following steps to cancel a fax job by using the Fax Job status menu:

1. On the control panel, press Setup.

2. Press OK to select Fax Job status.

3. Use the arrow buttons to scroll through pending jobs until you reach the job that you want to clear.

4. Press OK to select the job that you want to cancel.

5. Press OK to confirm that you want to cancel the job.

Delete faxes from memory
Use this procedure only if you are concerned that someone else has access to your product and might
try to reprint faxes from the memory.

CAUTION: In addition to clearing the reprint memory, this procedure clears any fax that is currently
being sent, unsent faxes that are pending redial, faxes that are scheduled to be sent at a future time,
and faxes that are not printed or forwarded.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax functions, and then press OK.

3. Use the arrow buttons to select Clear saved faxes, and then press OK.

4. Press OK to confirm the deletion.

Use fax on a DSL, PBX, ISDN, or VoIP system
HP products are designed specifically for use with traditional analog phone services. They are not
designed to work on DSL, PBX, ISDN lines, or VoIP services, but they might work with the proper setup
and equipment.

NOTE: HP recommends discussing DSL, PBX, ISDN, and VoIP setup options with the service
provider.

The HP LaserJet product is an analog device that is not compatible with all digital phone environments
(unless a digital-to-analog converter is used). HP does not guarantee that the product will be compatible
with digital environments or digital-to-analog converters.

DSL
A digital subscriber line (DSL) uses digital technology over standard copper telephone wires. This
product is not directly compatible with digital signals. However, if the configuration is specified during
DSL setup, the signal can be separated so that some of the bandwidth is used to transmit an analog
signal (for voice and fax) while the remaining bandwidth is used to transmit digital data.
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NOTE: Not all faxes are compatible with DSL services. HP does not guarantee that the product will
be compatible with all DSL service lines or providers.

The DSL modem requires a high-pass filter. The service provider typically provides a low-pass filter, for
normal telephone wiring.

NOTE: Contact the DSL provider for more information or for assistance.

PBX
The product is an analog device that is not compatible in all digital phone environments. Digital-to-analog
filters or converters may be needed for faxing functionality. If faxing issues occur in a PBX environment,
it might be necessary to contact the PBX provider for assistance. HP does not guarantee that the product
will be compatible with digital environments or digital-to-analog converters.

Contact the PBX provider for more information and for assistance.

ISDN
Contact the ISDN provider for more information and for assistance.

VoIP
Voice over internet protocol (VoIP) services are often not compatible with fax machines unless the
provider explicitly states that it supports fax over IP services.

If the product experiences problems getting a fax to work on a VoIP network, verify that all cables and
settings are correct. Decreasing the fax-speed setting might allow the product to send a fax over a VoIP
network.

If faxing problems continue, contact the VoIP provider.

Send a fax

Fax from the flatbed scanner
1. Make sure that the automatic document feeder (ADF) contains no media.

2. Lift the flatbed scanner cover.

3. Place the original document face-down on the flatbed scanner with the upper-left corner of the
document at the lower-right corner of the glass.

4. Gently close the lid.

5. Use the alphanumeric buttons on the control panel to dial the number.

-or-
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If the fax number you are calling has been assigned to a one-touch key, press that key.

-or-

If the fax number you are calling has a speed dial or group-dial entry, press Phone Book, use the
alphanumeric buttons to specify the speed dial or group-dial entry, and then press OK.

6. On the control panel, press Start Fax.

The control-panel display shows the following message: Send from glass? 1=Yes 2=No.

7. Press 1 to select Yes. The control-panel display shows the following message: Load page: X
Press OK, where X is the page number.

8. Press OK. After scanning the page, the product control-panel display shows the following message:
Another page? 1=Yes 2=No.

9. If you have more pages to scan, press 1 to select Yes, and then repeat step 3 for each page of the
fax job.

-or-

If you are finished, press 2 to select No, and then go to the next step.

Fax from the automatic document feeder (ADF)

NOTE: The ADF capacity is up to 50 sheets of 80 g/m2 or 20 lb media.

CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF. Use the flatbed glass to scan these items.

1. Insert the top-end of the stack of originals into the ADF input tray, with the media stack face-up
and the first page to be copied on top of the stack.

If the media is longer than Letter- or A4-sized paper, pull out the ADF input tray extension to support
the media.

2. Slide the stack into the ADF until it does not move any farther.

Document loaded appears on the control-panel display.
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3. Adjust the media guides until they are snug against the media.

4. Use the alphanumeric buttons on the control panel to dial the number.

-or-

If the fax number you are calling has been assigned to a one-touch key, press that key.

-or-

If the fax number you are calling has a speed dial or group-dial entry, press Phone Book, use the
alphanumeric buttons to specify the speed dial or group-dial entry, and then press OK.

5. On the control panel, press Start Fax. The product starts the fax job.

Fax a two-sided original
To fax a two-sided document, use the scanner glass. See Fax from the flatbed scanner on page 118.

Manual dial faxing
Usually, the product dials after you press Start Fax. At times, however, you might want the product to
dial each number as you press it. For example, if you are charging your fax call to a calling card, you
might need to dial the fax number, wait for the acceptance tone of your telephone company, and then
dial the calling card number. When dialing internationally, you might need to dial part of the number and
then listen for dial tones before continuing to dial.

Dial manually with the automatic document feeder (ADF)

1. Load the document into the automatic document feeder (ADF) input tray.

2. On the control panel, press Start Fax.

3. Begin dialing.

NOTE: The product dials the number as you press each digit. This allows you to wait for pauses,
dial tones, international-access tones, or calling-card-acceptance tones before continuing to dial.

Dial manually with the flatbed scanner

1. On the control panel, press Start Fax.

The control-panel display shows the following message: Send from glass? 1=Yes 2=No.

2. Press 1 to select Yes. The control-panel display shows the following message: Load page: X
Press OK, where X is the page number.

3. Scan a page into memory by placing the sheet print-side-down on the flatbed scanner and pressing
OK. After scanning the page, the product control-panel display shows the following message:
Another page? 1=Yes 2=No.
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4. If you have more pages to scan, press 1 to select Yes, and then repeat step 3 for each page of the
fax job.

-or-

If you are finished, press 2 to select No, and then go to the next step.

5. When all pages are scanned into memory, begin dialing. The product dials the number as you
press each digit. This allows you to wait for pauses, dial tones, international access tones, or calling
card acceptance tones before continuing to dial.

Send a fax to a group manually (ad hoc faxing)

Use the following instructions to send a fax to a group of recipients that has not been assigned a group-
dial entry:

1. Load the document into the automatic document feeder (ADF) input tray or on the flatbed scanner.

2. Use the alphanumeric buttons.

-or-

If the fax number that you are calling has been assigned a speed-dial entry, press Phone Book,
use the alphanumeric buttons to specify the speed-dial entry, and then press OK.

3. Press OK.

4. To continue dialing numbers, repeat steps 2 and 3.

-or-

If you are finished dialing numbers, go to the next step.

5. Press Start Fax. If the pages that you want to send are in the ADF, then faxing begins automatically.

6. If the product ADF sensor detects that no document is loaded into the ADF input tray, Send from
glass? 1=Yes 2=No appears on the control-panel display. To send the fax from the flatbed
scanner, press 1 to select Yes, and then press OK.

Load Page: X Press OK appears on the control-panel display.

7. If you have already placed the document on the flatbed scanner, press OK (or place the document
on the flatbed scanner and then press OK).

After scanning the page, Another page? 1=Yes 2=No appears on the control-panel display.

8. If you have more pages to scan, press 1 to select Yes, and then repeat step 7 for each page of the
fax job.

-or-

If you are finished, press 2 to select No.

The product sends the fax to each fax number. If a number in the group is busy or does not answer, the
product redials that number based on the redial setting. If all redial attempts fail, the product updates
the fax activity log by adding the error, and then it proceeds to the next number in the group.
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Redial manually

1. Load the document into the automatic document feeder (ADF) input tray or onto the flatbed
scanner.

2. On the control panel, press Redial.

3. Press Start Fax. If the pages that you want to send are in the ADF, then faxing begins automatically.

4. If the product ADF sensor detects that no document is loaded into the ADF input tray, Send from
glass? 1=Yes 2=No appears on the control-panel display. To send the fax from the flatbed
scanner, press 1 to select Yes, and then press OK.

After you press OK, Load page: X Press OK appears on the control-panel display.

5. If you have already placed the document on the flatbed scanner, press OK (or place the document
on the flatbed scanner and then press OK).

After scanning the page, Another page? 1=Yes 2=No appears on the control-panel display.

6. If you have more pages to scan, press 1 to select Yes, and then repeat step 5 for each page of the
fax job.

-or-

If you are finished, press 2 to select No.

The product sends the fax to the number that it redialed. If the number is busy or does not answer, the
product redials the number based on its redial setting. If all redial attempts fail, the product updates the
fax activity log by adding the error.

Use speed dials and group-dial entries

Send a fax by using a speed dial

1. Load the document into the automatic document feeder (ADF) input tray or on the flatbed scanner.

2. Press the one-touch key for the speed dial.

-or-

Press Phone Book, use the alphanumeric buttons to specify the speed-dial entry, and then press
OK.

3. Load the document into the automatic document feeder (ADF) input tray or on the flatbed scanner.

4. Press Start Fax. If the pages that you want to send are in the ADF, then faxing begins automatically.

5. If the product ADF sensor detects that no document is loaded into the ADF input tray, Send from
glass? 1=Yes 2=No appears on the control-panel display. To send the fax from the flatbed
scanner, press 1 to select Yes, and then press OK.

After you press OK, Load page: X Press OK appears on the control-panel display.

6. If you have already placed the document on the flatbed scanner, press OK (or place the document
on the flatbed scanner and then press OK).
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After scanning the page, Another page? 1=Yes 2=No appears on the control-panel display.

7. If you have more pages to scan, press 1 to select Yes, and then repeat step 5 for each page of the
fax job.

-or-

If you are finished, press 2 to select No.

When the last page of the fax has exited the product, you can start sending another fax, copying, or
scanning.

You can assign a speed dial to numbers that you use regularly. See Create and edit speed dials
on page 101. If you have electronic phone books available, you might be able to use them to select
recipients. Electronic phone books are generated by using third-party software programs.

Send a fax by using a group-dial entry

1. Load the document into the automatic document feeder (ADF) input tray or on the flatbed scanner.

2. Press the one-touch key for the group.

-or-

Press Phone Book, use the alphanumeric buttons to specify the group-dial entry, and then press
OK.

3. Press Start Fax. If the pages that you want to send are in the ADF, then faxing begins automatically.

4. If the product ADF sensor detects that no document is loaded into the ADF input tray, Send from
glass? 1=Yes 2=No appears on the control-panel display. To send the fax from the flatbed
scanner, press 1 to select Yes, and then press OK.

After you press OK, Load page: X Press appears on the control-panel display.OK.

5. If you have already placed the document on the flatbed scanner, press OK (or place the document
on the flatbed scanner and then press OK).

After scanning the page, Another page? 1=Yes 2=No appear on the control-panel display.

6. If you have more pages to scan, press 1 to select Yes, and then repeat step 5 for each page of the
fax job.

-or-

If you are finished, press 2 to select No.

The product scans the document into memory and sends the fax to each number specified. If a number
in the group is busy or does not answer, the product redials the number based on its redial setting. If all
redial attempts fail, the product updates the fax activity log with the error and proceeds to the next
number in the group.
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Send a fax from the software
This section contains basic instructions for sending faxes by using the software that came with the
product. All other software-related topics are covered in the software Help, which can be opened from
the software-program Help menu.

You can fax electronic documents from a computer if you meet the following requirements:

● The product is connected directly to the computer or connected to the computer over a TCP/IP
network.

● The product software is installed on the computer.

● The computer operating system is Microsoft Windows XP, Windows Vista, Mac OS X v10.3, or
Mac OS X v10.4.

Send a fax from the software (Windows XP or Vista)

The procedure to send a fax varies according to your specifications. The most typical steps follow.

1. Click Start, click Programs (or All Programs in Windows XP), and then click Hewlett-Packard.

2. Click HP LaserJet product, and then click Send fax. The fax software appears.

3. Enter the fax number of one or more recipients.

4. Load the document in the automatic document feeder (ADF) input tray.

5. Include a cover page. (This step is optional.)

6. Click Send Now.

Send a fax from the software (Mac OS X v10.3)

1. Load the document into the automatic document feeder (ADF) input tray or the flatbed scanner.

2. Open HP Director and click Fax. The fax software appears.

3. Select Fax from the Print dialog.

4. Enter the fax number of one or more recipients.

5. Include a cover page (this step is optional).

6. Click Fax.

Send a fax from the software (Mac OS X v10.4)

Using Mac OS X v10.4, you can choose between two methods of sending faxes from the product
software.

To send a fax by using HP Director complete the following steps:

1. Load the document into the automatic document feeder (ADF) input tray or the flatbed scanner.

2. Open HP Director by clicking the icon in the dock, and then click Fax. The Apple print dialog
appears.

3. Select Fax PDF from the PDF pop-up menu.

4. Enter the fax number of one or more recipients under To.
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5. Select the product under Modem.

6. Click Fax.

To send a fax by printing to a fax driver, complete the following steps:

1. Open the document that you want to fax.

2. Click File and then click Print.

3. Select Fax PDF from the PDF pop-up menu.

4. Enter the fax number of one or more recipients under To.

5. Select the product under Modem.

6. Click Fax.

Send a fax from a third-party software program, such as Microsoft Word (all operating systems)

1. Open a document in a third-party program.

2. Click the File menu, and then click Print.

3. Select the fax print driver from the printer driver drop-down list. The fax software appears.

4. Complete one of the following procedures:

● Windows

a. Enter the fax number of one or more recipients.

b. Include a cover page. (This step is optional.)

c. Include any pages loaded at the product. (This step is optional.)

d. Click Send Now.

● Macintosh

a. Mac OS X v10.3: Select Fax from the Print dialog.

-or-

Mac OS X v10.4: Select Fax PDF from the PDF pop-up menu.

b. Enter the fax number of one or more recipients.

c. Mac OS X v10.3: Include a cover page (this step is optional).

-or-

Mac OS X v10.4: Select the product under Modem.

d. Click Fax.
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Send a fax by dialing from a downstream phone 
Occasionally, you might want to dial a fax number from a telephone that is connected to the same line
as the product. For example, if you are sending a fax to a person whose device is in the manual receive
mode, you can precede the fax with a voice call to let that person know that the fax is coming.

NOTE: The telephone must be connected to the product "telephone" port ( ).

1. Load the document into the automatic document feeder (ADF) input tray.

NOTE: You cannot use the flatbed scanner when sending a fax by dialing from an extension
telephone.

2. Pick up the handset of a telephone that is connected to the same line as the product. Dial the fax
number by using the telephone keypad.

3. When the recipient answers, instruct the person to start the fax machine.

4. When you hear the fax tones, press Start Fax, wait until Connecting appears on the control-panel
display, and then hang up the telephone.

Send a delayed fax
Use the product control panel to schedule a fax to be sent automatically at a future time to one or more
people. When this procedure is completed, the product scans the document into memory and then
returns to the Ready state.

NOTE: If the product cannot transmit the fax at the scheduled time, that information is indicated on
the fax error report (if that option is turned on) or recorded in the fax activity log. The transmittal might
not be initiated because the fax-sending call is not answered, or because a busy signal stops the redial
attempts.

If a fax has been scheduled to be sent at a future time but it requires updating, send the additional
information as another job. All faxes that are scheduled to go to the same fax number at the same time
are delivered as individual faxes.

1. Load the document into the automatic document feeder (ADF) input tray or onto the flatbed
scanner.

2. On the control panel, press Setup.

3. Use the arrow buttons until Fax functions appears, and then press OK.

4. Use the arrow buttons until Send fax later appears, and then press OK.

5. Use the alphanumeric buttons to enter the time.

6. If the product is set to the 12-hour time mode, use the arrow buttons to move the cursor past the
fourth character to set A.M. or P.M. Select 1 for A.M. or select 2 for P.M., and then press OK.

-or-

If the product is set to the 24-hour time mode, press OK.

7. Use the alphanumeric buttons to enter the date, and then press OK.

-or-

Accept the default date by pressing OK.
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8. Enter the fax number, enter the speed dial, or press the one-touch key.

NOTE: This feature does not support undefined (ad hoc) groups.

9. Press OK or Start Fax. The product scans the document into memory and sends it at the designated
time.

Use access codes, credit cards, or calling cards
To use access codes, credit cards, or calling cards, dial manually to allow for pauses and dialing codes.
See Manual dial faxing on page 120.

Send faxes internationally

To send a fax to an international destination, dial manually to allow for pauses and international dialing
codes. See Manual dial faxing on page 120.

Receive a fax
When the product receives a fax transmission, it prints the fax (unless the private-receive feature is
enabled) and also stores it automatically to flash memory.

Print a stored fax (when private receive feature is on)

To print stored faxes, you must provide the private-receive PIN. Once the product prints the stored faxes,
the faxes are deleted from memory.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the alphanumeric buttons to enter the product security PIN, and then press OK.

4. Use the arrow buttons to select Fax Recv. setup, and then press OK.

5. Use the arrow buttons to select Private receive, and then press OK.

6. Use the arrow buttons to select Print faxes, and then press OK.

Reprint a fax
If you want to reprint a fax because the print cartridge was empty or if the fax was printed on the wrong
type of media, you can try to reprint it. The amount of memory that is available determines the actual
number of faxes that are stored for reprinting. The most recent fax prints first; the oldest fax that is in
storage prints last.

These faxes are stored continuously. Reprinting them does not clear them from the memory. To clear
these faxes from the memory, see Delete faxes from memory on page 117.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax functions, and then press OK.

3. Use the arrow buttons to select Reprint last, and then press OK. The product begins reprinting
the most recently printed fax.

NOTE: To stop the printing at any time, press Cancel.
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CAUTION: If the Reprint faxes setting is set to Off, misprinted or faded faxes cannot be reprinted.

Receive faxes when fax tones are audible on the phone line
If you have a telephone line that receives both fax and telephone calls, and you hear fax tones when
you answer the telephone, you can start the receiving process in one of two ways:

● If you are close to the product, press Start Fax on the control panel.

● When you answer any telephone connected to the line (an extension telephone) and hear fax tones,
the product should begin answering the call automatically. If not, press 1-2-3 in sequence on the
telephone keypad, listen for fax transmission sounds, and then hang up.

NOTE: In order for the second method to work, the extension telephone setting must be set to Yes.
See Make an extension telephone available to receive faxes on page 115 to check or change the setting.

View a fax that was sent to your computer
In order to view faxes on a computer, the product must be configured to receive faxes to the computer.
See Set up the computer to receive faxes on page 112.

1. Open HP ToolboxFX.

2. Select the product.

3. Click Fax.

4. Click Fax Receive Log.

5. In the Fax Image column, click the “view” link of the fax that you want to view.

NOTE: Receiving faxes by using a computer is not supported for Macintosh.
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Solve fax problems
Fax error messages 

Alert and warning messages appear temporarily and might require the user to acknowledge the
message by pressing OK to resume or by pressing Cancel to cancel the job. With certain warnings, the
job might not complete or the print quality might be affected. If the alert or warning message is related
to printing and the auto-continue feature is on, the product will attempt to resume the printing job after
the warning has appeared for 10 seconds without acknowledgement.

Alert and warning message tables
Table 10-1  Alert and warning messages 

Control panel message Description Recommended action

Comm. error A fax communication error occurred between
the product and the sender or receiver.

Allow the product to retry sending the fax.
Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
call. Plug the product phone cord into a jack
for another phone line.

Try a different phone cord.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Fax delayed – Send memory full Fax memory is full. Cancel the fax by pressing OK or Cancel.
Resend the fax. You might need to send the
fax in multiple sections if the error occurs
again.

Fax is busy Canceled send The fax line to which you were sending a fax
was busy. The product has canceled sending
the fax.

Call the recipient to ensure that the fax
machine is on and ready.

Check that you are dialing the correct fax
number.

Check that the Redial if busy option is
enabled.

Check for a dial tone on the phone line by
pressing Start Fax.

Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.

Plug the product phone cord into a jack for
another phone line, and then try sending the
fax again.

Try a different phone cord.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Fax is busy Redial pending The fax line to which you were sending a fax
was busy. The product automatically redials
the busy number. See Set autoredial
on page 106.

Allow the product to retry sending the fax.

Call the recipient to ensure that the fax
machine is on and ready.
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Control panel message Description Recommended action

Check that you are dialing the correct fax
number.

Check for a dial tone on the phone line by
pressing Start Fax.

Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.

Plug the product phone cord into a jack for
another phone line, and try sending the fax
again.

Try a different phone cord.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Fax memory full Canceling recv. During the fax transmission, the product ran
out of memory. Only the pages that fit into
memory will be printed.

Print all of the faxes, and then have the
sender resend the fax. Have the sender
divide the fax job into multiple jobs before
resending. Cancel all fax jobs or clear the
faxes from memory. See Delete faxes from
memory on page 117.

Note: Adding a memory DIMM does not help
resolve this issue.

Fax memory full Canceling send During the fax job, the memory filled. All
pages of the fax have to be in memory for a
fax job to work correctly. Only the pages that
fit into memory were sent.

Print all received faxes or wait until all
pending faxes are sent.

Ask the sender to send the fax again.

Cancel all fax jobs or clear the faxes from
memory. See Delete faxes from memory
on page 117.

Fax recv. error An error occurred while trying to receive a fax. Ask the sender to resend the fax.

Try faxing back to the sender or another fax
machine.

Check for a dial tone on the phone line by
pressing Start Fax.

Check that the telephone cord is securely
connected by unplugging and replugging the
cord.

Make sure that you are using the telephone
cord that came with the product.

Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.

Decrease the fax speed. See Change the fax
speed on page 135. Ask the sender to
resend the fax.

Table 10-1  Alert and warning messages  (continued)
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Control panel message Description Recommended action

Turn off error-correction mode. See Set the
fax-error-correction mode on page 135. Ask
the sender to resend the fax.

Connect the product to a different phone line.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Fax Send error An error occurred while trying to send a fax. Try resending the fax.

Try faxing to another fax number.

Check for a dial tone on the phone line by
pressing Start Fax.

Check that the telephone cord is securely
connected by unplugging and replugging the
cord.

Make sure that you are using the telephone
cord that came with the product.

Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.

Connect the product to a different phone line.

Set the fax resolution to Standard instead of
the default of Fine. See Set resolution
settings on page 107.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Group dial not allowed in group The speed-dial code that you typed is
programmed for a group. Adding a group-dial
to another group-dial is not allowed.

Add one-touch buttons (programmed as an
individual speed dial) or speed-dial codes to
a group-dial.

Invalid entry Invalid data or response. Correct the entry.

No Dial Tone The product could not detect a dial tone. Check for a dial tone on the phone line by
pressing Start Fax.

Unplug the telephone cord from both the
product and the wall and replug the cord.

Make sure that you are using the telephone
cord that came with the product.

Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
voice call.

Plug the product phone cord into a jack for
another phone line. See Connect to a
telephone line on page 95.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Table 10-1  Alert and warning messages  (continued)
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Control panel message Description Recommended action

No document sent The product did not scan any pages, or it did
not receive any pages from the computer to
transmit a fax.

Try sending the fax again.

No fax answer Redial pending The receiving fax line did not answer. The
product attempts to redial after a few minutes.

Allow the product to retry sending the fax.

Call the recipient to ensure that the fax
machine is on and ready.

Check that you are dialing the correct fax
number.

If the product continues to redial, unplug the
product telephone cord from the wall, plug in
a telephone, and try making a voice call.

Plug the product phone cord into a jack for
another phone line.

Try a different phone cord.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

No fax answer. Canceled send Attempts to redial a fax number failed, or the
“Redial-no answer” option was turned off.

Call the recipient to ensure that the fax
machine is on and ready.

Check that you are dialing the correct fax
number.

Check that the redial option is enabled.

Unplug the telephone cord from both the
product and the wall and replug the cord.

Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
voice call.

Plug the product phone cord into a jack for
another phone line.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

No fax detected The product answered the incoming call but
did not detect that a fax machine was calling.

Allow the product to retry receiving the fax.

Try a different phone cord.

Plug the product phone cord into a jack for
another phone line.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Fax memory is retained when there is a loss of power
The HP LaserJet M2727 mfp flash memory protects against data loss when a power failure occurs.
Other fax devices store fax pages in either normal RAM or short-term RAM. Normal RAM immediately

Table 10-1  Alert and warning messages  (continued)
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loses data when power is lost, while short-term RAM loses data about 60 minutes after a power failure
occurs. Flash memory can maintain its data for years without power applied.

Fax logs and reports
Use the following instructions to print fax logs and reports:

Print all fax reports
Use this procedure to print all of the following reports at one time:

● Fax activity log

● Phone book report

● Configuration report

● Usage page

● Block-fax list

● Billing report (if the option is turned on)

 

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Fax Reports, and then press OK.

4. Use the arrow buttons to select All fax reports, and then press OK. The product exits the menu
settings and prints the reports.

Print individual fax reports
Use the control panel to print the following fax logs and reports:

● Fax activity log: Provides a chronological history of the last 40 faxes that were received, sent, or
deleted, and any errors that occurred.

● Phone book report: Lists the fax numbers that are assigned to the phone book entries, including
speed dials and group-dial entries.

● Block-fax list: Lists the fax numbers that are blocked from sending faxes to the product.

● Last call report: Provides information about the last fax sent from or received at the product.

 

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Fax Reports, and then press OK.

4. Use the arrow buttons to select the report to be printed, and then press OK. The product exits the
menu settings and prints the report.

ENWW Solve fax problems 133



NOTE: If you selected Fax Activity log and pressed OK, press OK again to select Print log
now. The product exits the menu settings and prints the log.

Set the fax activity log to print automatically
You can decide whether or not you want the fax log to print automatically after every 40 entries. The
factory-set default is On. Use the following steps to set the fax activity log to print automatically:

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Fax Reports, and then press OK.

4. Use the arrow buttons to select Fax Activity log, and then press OK.

5. Use the arrow buttons to select Auto Log Print, and then press OK.

6. Use the arrow buttons to select On, and then press OK to confirm the selection.

Set the fax error report
A fax error report is a brief report that indicates the product experienced a fax job error. It can be set to
print after the following events:

● Every fax error (the factory-set default)

● Send fax error

● Receive fax error

● Never

NOTE: If you select Never, you will have no indication that a fax failed to be transmitted unless you
print a fax activity log.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Fax Reports, and then press OK.

4. Use the arrow buttons to select Fax Error report, and then press OK.

5. Use the arrow buttons to select the option for when you want the fax error reports to be printed.

6. Press OK to save the selection.

Set the fax confirmation report
A confirmation report is a brief report that indicates the product successfully sent or received a fax job.
It can be set to print after the following events:

● Every fax job

● Send fax

● Receive fax

● Never (the factory-set default)
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1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Fax Reports, and then press OK.

4. Use the arrow buttons to select Fax Confirmation, and then press OK.

5. Use the arrow buttons to select the option for when you want the fax error reports to be printed.

6. Press OK to save the selection.

Include the first page of each fax on the fax confirmation, fax error, and last call reports
If this option is turned on and the page image still exists in the product memory, the fax configuration,
fax error, and last call reports include a thumbnail (50% reduction) of the first page of the most recent
fax that was sent or received. The factory-set default for this option is On.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press OK.

3. Use the arrow buttons to select Fax Reports, and then press OK.

4. Use the arrow buttons to select Include 1st page, and then press OK.

5. Use the arrow buttons to select On, and then press OK to confirm the selection.

Change error correction and fax speed

Set the fax-error-correction mode
Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select All faxes, and then press OK.

4. Use the arrow buttons to select Error correction, and then press OK.

5. Use the arrow buttons to select On or Off, and then press OK to save the selection.

Change the fax speed
The fax-speed setting is the modem protocol that the product uses to send faxes. It is the worldwide
standard for full-duplex modems that send and receive data across telephone lines at up to 33,600 bits
per second (bps). The factory-set default for the fax-speed setting is High (V.34).
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You should change the setting only if you are having trouble sending a fax to or receiving a fax from a
particular device. Decreasing the fax speed might be useful when you are trying to send a fax overseas,
or receive one from overseas, or if you are using a satellite telephone connection.

1. On the control panel, press Setup.

2. Use the arrow buttons to select Fax setup, and then press OK.

3. Use the arrow buttons to select All faxes, and then press OK.

4. Use the arrow buttons to select Fax Speed, and then press OK.

5. Use the arrow buttons to select a speed setting, and then press OK.

Problems sending faxes

Problem Cause Solution

The document stops feeding in the
middle of faxing.

The maximum length of a page that you
can load is 381 mm (15 inches). Faxing
of a longer page stops at 381 mm (15
inches).

Print the document on shorter media.

If no jam exists and less than one minute
has elapsed, wait a moment before
pressing Cancel. If a jam exists, remove
the jam. Then, resend the job.

If the item is too small, it can jam inside
the automatic document feeder (ADF). 

Use the flatbed scanner. The minimum
page size for the ADF is 127 x 127 mm
(5 x 5 inches).

If a jam exists, remove the jam. Then,
resend the job.

Faxes stop during sending. The receiving fax machine might be
malfunctioning.

Try sending to another fax machine.

The telephone line might not be working. Do one of the following:

● Turn up the volume on the product,
and then press Start Fax on the
control panel. If you hear a dial tone,
the telephone line is working.

● Disconnect the product from the
jack in the wall, and then connect a
telephone to the jack. Try to make a
telephone call to verify that the
telephone line is working.

A communication error might be
interrupting the fax job.

Change the redial-on-communication-
error setting to On.
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Problem Cause Solution

The product is receiving faxes but is not
sending them.

If the product is on a digital system, the
system might be generating a dial tone
that the product cannot detect.

Disable the detect-dial-tone setting.

If the error persists, contact the system
service provider.

A poor telephone connection might exist. Try again later.

The receiving fax machine might be
malfunctioning.

Try sending to another fax machine.

The telephone line might not be working. Do one of the following:

● Turn up the volume on the product
and press Start Fax on the control
panel. If a dial tone exists, the
telephone line is working.

● Disconnect the product from the
telephone jack and connect a
telephone. Try to make a telephone
call to verify that the telephone line
is working.

Outgoing fax calls continue to be dialed. The product automatically redials a fax
number if the redial options are set to
On.

To stop the product from redialing a fax,
press Cancel. Or change the redial
setting.

Sent faxes are not arriving at the
receiving fax machine.

The receiving fax machine might be off
or might have an error condition, such as
being out of paper.

Call the recipient to verify that the fax
machine is on and ready to receive
faxes.

The originals might be incorrectly loaded. Verify that the original documents are
correctly loaded into the ADF input tray
or flatbed scanner.

A fax might be in memory because it is
waiting to redial a busy number, other
jobs that are ahead of it are waiting to be
sent, or the fax is set up for a delayed
send.

If a fax job is in memory for any of these
reasons, an entry for the job appears in
the fax log. Print the fax activity log and
check the Status column for jobs that
show a Pending designation.

Sent faxes include a block of gray
shading at the end of each page.

The glass-fax size might be set
incorrectly.

Verify that the setting is correct.

Sent faxes have data missing from the
end of each page.

The glass-fax size might be set
incorrectly.

Verify that the setting is correct.

The control panel shows a low-memory
error.

The fax might be too large, or the
resolution might be too high.

Try one of the following:

● Divide a large fax into smaller
sections, and then fax them
individually.

● Clear stored faxes to make more
memory available for outgoing
faxes.

● Configure the outgoing fax as a
delayed fax, and then verify that it
will send completely.

● Make sure that the product is using
the lowest resolution setting
(Standard).
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Problems receiving faxes
Use the table in this section to solve problems that might occur when receiving faxes.

NOTE: Use the fax cord that came with the product in order to ensure that the product functions
correctly.

Problem Cause Solution

The product cannot receive faxes from
an extension telephone.

The extension-telephone setting might
be disabled.

Change the extension-telephone setting.

The fax cord might not be securely
connected.

Verify that the fax cord is securely
connected between the telephone jack
and the product (or another device that is
connected to the product). Press 1-2-3 in
sequence, wait for three seconds, and
then hang up.

The product dialing mode might be
incorrectly set, or the extension phone
might be incorrectly set.

Verify that the product dialing mode is set
to Tone. Verify that the extension phone
is set up for tone dialing as well.

The product is not answering incoming
fax calls.

The answer mode might be set to
Manual.

If the answer mode is set to Manual, the
product does not answer calls. Start the
fax-receiving process manually.

The rings-to-answer setting might not be
set correctly.

Check the rings-to-answer setting to
verify that it is set properly.

The answer-ring pattern feature might be
turned on, but you do not have the
service, or you do have the service and
the feature is not set correctly.

Check the answer-ring pattern feature to
verify that it is set properly.

The fax cord might not be correctly
connected, or the fax cord is not working.

See the getting started guide to check
the installation. Verify that you are using
the fax cord that came with the product.

The product might not be able to detect
incoming fax tones because the
answering machine is playing a voice
message.

Re-record the answering machine
message, leaving at least two seconds of
silence at the beginning of the message.

Too many devices might be connected to
the telephone line.

Do not attach more than three devices to
the line. Remove the last device that was
connected and determine whether the
product works. If not, continue removing
devices one at a time and retry after
removing each one.

The telephone line might not be working. Do one of the following:

● Increase the volume on the product,
and then press Start Fax on the
control panel. If a dial tone exists,
the telephone line is working.

● Disconnect the product from the
telephone jack, and then connect a
telephone. Try to make a telephone
call to verify that the telephone line
is working.
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Problem Cause Solution

The product is not answering incoming
fax calls.

A voice-messaging service might be
interfering with the product as it attempts
to answer calls.

Do one of the following:

● Disable the messaging service.

● Get a telephone line that is
dedicated to fax calls.

● Set the product answer mode to
Manual. In manual mode, you must
start the fax-receive process
yourself.

● Leave the product set to automatic
mode and lower the rings-to-
answer setting for the product to a
number less than the rings-to-
answer setting for the voice mail.
The product will answer all
incoming calls.

The product might be out of paper and
the memory is full.

Refill the media input tray. Press OK. The
product prints all of the faxes it has saved
in memory and then resumes answering
fax calls.

Faxes are not printing. The media input tray is empty. Load media. Any faxes that are received
while the input tray is empty are stored in
memory and will print after the tray has
been refilled.

The receive-to-PC option might be
selected, and faxes are being received
by the computer.

Check to determine whether the
computer is receiving faxes.

The product has encountered an error. Check the control panel for an error
message, and then see Fax error
messages on page 129.

Faxes are printing on two pages instead
of one.

The autoreduction setting might not be
set correctly.

Turn on the autoreduction setting.

The incoming faxes might have been
sent on larger media.

Adjust the autoreduction setting to allow
larger pages to be printed on one page.

Received faxes are too light, are blank,
or have poor print quality.

The product ran out of toner while
printing a fax.

The product stores the most recently
printed faxes. (The amount of memory
that is available determines the actual
number of faxes stored for reprinting.) As
soon as possible, replace the print
cartridge, and then reprint the fax.

The fax that was sent was too light. Contact the sender and have the sender
resend the fax after altering the contrast
settings.
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Performance problems

Problem Cause Solution

Faxes are transmitting or being received
very slowly.

The fax might be very complex, such as
one with many graphics.

Complex faxes take longer to be sent or
received. Breaking longer faxes into
multiple jobs and decreasing the
resolution can increase the transmission
speed.

The receiving fax machine might have a
slow modem speed.

The product sends the fax only at the
fastest modem speed that the receiving
fax machine can accept.

The resolution at which the fax was sent
or is being received might be very high.

To receive the fax, call and ask the
sender to lower the resolution and
resend the fax. To send the fax, lower the
resolution and resend the fax.

The telephone line might be
experiencing line noise.

Hang up and resend the fax. Have the
telephone company check the telephone
line.

If the fax is being sent via a digital phone
line, contact the service provider.

The fax is being sent via an international
call.

Allow more time to transmit fax jobs
internationally.

The original document has a colored
background.

Reprint the original document with a
white background, and then resend the
fax.

The fax activity logs or fax call reports are
printing at inappropriate times.

The fax activity log or fax call reports
settings are not correct.

Print a configuration page and check
when the reports print.

The product sounds are too loud or too
soft.

The volume setting might not be adjusted
correctly.

Adjust the product volume setting.
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11 Manage and maintain the product

● Information pages

● HP ToolboxFX

● Embedded Web server

● Use HP Web Jetadmin software

● Security features

● Use the convenience stapler (HP LaserJet M2727nfs mfp only)

● Manage supplies
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Information pages
Information pages reside within the product memory. These pages help diagnose and solve problems
with the product.

NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System setup menu on the control panel or the embedded Web server. See Control panel
on page 9.

Page description How to print the page

Configuration page

Shows the current settings and product properties.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press
OK.

3. Use the arrow buttons to select Config report, and then
press OK.

A second page also prints. On that page, the Fax Settings
section provides details about the product fax settings.

Supplies status page

Shows the remaining life of the HP print cartridge, the
estimated pages remaining, the number of pages printed, and
other supplies information.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press
OK.

3. Use the arrow buttons to select Supplies Status, and
then press OK.

PCL, PCL 6, or PS font list

Shows which fonts are currently installed in the device.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press
OK.

3. Use the arrow buttons to select PCL font list, PS font
list, or PCL6 font list, and then press OK.

Demo page

Contains examples of text and graphics.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press
OK.

3. Use the arrow buttons to select Demo page, and then
press OK.

Event log You can print the event log from HP ToolboxFX, the embedded
Web server, or HP Web Jetadmin. See HP ToolboxFX
on page 144, Embedded Web server on page 153, or the Web
Jetadmin Help.

Usage page

Shows a page count for each size of paper printed, the number
of one-sided (simplexed) or two-sided (duplexed) pages, and
the average percentage of coverage.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press
OK.

3. Use the arrow buttons to select Usage page, and then
press OK.
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Page description How to print the page

Menu map

Shows the control-panel menus and available settings.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press
OK.

3. Use the arrow buttons to select Menu structure, and then
press OK.

Network report

Shows the product network settings.

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Reports, and then press
OK.

3. Use the arrow buttons button to select Network report,
and then press OK.

Fax reports For information about fax logs and reports, see Fax logs and
reports on page 133.
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HP ToolboxFX
HP ToolboxFX is a program that you can use to complete the following tasks:

● Check the product status.

● Configure the product settings.

● View troubleshooting information.

● View online documentation.

You can view HP ToolboxFX when the product is directly connected to a computer or when it is
connected to the network. You must perform the recommended full software installation to use
HP ToolboxFX.

View HP ToolboxFX
Open HP ToolboxFX in one of these ways:

● In the Windows system tray or on your desktop, double-click the HP ToolboxFX icon.

● On the Windows Start menu, click Programs (or All Programs in Windows XP), click HP, click
HP LaserJet M2727, and then click HP ToolboxFX.

Status
The HP ToolboxFX Status tab contains links to the following main pages:

● Device Status. View product status information. This page indicates product conditions such as
a jam or an empty tray. After you correct a problem with the product, click Refresh status to update
the product status.

● Supplies Status. View detailed supplies information such as the estimated percent of life
remaining in the print cartridge and the number of pages that have been printed with the current
print cartridge. This page also has links to order supplies and to find recycling information.

● Device Configuration. View a detailed description of the current product configuration, including
the amount of memory installed and whether optional trays are installed.

● Network Summary. View a detailed description of the current network configuration, including the
IP address and network status.

● Print Info Pages. Print the configuration page and various other information pages that are
available for the product, such as the supplies status page and the demo page.

● Event Log. View a history of product errors. The most recent error is at the top of the list.

Event log
The event log is a four-column table where the product events are logged for your reference. The log
contains codes that correspond to the error messages that appear on the product control-panel display.
The number in the Page Count column specifies the total number of pages that the product had printed
when the error occurred. The event log also contains a brief description of the error. For more information
about error messages, see Control-panel messages on page 170.
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Alerts
The HP ToolboxFX Alerts tab contains links to the following main pages:

● Set up Status Alerts . Set up the product to send you pop-up alerts for certain events, such as
low toner levels.

● Set up E-mail Alerts. Set up the product to send you e-mail alert messages for certain events,
such as low toner levels.

Set up status alerts
Use HP ToolboxFX to set up the product so that it issues pop-up alerts to your computer when certain
events occur. Events that trigger alerts include jams, low levels of toner in HP print cartridges, non-HP
print cartridge in use, empty input trays, and specific error messages.

Select the pop-up format, the tray icon format, or both for the alerts. The pop-up alerts only appear when
the product is printing from the computer on which you set up the alerts.

NOTE: You must click Apply before the changes take effect.

Set up e-mail alerts
Use HP ToolboxFX to configure up to two e-mail addresses to receive alerts when certain events occur.
You can specify different events, such as a low cartridge or a paper jam, for each e-mail address. Enter
the information for the e-mail server that will send out the e-mail alert messages for the product.

NOTE: You must click Apply before the changes take effect.

Fax
Use the HP ToolboxFX Fax tab to perform fax tasks from your computer. The Fax tab contains links to
the following main pages:

● Fax Tasks. Perform such tasks as sending a fax or clearing the fax memory, or set the fax receive
mode.

● Fax Phone Book. Add, edit, or delete entries in the product phone book.

● Fax Send Log. View all of the recent faxes that have been sent from the product.

● Fax Receive Log. View all of the recent faxes that have been received by the product.

● Block Faxes. Add, delete, or view fax numbers that are blocked.

● Fax Data Properties. Manage the space used to store faxes on your computer. These settings
apply only if you have chosen to send or receive faxes remotely from your computer.
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Fax tasks
The following three options are available when receiving a fax:

● Print the fax. You can also select an option to have a message appear on your computer to notifying
you when the fax was printed.

● Receive the fax on your computer. You can also select an option to have a message appear on
your computer to notifying you when the fax arrives. If the fax machine is connected to multiple
computers, only one computer can be designated to receive faxes.

● Forward the fax to another fax machine.

For more information about fax tasks, see Fax on page 93.

NOTE: You must click Apply before the changes take effect.

Fax phone book
Use the HP ToolboxFX fax phone book to add and remove individuals or groups on your speed-dial list,
import phone books from a variety of sources, and update and maintain the contact list.

● To add an individual contact to the speed-dial list, select the row of the speed dial number that you
want to specify. Type the contact name in the Contact name window. Type the fax number in the
Fax number window. Click Add.

● To add a group of contacts to the speed-dial list, select the row of the speed-dial number that you
want to specify. Click Add Group. Double-click a contact name from the list on the left to move it
to the group list on the right, or select a name on the left and then click the appropriate arrow to
move it to the group list on the right. You can also use those two methods to move names from
right to left. When you have created a group, type a name in the Group name window, and then
click OK.

● To edit an existing individual speed-dial entry, click anywhere on the row containing the contact
name to select it, and then click Update. Type changes in the appropriate windows, and then click
OK.

● To edit an existing group-speed-dial entry, click anywhere on the row containing the group name
to select it, and then click Update Group. Make any required changes, and then click OK.

● To delete an entry from the speed-dial list, select the item, and then click Delete.

● To move speed dial entries, select the entry and then click Move, or select Move and then specify
the entry in the dialog box. Either select Next empty row or specify the number of the row where
you want to move the entry.

NOTE: If you specify a row that is occupied, the new entry will overwrite the existing entry.

● To import contacts from a phone book that exists in Lotus Notes, Outlook, or Outlook Express, click
Import/Export Phone Book. Select the Import option, and then click Next. Select the appropriate
software program, navigate to the appropriate file, and then click Finish. To export contacts from
a phone book, click Import/Export Phone Book. Select the Export option, and then click Next.
Enter the file name or browse to the file to which you want to export contacts, and then click
Finish. You can also select individual entries from the phone book instead of importing the entire
phone book.

● To delete all entries, click Delete All, and then click Yes.
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In addition to numerical digits, the following are valid characters for fax numbers:

● (

● )

● +

● -

● *

● #

● R

● W

● .

● ,

● <space>

NOTE: You must click Apply before the changes take effect.

For more information about faxes, see Fax on page 93.
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Fax send log
The HP ToolboxFX fax send log lists all recently sent faxes and information about them, including the
date and time sent, job number, fax number, page count, and the results.

Click any column heading in the fax send log to re-sort the information in that column in ascending or
descending order.

The Results column provides the fax status. If the fax attempt was unsuccessful, this column provides
a description of why the fax was not sent.

For more information about faxes, see Fax on page 93.

Fax receive log
The HP ToolboxFX fax receive log provides a list of all recently received faxes and information about
them including the date and time received, job number, fax number, page count, results, and an
abbreviated fax image.

The fax receive log can be used to block future faxes. Check the Block Fax box next to a received fax
listed on the log.

When a computer that is connected to the product receives a fax, the fax contains a View link. Clicking
this link opens a new page that provides information about the fax.

Click on any column heading in the fax receive log to re-sort the information in that column in ascending
or descending order.

The Results column provides the fax status. If the fax attempt was unsuccessful, this column provides
a description of why the fax was not received.

NOTE: You must click Apply before the changes take effect.

For more information about faxes, see Fax on page 93.

Block Faxes
Block Faxes provides a list of all numbers that are blocked. Add, modify, or delete blocked fax numbers
on this tab.

Help
The HP ToolboxFX Documentation tab contains links to the following main pages:

● Troubleshooting

● Animated demonstrations

● User Guide. View information about the product usage, warranty, specifications, and support. The
user guide is available in both HTML and PDF format.
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System Settings
The HP ToolboxFX System Settings tab contains links to the following main pages:

● Device Information. View information about the product, such as the product description and a
contact person.

● Paper Handling. Change the product paper-handling settings, such as default paper size and
default paper type.

● Print Quality. Change the product print-quality settings.

● Paper Types. Change the product mode settings for each media type, such as letterhead,
prepunched, or glossy paper.

● System Setup. Change the product system settings, such as product language and jam recovery.

● Service. Gain access to various procedures required to maintain the product.

● Device Polling. Change the product polling settings, which determine how often HP ToolboxFX
collects data from the product.

● Save/Restore Settings. Save the current settings for the product to a file on the computer. Use
this file to load the same settings onto another product or to restore these settings to this product
at a later time.

● Password. Set, change, or clear the product security password (see Turn on password protection
on page 103).

Device information
The HP ToolboxFX Device information page stores data about the product for future reference. The
information that you type in these fields appears on the Configuration page. You can type any character
in each of these fields.

NOTE: You must click Apply before the changes take effect.
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Paper handling
Use the HP ToolboxFX paper-handling options to configure the default settings. These are the same
options that are available on the product control-panel. For more information, see Control panel
on page 9.

Three options are available for handling print jobs when the product is out of media:

● Select Wait for paper to be loaded.

● Select Cancel from the Paper out action drop-down list to cancel the print job.

● Select Override from the Paper out time drop-down list to send the print job to another paper tray.

The Paper out time field specifies how long the product waits before acting on the selections. You can
specify from 0 to 3600 seconds.

NOTE: You must click Apply before the changes take effect.

Print quality
Use the HP ToolboxFX print-quality options to improve the appearance of print jobs. These are the same
options that are available on the product control panel. For more information, see Control panel
on page 9.

The four options provided for controlling print quality are resolution, REt (Resolution Enhancement
technology), print density, and EconoMode.

● Resolution. Select 600 resolution for average print jobs and Fast Res 1200 for higher-quality print
jobs. Select ProRes 1200 for the highest-quality print job, but a longer printing time.

● REt. You can turn on REt, which HP provides for improved print quality.

● Print density. For increased print density, select a higher number. For decreased print density,
select a lower number.

● EconoMode. Turn EconoMode on when you are printing average print jobs. EconoMode is a
feature that allows the product to use less toner per page. Selecting this option might extend the
life of the toner supply and might reduce cost per page. However, it will also reduce print quality.
The printed image is lighter, but it is adequate for printing drafts or proofs. HP does not recommend
full-time use of EconoMode. If EconoMode is used full-time, it is possible that the toner supply will
outlast the mechanical parts in the print cartridge. If print quality begins to degrade under these
circumstances, you will need to install a new print cartridge, even if there is toner supply remaining
in the cartridge.

NOTE: You must click Apply before the changes take effect.

Paper types
Use the HP ToolboxFX Paper types options to configure print modes that correspond to the various
media types. Select Restore Modes to reset all modes to the factory settings.

NOTE: You must click Apply before the changes take effect.
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System setup
Use the HP ToolboxFX system settings options to configure global settings for copy, fax, scan, and print,
such as jam recovery and auto-continue.

NOTE: You must click Apply before the changes take effect.

Service
During the printing process, paper, toner and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. HP ToolboxFX
provides an easy method for cleaning the paper path. For more information, see Clean the paper path
from HP ToolboxFX on page 162.

Device polling
You can turn off HP ToolboxFX device polling to reduce network traffic, but doing so also disables some
HP ToolboxFX features: pop-up alerts, fax log updates, the ability to receive faxes to this computer, and
scanning using the Scan To button.

NOTE: You must click Apply before the changes take effect.

Print Settings
The HP ToolboxFX Print Settings tab contains links to the following main pages:

● Printing. Change the default product print settings, such as number of copies and paper
orientation.

● PCL5e. View and change the PCL5 settings.

● PostScript. View and change the PS settings.

Printing
Use the HP ToolboxFX printing settings options to configure the settings for all print functions. These
are the same options that are available on the product control panel. For more information, see Control
panel on page 9.

NOTE: You must click Apply before the changes take effect.
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PCL 5e
Use the PCL 5 options to configure the settings when you are using the PCL5 print personality. These
are the same options that are available on the PCL5 menu on the control panel.

NOTE: You must click Apply before the changes take effect.

PostScript
Use the PostScript option when you are using the HP postscript level 3 emulation print personality. When
the Print PostScript error option is turned on, the PostScript error page automatically prints when
HP postscript level 3 emulation errors occur.

NOTE: You must click Apply before the changes take effect.

Network Settings
The network administrator can use the HP ToolboxFX Network Settings tab to control the network-
related settings for the product when it is connected to an IP-based network.
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Embedded Web server
This product is equipped with an embedded Web server (EWS), which provides access to information
about product and network activities. A Web server provides an environment in which web programs
may run, much in the same way that an operating system, such as Windows, provides an environment
for programs to run on a computer. The output from these programs can then be displayed by a Web
browser, such as Microsoft Internet Explorer, Safari, or Netscape Navigator.

An “embedded” Web server resides on a hardware device (such as an HP LaserJet product) or in
firmware, rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-
connected product and computer can use. There is no special software to install or configure, but you
must have a supported Web browser on the computer. To gain access to the EWS, type the IP address
for the product in the address line of the browser. (To find the IP address, print a configuration page.
For more information about printing a configuration page, see Information pages on page 142.)

NOTE: For Macintosh operating systems, you can use the EWS over a USB connection after installing
the Macintosh software included with the product.

Features
The EWS allows you to view product and network status and manage printing functions from a computer.
With the EWS, you can complete the following tasks:

● View product status information

● Determine the remaining life on all supplies and order new ones

● View and change part of the product configuration

● View and print some internal pages

● Select the language in which to display the EWS pages

● View and change network configuration

● Set, change, or clear the product security password (see Turn on password protection
on page 103).

NOTE: Changing network settings in the EWS might disable some of product software or features.
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Use HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. The intuitive browser interface simplifies cross-platform
management of a wide range of devices, including HP and non-HP devices. Management is proactive,
allowing network administrators the ability to resolve issues before users are affected. Download this
free, enhanced-management software at www.hp.com/go/webjetadmin_software. 

To obtain plug-ins to HP Web Jetadmin, click plug-ins, and then click the download link that is next to
the name of the plug-in that you want. The HP Web Jetadmin software can automatically notify you
when new plug-ins are available. On the Product Update page, follow the directions to automatically
connect to the HP Web site.

If installed on a host server, HP Web Jetadmin is available to any client through a supported Web
browser, such as Microsoft Internet Explorer 6.0 for Windows or Netscape Navigator 7.1 for Linux.
Browse to the HP Web Jetadmin host.

NOTE: Browsers must be Java-enabled. Browsing from an Apple PC is not supported.

Security features
Secure the embedded Web server

Use the EWS to set a password.

1. Open the EWS, and then click the System tab.

2. Click Password.

3. In the Password box, type the password you want to set, and then in the Confirm password box,
type the same password again to confirm your choice.

4. Click Apply to save the password.

Lock the control-panel menus
The product includes a password-protection feature that locks many menu items. For information about
setting up password protections, see Turn on password protection on page 103.

Private receive
The private receive feature allows you to store faxes in memory, without printing them, until you are at
the product and can proved a PIN to print the faxes. For more information, see Turn on private receive
feature on page 104.
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Use the convenience stapler (HP LaserJet M2727nfs mfp
only)
Staple documents

Activate the stapling mechanism by inserting media into the convenience stapler.

1. Insert up to 20 sheets of media (80 g/m2 or 20 lb) into the slot in the stapler door. Insert fewer
sheets to staple if the media weight is heavier than 80 g/m2 or 20 lb.

CAUTION: Do not use the convenience stapler to staple plastic, cardboard, or wood. Damage
to the convenience stapler can result from attempting to staple these materials.

NOTE: Exceeding the recommended capacity could result in jams or damage.

2. Wait for the stapler to staple the sheets. When it is inserted all the way into the stapler slot, the
media should trigger the stapler mechanism.

3. Remove the stapled media from the slot.

NOTE: If you are unable to remove the media after stapling, carefully open the stapler door and
then slide your document out.
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Load staples
Each staple cassette holds 1,500 unformed staples.

1. Open the stapler door.

NOTE: Opening the stapler door disables the stapler.

Instructions and replacement staples part numbers are listed on the stapler door.

2. If you are replacing a staple cassette (for example, if the staple cassette has run out of staples),
remove the staple cassette from the product.

3. Insert a new staple cassette into the opening inside the staple door.

4. Close the stapler door.
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Manage supplies
Check and order supplies

You can check the supplies status by using the product control panel, printing a supplies status page,
or viewing HP ToolboxFX. Hewlett-Packard recommends that you place an order for a replacement print
cartridge when Low message for a print cartridge first appears. Use a new, authentic HP print cartridge
to obtain the following types of supplies information:

● Amount of cartridge life remaining

● Estimated number of pages remaining

● Number of pages printed

● Other supplies information

NOTE: If the product is connected to the network, you can set HP ToolboxFX to notify you by e-mail
when a print cartridge is low. If the product is directly connected to a computer, you can set
HP ToolboxFX to notify you when supplies are low.

Check supplies status by using the control panel
Do one of the following:

● Check the product control panel, which indicates when a print cartridge is low or empty. The control
panel also indicates when a non-HP print cartridge is first installed.

● Print a supplies status page, and then check the supplies levels on the page.

If the supplies levels are low, you can order supplies through a local HP dealer, by telephone, or online.
See Accessories and ordering information on page 213 for part numbers. Go to www.hp.com/go/
ljsupplies to order online.

Check supplies status by using HP ToolboxFX
You can configure HP ToolboxFX to notify you when the supplies are low. Choose to receive alerts by
e-mail or as a pop-up message or taskbar icon.
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Store supplies
Follow these guidelines for storing print cartridges:

● Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage, do not expose the print cartridge to light for more than a few
minutes.

● See Environmental specifications on page 225 for operating and storage temperature ranges.

● Store the supply in a horizontal position.

● Store the supply in a dark, dry location away from heat and magnetic sources.

HP policy on non-HP supplies
Hewlett-Packard Company cannot recommend the use of non-HP supplies, either new or
remanufactured. Because they are not HP products, HP cannot influence their design or control their
quality. Service or repairs required as a result of using a non-HP supply will not be covered under the
warranty.

HP fraud hotline
Call the HP fraud hotline if the product or HP ToolboxFX indicates that the print cartridge is not an
HP print cartridge and you think that it is genuine. HP will help determine if the product is genuine and
take steps to resolve the problem.

The print cartridge might not be a genuine HP one if you notice the following issues:

● You are experiencing a large number of problems with the print cartridge.

● The print cartridge does not look like it usually does (for example, the pull tab or the box is different).

In the United States, call toll-free: 1-877-219-3183.

Outside the United States, you can call collect. Dial the operator and ask to place a collect call to this
telephone number: 1-770-263-4745. If you do not speak English, a representative at the HP fraud hotline
who speaks your language will assist you. Or, if someone who speaks your language is not available,
a language line interpreter will connect approximately one minute after the beginning of the call. The
language line interpreter is a service that will translate between you and the representative for the HP
fraud hotline.

Recycle supplies
To install a new HP print cartridge, follow the instructions that are included in the box that contains the
new supply, or see the getting started guide.

To recycle supplies, place the used supply in the box in which the new supply arrived. Use the enclosed
return label to send the used supply to HP for recycling. For complete information, see the recycling
guide that is included with each new HP supply item. See HP LaserJet print supplies on page 229 for
more information about HP's recycling program.
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Redistribute toner
If faded or light areas appear on the printed page, you might be able to temporarily improve print quality
by redistributing the toner.

1. Remove the print cartridge from the printer.

2. To redistribute the toner, gently rock the print cartridge from front to back.

CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing in cold
water. Hot water sets toner into the fabric.

3. Reinsert the print cartridge into the printer, and close the print cartridge door. If the print is still light
or unacceptable, install a new print cartridge.

Replace supplies

Print cartridge
1. Open the print-cartridge door.

2. Grasp the handle on the print cartridge and then pull the cartridge straight out to remove it. See
the recycling information inside the print cartridge box.

3. Remove the new print cartridge from its packaging, remove the orange cover from the print
cartridge, and then pull the orange tab straight out to remove the sealing tape.
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4. Insert the cartridge into the product until it is firmly in place.

5. Close the print-cartridge door.

CAUTION: If toner gets on any clothing, wipe it off with a dry cloth and wash the clothing in cold water.
Hot water sets toner into the fabric.

Memory DIMMs

Information

The product comes with 64 MB of RAM and can be upgraded to 320 MB via the DIMM slot, which is
accessible from the left side of the product.

Install a memory DIMM 

CAUTION: Handling a DIMM without wearing a grounded, antistatic device might damage the DIMM.
Touch any metal part of the product or other grounded metal before touching the DIMM.

1. Use the power switch to turn off the product, and then unplug all of the cables and cords connected
to the product.
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2. Open the DIMM door.

3. Remove the DIMM from the antistatic bag it came in, grasping the DIMM on the top edge.

4. With the gold contacts facing upward, insert the DIMM in the DIMM seat and press the DIMM body
in until the metal retaining pins click.
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5. Close the DIMM door.

6. Reconnect all cables and cords, and then use the power switch to turn on the product.

7. Print a configuration page, and then verify that the Memory section shows the new memory amount.
See Information pages on page 142.

Clean the product

Clean the paper path
During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product has
a cleaning mode that can correct and prevent these types of problems.

Specks Smearing

Clean the paper path from HP ToolboxFX

Use HP ToolboxFX to clean the paper path. This is the recommended cleaning method. If you do not
have access to HP ToolboxFX, use the method in Clean the paper path from the product control panel
on page 163.

1. Make sure that the product is turned on and in the Ready state, and that media is loaded in tray 1
or tray 2.

2. Open HP ToolboxFX, click the product, and then click the System Settings tab.

3. Click the Service tab, and then click Start.

A page feeds through the product slowly. Discard the page when the process is completed.
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Clean the paper path from the product control panel

If you do not have access to HP ToolboxFX, you can print and use a cleaning page from the product
control panel.

1. Press Setup.

2. Use the arrow buttons to find the Service menu, and then press OK.

3. Use the arrow buttons to find Cleaning mode, and then press OK.

4. Load plain letter or A4 paper when you are prompted.

5. Press OK again to confirm and begin the cleaning process.

A page feeds through the product slowly. Discard the page when the process is completed.

Clean the automatic document feeder (ADF) pickup roller assembly
If the ADF has trouble feeding documents, clean the ADF pickup roller assembly.

1. Turn off the product and unplug the power cord.

2. Open the ADF cover.

3. Rotate the assembly upward. Wipe it clean and rotate the rollers until the assembly is clean.
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4. Lower the green lever assembly and close the ADF cover.

NOTE: If you are experiencing jams in the ADF, contact HP. See www.hp.com/support/
LJM2727 or the support flyer that came in the product box.

5. Plug in the product, and then turn on the product.

Clean the lid backing
Minor debris can accumulate on the white document lid backing that is located underneath the product
lid.

1. Turn off the product, unplug the power cord, and raise the lid.

2. Clean the white document lid backing by using a soft cloth or sponge that has been moistened with
a mild soap and warm water. Wash the backing gently to loosen debris; do not scrub the backing.

3. Also, clean the scanner strip next to the ADF scanner glass.

4. Dry the backing by using a chamois or soft cloth.

CAUTION: Do not use paper-based wipes because they might scratch the backing.

5. If this does not clean the backing well enough, repeat the previous steps and use isopropyl alcohol
to dampen the cloth or sponge, and then wipe the backing thoroughly with a damp cloth to remove
any residual alcohol.
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Clean the exterior
Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the product.

Firmware updates
Firmware updates and installation instructions for this product are available at www.hp.com/support/
LJM2727. Click Downloads and drivers, click the operating system, and then select the firmware
download for the product.
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12 Problem solve

● Problem-solving checklist

● Restore the factory-set defaults

● Control-panel messages

● Control-panel display problems

● Clear jams

● Solve image-quality problems

● Solve convenience stapler problems

● Solve connectivity problems

● Solve software problems
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Problem-solving checklist
Follow these steps when trying to solve a problem with the product.

Step
number

Verification step Possible problems Solutions

1 Is the power on? No power due to failed power source, cable,
switch, or fuse.

1. Verify that the product is plugged in.

2. Verify that the power cable is functional
and that the power switch is on.

3. Check the power source by plugging
the product directly into the wall or into
a different outlet.

2 Does Ready appear in the
product control panel?

The control panel should
function without error
messages.

Control panel shows an error. See Control-panel messages on page 170
for a list of common messages that will help
you correct the error.

3 Do information pages print?

Print a configuration page. See
Information pages
on page 142.

An error message appears on the control-
panel display.

See Control-panel messages on page 170
for a list of common messages that will help
you correct the error.

Paper jams when printing. Make sure that media that meets
HP specifications. See Paper and print
media on page 45

Clean the paper path. See Clean the paper
path on page 162.

4 Does the product copy?

Place the configuration page
into the ADF and make a copy.
The report should feed
smoothly through the ADF, and
copies should print without
print-quality problems. Make a
copy from the flatbed as well.

Poor copy quality from the ADF. If the print quality from the internal tests and
the copy from the flatbed were acceptable,
clean the ADF scanning strip. See Clean the
scanner glass on page 88.

Paper jams when printing. Make sure that media that meets
HP specifications. See Paper and print
media on page 45

Clean the paper path. See Clean the paper
path on page 162.

Poor copy quality from the flatbed. 1. If the print quality from the internal tests
and the copy from the ADF were
acceptable, clean the flatbed glass.
See Clean the scanner glass
on page 88.

2. If, after performing the maintenance,
the problem persists, see Copy
problems on page 197.

5 Does the product send a fax?

Press Start Fax to verify that a
dial tone exists (using a hand
set, if necessary). Attempt to
send a fax.

The telephone line is not operational or the
product is not plugged into the telephone line.

Verify that the product is plugged into a
telephone line that you know works.

The telephone cord is faulty or is plugged into
the wrong connector.

1. Try plugging the telephone cord into
the other connector.

2. Try a new telephone cord.
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Step
number

Verification step Possible problems Solutions

6 Does the product receive a
fax?

Use another fax machine to
send a fax to the product, if
available.

Too many telephone devices are plugged in,
or telephone devices are not connected in the
correct order.

Make sure that the HP LaserJet M2727 mfp
is the only device on the telephone line and
try again to receive the fax.

The product fax settings are set incorrectly. Review and reset the product fax settings.
See Change fax settings on page 105

7 Does the product print from
the computer?

Use a word-processing
program to send a print job to
the product.

Software is not installed correctly or an error
occurred during software installation.

Uninstall and then reinstall the product
software. Verify that you are using the
correct installation procedure and the
correct port setting.

The cable is not connected correctly. Reconnect the cable.

An incorrect driver is selected. Select the proper driver.

There is a port driver problem in Microsoft
Windows.

Uninstall and then reinstall the product
software. Verify that you are using the
correct installation procedure and the
correct port setting.

8 Does the product scan to the
computer?

Initiate a scan from the basic
desktop software at your
computer.

The cable is not connected correctly. Reconnect the cable.

Software is not installed correctly or an error
occurred during software installation.

Uninstall and then reinstall the product
software. Verify that you are using the
correct installation procedure and the
correct port setting.

If the error persists, turn off the product and then turn on the product.

Restore the factory-set defaults
Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also clears the
fax header name, phone number, speed dials, and any stored faxes in the product memory.

CAUTION: This procedure also clears all fax numbers and names that are associated with one-touch
keys and speed-dial codes, and deletes any pages that are stored in the memory. The procedure then
automatically restarts the product.

1. On the product control panel, press Setup.

2. Use the arrows buttons to select Service, and then press OK.

3. Use the arrows buttons to select Restore defaults, and then press OK.

The product automatically restarts.
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Control-panel messages
The majority of the control-panel messages are intended to guide the user through typical operation.
The control-panel messages indicate the status of the current operation, and include a page count on
the second line of the display, if appropriate. When the product is receiving fax data, print data, or
scanning commands, control-panel messages indicate this status. In addition, alert messages, warning
messages, and critical error messages indicate situations that might require some action.

Alert and warning messages 
Alert and warning messages appear temporarily and might require the user to acknowledge the
message by pressing OK to resume or by pressing Cancel to cancel the job. With certain warnings, the
job might not complete or the print quality might be affected. If the alert or warning message is related
to printing and the auto-continue feature is on, the product will attempt to resume the printing job after
the warning has appeared for 10 seconds without acknowledgement.

Alert and warning message tables
To solve fax issues, see Solve fax problems on page 129.

Table 12-1  Alert and warning messages 

Control panel message Description Recommended action

10.0000 Supply Memory Error A specific print cartridge has an e-label error. Reinstall the print cartridge.

Turn off and then turn on the product.

If the problem is not solved, replace the
cartridge.

10.1000 Supply Memory Error A specific print cartridge has a missing e-
label.

Reinstall the print cartridge.

Turn off and then turn on the product.

If the problem is not solved, replace the
cartridge.

ADF door is open The ADF lid is open or a sensor is
malfunctioning.

Make sure that the ADF lid is closed.

Remove the ADF and reinstall it.

If the message persists, turn off the power by
using the power switch, wait at least 30
seconds, and then turn on the power and wait
for the product to initialize.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Canceled copy. Clear document The Cancel button was pressed to cancel the
current job while pages were feeding from the
ADF. The cancel process does not
automatically clear the ADF.

Remove the jammed item. See Clear jams
from the ADF on page 177. Then, clear the
items in the ADF tray and start over.

Canceled scan. Clear document The Cancel button was pressed to cancel the
current job while pages were feeding from the
ADF. The cancel process does not
automatically clear the ADF.

Remove the jammed item. See Clear jams
from the ADF on page 177. Then, clear the
items in the ADF tray and start over.
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Control panel message Description Recommended action

Canceled send. Clear document The Cancel button was pressed to cancel the
current job while pages were feeding from the
ADF tray. The cancel process does not
automatically clear the ADF.

Remove the jammed item. See Clear jams
from the ADF on page 177. Then, clear the
items in the ADF tray and start over.

Comm. error [Receiver CSID] A fax communication error occurred between
the product and the receiver.

Allow the product to retry sending the fax.
Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
call. Plug the product phone cord into a jack
for another phone line.

Try a different phone cord.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Comm. error [Sender CSID] A fax communication error occurred between
the product and the sender.

Allow the product to retry sending the fax.
Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
call. Plug the product phone cord into a jack
for another phone line.

Try a different phone cord.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Device error, press OK Generic engine error. This is a warning message only. Job output
might be affected.

Device is busy. Try again later The product is currently in use. Wait for the product to finish the current job.

Doc feeder jam Clear, Reload A piece of media is jammed in the ADF tray. Open the document release door, clear the
jam, close the document release door, and
reload the paper into the ADF tray.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Doc feeder jam, DATE/TIME ADF has not been cleared since previous
jam.

Clear the jam.

Document feeder mispick. Reload Media in the ADF tray was not picked up. Remove the media from the ADF tray, and
then reload it.

Clean the ADF pickup roller. See Clean the
automatic document feeder (ADF) pickup
roller assembly on page 163.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Door open The print-cartridge door is open. Close the print-cartridge door.

Engine comm. error The product experienced a print engine
communication error.

This is a warning message only. Job output
might be affected.

Engine error, press OK The product experienced a print engine error. This is a warning message only. Job output
might be affected.

Table 12-1  Alert and warning messages  (continued)
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Control panel message Description Recommended action

Fit to Page on flatbed only The copy reduce/enlarge feature (called "Fit
to Page") applies only to copies made from
the flatbed scanner.

Use the flatbed or select another reduction/
enlargement setting.

Install black cartridge No cartridge installed with door closed. Install print cartridge.

Invalid driver Press OK You are using the incorrect printer driver. Select the printer driver that is appropriate for
your product.

Invalid entry Invalid data or response. Correct the entry.

Jam in (area), Open door and clear jam Paper jam in one of the following areas: drum
area, fuser area, duplex feeding area, duplex
receiving area, and duplex pickup area.

Clear the jam from the area indicated on the
product control panel, and then follow the
control panel instructions. See Clear jams
on page 176.

Jam in Tray #, Clear jam and then press
OK

The product has detected a jam in one of the
following areas: tray 1, tray 2, or tray 3.

Clear the jam from the area indicated on the
product control panel, and then follow the
control panel instructions. See Clear jams
on page 176.

Load paper Out of paper in all available trays. Load paper in trays.

Load Tray # <TYPE> <SIZE>, Press OK to
use available media

Device is processing job, but a matching tray
is empty.

Press OK to use existing available media.

Load tray #, Press OK Manual duplex mode. “#” is the tray number
where the first half of the job printed.

Load paper in the correct tray.

Load Tray 1 <TYPE> <SIZE>, Press OK to
use available media

Device is processing job, but no trays match. Press OK to use existing tray settings.

Load Tray 1, <PLAIN> <SIZE> / Cleaning
mode, OK to start

Cleaning mode paper prompt. Press OK to begin the cleaning procedures.

Manual feed <SIZE> <TYPE>, Press OK to
use available media

Print Manual Feed mode. Load paper into tray 1.

Mem. low 1 copy. Press OK The product completed making one copy.
The remaining copies have been canceled
because of low memory.

Press Cancel to clear the error. Break the job
into smaller jobs that contain fewer pages.

Memory is low Try again later The product does not have enough memory
to start a new job.

Wait until the current job is finished before
starting a new job.

Memory is low. Press OK The product memory has been almost
completely filled.

Allow the product to finish the job, or press
Setup to cancel the job.

Memory low Only 1 copy made The product does not have enough memory
to complete the collated copy job.

Break the job into smaller jobs that contain
fewer pages.

Misprint, Press OK Feed delay misprint. Reload paper.

No paper pickup, Press OK The product has failed to pick up a piece of
media.

Verify that the media was inserted far enough
into the input tray. In tray 2, verify that the
paper-length guide is in the correct position
for the media size that you are using.

Reload the media in the input tray and press
Setup to continue the job.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Table 12-1  Alert and warning messages  (continued)
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Control panel message Description Recommended action

Non-HP supply Installed A new supply has been installed that is not
made by HP. This message is appears for
several seconds, and then the product
returns to the Ready state.

If you believe you purchased an HP supply,
please call the HP fraud hotline at
1-877-219-3183. Service or repairs that are
required as a result of using non-HP supplies
is not covered under HP warranty.

Order black Cartridge Print cartridge is low. Order a new print cartridge.

Page too complex, press OK The product could not print the current page
because of its complexity.

PressSetup to clear the message.

Allow the product to finish the job, or press
Cancel to cancel the job.

Paper path jam. Open door/Remove tray 2,
Push green lever

Paper jam in the duplexer Clear the jam from the area, and then follow
the control-panel instructions.

Scanner reserved for PC scan A computer is using the product to create a
scan.

Wait until the computer scan has finished, or
cancel the scan from the computer software,
or press Cancel.

Scanning error Cannot connect The product cannot transmit scan information
to a computer.

Verify that the connection cable is not loose
or damaged. Replace the cable if necessary,
and try the scan again.

Settings cleared, DATE/TIME The product has cleared job settings. Re-enter any appropriate job settings.

Used black cartridge in use

alternates with

to accept, press OK

A used printer cartridge has been installed or
moved.

Press OK to return to the Ready state.

Table 12-1  Alert and warning messages  (continued)
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Critical error messages
Critical error messages can indicate some kind of failure. Turning off and then turning on the power
might fix the problem. If a critical error persists, the product might require service.

Critical error message-tables
Table 12-2  Critical error messages

Control panel message Description Recommended action

49 Error, Turn off then on The product has experienced an internal
embedded software error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

50.x Fuser Error The product has experienced an internal
hardware error.

1. Turn off the power by using the power
switch, and then wait at least 30
seconds.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Turn on the power and wait for the
product to initialize.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

52 Scanner Error The product has experienced an internal
hardware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

55.4 Error, Turn off then on The product has experienced an engine
communication timeout error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

57 Fan Error, Turn off then on The product has experienced a problem with
its internal fan.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.
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Control panel message Description Recommended action

79 Error Turn off then on The product has experienced an internal
firmware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If you have recently installed a memory DIMM
in the product, turn off the product, remove
the memory DIMM, reinstall the DIMM to
verify that it is seated properly, and then turn
on the product.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

79 Service error, Turn off then on The product has experienced a problem with
the DIMM slot.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If you have recently installed a memory DIMM
in the product, turn off the product, remove
the memory DIMM, reinstall the DIMM to
verify that it is seated properly, and then turn
on the product.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Scanner error #, Turn off then on The product has experienced an error in the
scanner sub-assembly area.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.

Table 12-2  Critical error messages (continued)

ENWW Control-panel messages 175

http://www.hp.com/support/LJM2727
http://www.hp.com/support/LJM2727
http://www.hp.com/support/LJM2727


Control-panel display problems
CAUTION: Static electricity can cause unexpected black lines or dots to appear on the product control-
panel display. Do not touch the product control-panel display if there is a chance that you have collected
a static electric charge (for example, by walking on carpet in a low-humidity environment).

Unexpected lines or dots might appear on the product control-panel display, or the display might become
blank if the product is exposed to an electric or magnetic field. To resolve this problem, perform the
following procedure:

1. Turn the product off.

2. Remove the product from the electric or magnetic field.

3. Turn the product on again.

Clear jams
Causes of jams

Occasionally, paper or other print media can become jammed during a print job. Some causes include
the following events:

● The input trays are loaded improperly or overfilled, or the media guides are not set properly.

● Media is added to or removed from an input tray during a print job or an input tray is removed from
the product during a print job.

● The cartridge door is opened during a print job.

● Too many sheets have accumulated in an output area, or sheets are blocking an output area.

● The print media that is being used does not meet HP specifications. See Paper and print media
on page 45.

● The media is damaged or has foreign objects attached to it, such as staples or paper clips.

● The environment in which the print media was stored is too humid or too dry. See Paper and print
media on page 45.
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Where to look for jams
Jams can occur in these locations:

● In the automatic document feeder (ADF)

● In input areas

● In the automatic duplexer

● In output areas

● Inside the product

Find and remove the jam by using the instructions on the following pages. If the location of the jam is
not obvious, first look inside the product.

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.

Clear jams from the ADF
Occasionally, media becomes jammed during a fax, copy, or scan job.

You are notified of a media jam by the Doc feeder jam Clear, Reload message that appears on the
product control-panel display.

● The ADF input tray is loaded incorrectly or is too full. See Load paper and print media
on page 49 for more information.

● The media does not meet HP specifications, such as those for size or type. See Paper and print
media on page 45 for more information.

1. Open the ADF cover.

NOTE: Verify that any shipping tape inside the ADF has been removed.
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2. Remove the jam cleanout part. Using both hands, lift up on the two handles until the part unsnaps.
Rotate and lift out the cleanout part and set it aside.

3. Lifting the green lever, rotate the pick mechanism until it stays open.

4. Gently try to remove the page without tearing it. If you feel resistance, go to the next step.

5. Open the ADF lid and gently loosen the media by using both hands.
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6. When the media is free, gently pull it out in the direction shown.

7. Close the lid to the flatbed scanner.

8. Lower the green lever.

9. Reinstall the cleanout part by inserting it as shown. Push down on the two tabs until the part snaps
into place. Install the cleanout part correctly, because future jamming might occur if the cleanout
part is not replaced correctly.
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10. Close the ADF lid.

Clear jams from the input-tray areas
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.

NOTE: Depending on where the jam is located, some of the following steps might not be necessary.

1. Open the rear output door.

2. Rotate the green pressure release levers downward.

3. Open the print-cartridge door.
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4. With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.

5. Close the print-cartridge door.

6. Open tray 2 and tray 3.

7. With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.
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8. If no media is visible, open the print-cartridge door, remove the print cartridge, and rotate the upper
media guide. Carefully pull the media up and out of the product.

9. Close tray 2 and optional tray 3.

10. Close the rear output door.
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Clear jams from the duplexer
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.

NOTE: Depending on where the jam is located, some of the following steps might not be necessary.

1. Open the rear output door.

2. Rotate the green pressure release levers downward.

3. Remove tray 2.

4. Push down on the green lever on the automatic two-sided path door on the front of the product.
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5. With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.

NOTE: If you cannot grasp the media with your hands, perform the procedure in Clear jams from
the print-cartridge area on page 187.

6. Close the automatic two-sided path door.

7. Reinsert tray 2.

8. Close the rear output bin, and then open the automatic two-sided path door on the back of the
product.
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9. With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.

10. Close the automatic two-sided path door.

Clear jams from the output-bin areas

Top (face-down) output bin
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

With both hands, grasp the side of the media that is most visible (this includes the middle), and carefully
pull it free from the product.
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Rear (face-up) output bin
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

1. Open the straight-through output door.

2. Pull down the green pressure-release levers.

3. With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the printer.

NOTE: If you cannot grasp the media with your hands, perform the procedure in Clear jams from
the print-cartridge area on page 187.

4. Close the straight-through output door.
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Clear jams from the print-cartridge area
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.

1. Open the print-cartridge door, and remove the print cartridge.

CAUTION: To prevent damage to the print cartridge, minimize its exposure to direct light.

2. On the product, open the rear output door, and then rotate the green pressure-release levers
downward.

3. With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.

4. Replace the print cartridge and close the print-cartridge door.

5. Close the rear output door.
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Clear jams from the convenience stapler (HP LaserJet M2727nfs mfp only)
To reduce the risk of staple jams, make sure that you staple 20 or fewer pages of media (80 g/m2 or 20
lb) at a time.

1. Turn off the HP LaserJet M2727nfs mfp, and then open the stapler door.

NOTE: Opening the stapler door disables the stapler.

2. Remove the staple cassette from the product.

3. Clear any loose staples from the stapler and from the staple cassette.

4. Replace the staple cassette.

188 Chapter 12   Problem solve ENWW



5. Close the stapler door, and then turn on the product.

6. Insert media to test the convenience stapler. Repeat steps 1 through 6 if necessary.

Avoid repeated jams 
● Verify that the input tray is not overfilled. The input tray capacity varies depending on the type of

print media that you are using.

● Verify that the media guides are properly adjusted.

● Check that the input tray is securely in place.

● Do not add print media into the input tray while the product is printing.

● Use only HP-recommended media types and sizes. See Paper and print media on page 45 for
more information about print media types.

● Do not fan media prior to loading it in a tray. To loosen the ream, hold it firmly in both hands and
twist the media by rotating your hands in the opposite direction.

● Do not let print media stack up in the output bin. The print media type and the amount of toner used
affect the output bin capacity.

● Check the power connection. Make sure that the power cord is firmly connected to both the product
and the power supply box. Plug the power cord into a grounded power outlet.
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Solve image-quality problems
Print problems

Print quality problems
Occasionally, you might encounter problems with print quality. The information in the following sections
helps you identify and resolve these issues.

NOTE: If you are having copy problems, see Copy problems on page 197.

General print-quality issues

The following examples depict letter-size paper that has passed through the product short-edge-first.
These examples illustrate problems that would affect all of the pages that you print. The topics that follow
list the typical cause and solution for each of these examples.

Problem Cause Solution

Print is light or faded. The media might not meet HP specifications. Use media that meets HP specifications.
See Paper and print media on page 45.

The print cartridge might be defective. If you
use a non-HP print cartridge, no messages
appear on the product control panel or in
HP ToolboxFX.

Replace the print cartridge. See Print
cartridge on page 159.

If the print cartridge is not low or empty,
inspect the toner roller to see if the roller is
damaged. If it is, replace the print cartridge.

If the whole page is light, the print density
adjustment is too light or EconoMode might
be turned on.

Adjust the print density, and disable
EconoMode in the product Properties.

Toner specks appear. The media might not meet HP specifications. Use media that meets HP specifications.
See Paper and print media on page 45.

The paper path might need cleaning. Clean the paper path. See Clean the paper
path on page 162, or see the HP ToolboxFX
online Help.

Dropouts appear. A single sheet of print media might be
defective.

Try reprinting the job.

The moisture content of the paper is uneven
or the paper has moist spots on its surface.

Try different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 45.

The paper lot is flawed. The manufacturing
processes can cause some areas to reject
toner.

The print cartridge might be defective. Replace the print cartridge. See Print
cartridge on page 159.

If the error persists, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.
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Problem Cause Solution

Vertical streaks or bands appear
on the page.
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The print cartridge might be defective. If you
are using a non-HP print cartridge, no
messages appear on the product control
panel or in the HP ToolboxFX.

Replace the print cartridge. See Print
cartridge on page 159.

The amount of background toner
shading becomes unacceptable.

The media might not meet HP specifications. Use a different paper with a lighter basis
weight. See Paper and print media
on page 45.

The single-sheet priority input tray might be
installed incorrectly.

Make sure that the single-sheet priority
input tray is in place.

The print-density setting is too high. Decrease the print-density setting
throughHP ToolboxFX or the embedded
Web server. This decreases the amount of
background shading.

Very dry (low humidity) conditions can
increase the amount of background shading.

Check the product environment.

The print cartridge might be defective. If you
are using a non-HP print cartridge, no
messages appear on the product control
panel or in the HP ToolboxFX.

Replace the print cartridge. See Print
cartridge on page 159.

Toner smears appear on the
media.

The media might not meet HP specifications. Use media that meets HP specifications.
See Paper and print media on page 45.

If toner smears appear on the leading edge
of the paper, the media guides are dirty, or
debris has accumulated in the print path.

Clean the media guides and the paper path.
See Clean the paper path on page 162.

The print cartridge might be defective. If you
are using a non-HP print cartridge, no
messages appear on the product control
panel or in the HP ToolboxFX.

Replace the print cartridge. See Print
cartridge on page 159.

The fuser temperature might be too low. In the printer driver, make sure the
appropriate media type is selected.

Use the archive print feature to improve
toner fusing. See Archive print on page 65.
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Problem Cause Solution

The toner smears easily when
touched.

The product is not set to print on the type of
media on which you want to print.

In the printer driver, select the Paper/
Quality tab and set Paper Type to match
the type of media on which you are printing.
Print speed might be slower if you are using
heavy paper.

The media might not meet HP specifications. Use media that meets HP specifications.
See Paper and print media on page 45.

The paper path might need cleaning. Clean the product. See Clean the paper
path on page 162.

The power source might be defective. Plug the product directly into an AC outlet
instead of into a power strip.

The fuser temperature might be too low. Use the archive print feature to improve
toner fusing. See Archive print on page 65.

Marks repeatedly appear at even
intervals on the page.

The product is not set to print on the type of
media on which you want to print.

In the printer driver, make sure that the
appropriate media type is selected. Print
speed might be slower if you are using
heavy paper.

Internal parts might have toner on them. The problem typically corrects itself after a
few more pages.

The paper path might need cleaning. Clean the product. See Clean the paper
path on page 162.

The print cartridge might be damaged. If a repetitive mark occurs at the same spot
on the page, install a new HP print cartridge.
See Print cartridge on page 159.

The printed page contains
misformed characters.

The media might not meet HP specifications. Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 45.

If characters are incorrectly formed so that
they produce a wavy effect, the laser scanner
might need service.

Verify that the problem also occurs on the
configuration page. If so, contact HP. See
www.hp.com/support/LJM2727 or the
support flyer that came in the product box.
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Problem Cause Solution

The printed page is curled or
wavy.

The product is not set to print on the type of
media on which you want to print.

In the printer driver, make sure the
appropriate media type is selected.

If the problem persists, select a media type
that uses a lower fuser temperature, such
as transparencies or light media.

The media might have been in the input tray
too long.

Turn over the stack of media in the tray.
Also, try rotating the media 180° in the input
tray.

The paper path is curling the media. Open the rear output door to print to the
straight-through output path.

The media might not meet HP specifications. Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 45.

Both high temperature and humidity can
cause paper curl.

Check the product environment.

Text or graphics are skewed on
the printed page.

The media might be loaded incorrectly or the
input tray might be too full.

Verify that the media is loaded correctly and
that the media guides are not too tight or too
loose against the stack. See Load paper
and print media on page 49.

The media might not meet HP specifications. Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 45.

The printed page contains
wrinkles or creases.

The media might be loaded incorrectly or the
input tray might be too full.

Turn over the stack of paper in the input tray,
or try rotating the paper 180° in the input
tray.

Verify that the media is loaded correctly and
that the media guides are not too tight or too
loose against the stack. See Load paper
and print media on page 49.

The media might not meet HP specifications. Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 45.

The paper path is curling the media. Open the rear output door to print to the
straight-through output path.

Air pockets inside envelopes can cause them
to wrinkle.

Remove the envelope, flatten it, and try
printing again.

ENWW Solve image-quality problems 193



Problem Cause Solution

Toner appears around the printed
characters.

The media might be loaded incorrectly. Turn over the stack of paper in the tray.

If large amounts of toner have scattered
around the characters, the paper might have
high resistivity.

Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 45.

An image that appears at the top
of the page (in solid black) repeats
farther down the page (in a gray
field).

Software settings might affect image
printing.

In your software program, change the tone
(darkness) of the field in which the repeated
image appears.

In your software program, rotate the whole
page 180° to print the lighter image first.

The order of images printed might affect
printing.

Change the order in which the images are
printed. For example, have the lighter image
at the top of the page, and the darker image
farther down the page.

A power surge might have affected the
product.

If the defect occurs later in a print job, turn
the product off for 10 minutes, and then turn
on the product to restart the print job.

Media-handling problems
Use the information in this section when the product experiences media-handling problems.

Print-media guidelines

● For best results, make sure that the paper is of good quality, and free of cuts, nicks, tears, spots,
loose particles, dust, wrinkles, voids, staples, and curled or bent edges.

● For best-quality printing, use a smooth type of paper. Generally, smoother media produces better
results. .

● If you are unsure what type of paper you are loading (such as bond or recycled), check the label
on the package of paper.

● Do not use media that is designed for inkjet printers only. Use media that is designed for laser
printers.

● Do not use letterhead paper that is printed with low-temperature inks, such as those used in some
types of thermography.

● Do not use raised or embossed letterhead.

● The product uses heat and pressure to fuse toner to the paper. Make sure that any colored paper
or preprinted forms use inks that are compatible with this fusing temperature (200°C or 392°F for
0.1 second).

CAUTION: Failure to follow these guidelines could cause jams or damage to the product.
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Solve print-media problems

The following problems with media cause print-quality deviations, jamming, or even damage to the
product.

Problem Cause Solution

Poor print quality or toner
adhesion

The paper is too moist, too rough, too heavy or
too smooth, or it is embossed or from a faulty
paper lot.

Try another kind of paper, between 100 and
250 Sheffield, with 4 to 6% moisture content.

Dropouts, jamming, or curl The paper has been stored incorrectly. Store paper flat in its moisture-proof wrapping.

The paper has variability from one side to the
other.

Turn the paper over.

Excessive curl The paper is too moist, has the wrong grain
direction, or is of short-grain construction

Open the rear output bin, or use long-grain
paper.

The paper varies from side-to-side. Turn the paper over.

High fuser temperature is curling the paper. Turn on the Less paper curl setting.

At the control panel, press Setup, use the
arrow buttons to select Service, and then press
OK. Use the arrow buttons to select Less paper
curl, press OK, use the arrow buttons to select
On, and then press OK.

Jamming, damage to
product

The paper has cutouts or perforations. Use paper that is free of cutouts or
perforations.

Problems with feeding The paper has ragged edges. Use high-quality paper that is made for laser
printers.

The paper varies from side-to-side. Turn the paper over.

The paper is too moist, too rough, too heavy or
too smooth, has the wrong grain direction, or is
of short-grain construction or it is embossed or
from a faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Open the rear output bin, or use long-grain
paper.

Print is skewed (crooked). The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the media
in the input tray again. Adjust the media guides
to the width and length of the media that you
are using and try printing again.

More than one sheet feeds at
one time.

The media tray might be overloaded. Remove all media from the tray, and then
return some of the media to the tray. See Load
paper and print media on page 49.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled, folded, or
damaged. Try printing on media from a new or
different package.

The media might have been fanned before it
was loaded.

Load media that was not fanned. Loosen ream
by twisting paper stack.

Media might be too dry. Load new paper that was stored properly.
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Problem Cause Solution

The product does not pull
media from the media input
tray.

The product might be in manual feed mode. ● If Manual feed appears on the product
control-panel display, press OK to print
the job.

● Verify that the product is not in manual
feed mode and print your job again.

The pickup roller might be dirty or damaged. Contact HP. See www.hp.com/support/
LJM2727 or the support flyer that came in the
product box.

The paper-length adjustment control in tray 2
or optional tray 3 is set at a length that is
greater than the media size.

Adjust the paper-length adjustment control to
the correct length.

Performance problems
Try the tips in this section if pages exit the product, but have nothing printed on them, or when the product
does not print any pages.

Problem Cause Solution

Pages print but are totally
blank.

The sealing tape might still be in the print
cartridge.

Verify that the sealing tape has been
completely removed from the print cartridge.

The document might contain blank pages. Check the document that you are printing to
see if content appears on all of the pages.

The product might be malfunctioning. To check the product, print a configuration
page. See Information pages on page 142.

Certain media types can slow the print job. Print on a different type of media.
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Problem Cause Solution

Pages did not print. The product might not be pulling media
correctly.

See Media-handling problems on page 194.

The media might be jamming in the product. Clear the jam. See Clear jams on page 176.

The USB cable or the network cable might be
defective or incorrectly connected. 

● Disconnect the cable at both ends and
reconnect it.

● Try printing a job that has printed in the
past.

● Try using a different USB or network
cable.

The product IP address might have been
changed.

From the control panel, print a configuration
page. Confirm the IP address with that listed in
the Properties dialog box.

The product might not be set up as the default
printer.

Open the Printers or Printers and Faxes
dialog box, right click the product, and then
click Set as Default Printer.

The product might have encountered an error. Check the control panel for an error message.
See Control-panel messages on page 170.

The product might be paused or offline. Open the Printers or Printers and Faxes
dialog box, and verify that the product status is
Ready. If it is Paused, right-click the product
and click Resume Printing.

The product might not be receiving power. Check the power cord and verify that the
product is turned on.

Other devices are running on your computer. The product might not share a USB port. If you
have an external hard drive or network
switchbox that is connected to the same port
as the product, the other device might be
interfering. To connect and use the product,
disconnect the other device or use two USB
ports on the computer.

Copy problems

Prevent copy problems
The following are a few simple steps you can take to improve copy quality:

● Copy from the flatbed scanner. This will produce a higher quality copy than copying from the
automatic document feeder (ADF).

● Use quality originals.

● Load the media correctly. If the media is loaded incorrectly, it might skew, causing unclear images
and problems with the OCR program. See Load paper and print media on page 49 for instructions.

● Use or make a carrier sheet to protect your originals.

NOTE: Verify that the media meets HP specifications. If the media meets HP specifications, recurring
feed problems indicate the pickup roller or separation pad is worn. Contact HP. See www.hp.com/
support/LJM2727 or the support flyer that came in the product box.
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Image problems

Problem Cause Solution

Images are missing or faded. The print-cartridge might be defective. Replace the print cartridge. See Print
cartridge on page 159.

The original might be of poor quality. If your original is too light or damaged, the
copy might not be able to compensate, even
if you adjust the contrast. If possible, find an
original document in better condition.

The contrast settings might be set
incorrectly.

Use the control-panel Lighter/Darker button
to change the contrast setting.

The original might have a colored
background.

Colored backgrounds might cause images in
the foreground to blend into the background,
or the background might appear in a
different shade. If possible, use an original
document without a colored background.

Vertical white or faded stripes
appear on the copy.

The media might not meet
HP specifications.

Use media that meets HP specifications.
See Paper and print media on page 45.

The print-cartridge might be defective. Replace the print cartridge. See Print
cartridge on page 159.

Unwanted lines appear on the
copy.
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The flatbed scanner or the ADF glass might
be dirty.

Clean the flatbed scanner or the ADF glass.
See Clean the product on page 162.

 

The photosensitive drum inside the print
cartridge might have been scratched.

Install a new HP print cartridge. See Print
cartridge on page 159.

Black dots or streaks appear on
the copy.

Ink, glue, correction fluid, or an unwanted
substance might be on the automatic
document feeder (ADF) or flatbed scanner.

Clean the product. See Clean the product
on page 162.

The power to the product might have
fluctuated.

Reprint the job.

Copies are too light or dark. The printer driver or product software
settings may be incorrect.

Verify that the quality settings are correct.

See the product software Help for more
information about changing the settings.

Text is unclear. The printer driver or product software
settings may be incorrect.

Verify that the quality settings are correct.

Verify that the EconoMode setting is off.

See the product software Help for more
information about changing the settings.
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Media-handling problems

Problem Cause Solution

Poor print quality or toner
adhesion

The paper is too moist, too rough, too heavy
or too smooth, or it is embossed or from a
faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Dropouts, jamming, or curl The paper has been stored incorrectly. Store paper flat in its moisture-proof
wrapping.

The paper has variability from one side to the
other.

Turn the paper over.

Excessive curl The paper is too moist, has the wrong grain
direction, or is of short-grain construction

Open the rear output bin, or use long-grain
paper.

The paper varies from side-to-side. Turn the paper over.

Jamming, damage to paper The paper has cutouts or perforations. Use paper that is free of cutouts or
perforations.

Problems with feeding The paper has ragged edges. Use high-quality paper that is made for laser
printers.

The paper varies from side-to-side. Turn the paper over.

The paper is too moist, too rough, too heavy
or too smooth, has the wrong grain direction,
or is of short-grain construction or it is
embossed or from a faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Open the rear output bin, or use long-grain
paper.

Print is skewed (crooked). The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the
media in the input tray again. Adjust the
media guides to the width and length of the
media that you are using and try printing
again.

More than one sheet feeds at one
time.

The media tray might be overloaded. Remove some of the media from the tray.
See Load paper and print media
on page 49.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled, folded,
or damaged. Try printing on media from a
new or different package.

The product does not pull media
from the media input tray.

The product might be in manual feed mode. ● If Manual appears on the product
control-panel display, pressOK to print
the job.

● Verify that the product is not in manual
feed mode and print your job again.

The pickup roller might be dirty or damaged. Contact HP. See www.hp.com/support/
LJM2727 or the support flyer that came in
the product box.

The paper-length adjustment control in
tray 2 or optional tray 3 is set at a length that
is greater than the media size.

Adjust the paper-length adjustment control
to the correct length.
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Performance problems

Problem Cause Solution

No copy came out. The input tray might be empty. Load media in the product. See Load paper
and print media on page 49 for more
information.

The original might have been loaded
incorrectly.

In the automatic document feeder (ADF),
load the original with the narrow side forward
and the side to be scanned facing up.

On the flatbed scanner, place the original
document face-down with the upper-left
corner of the document at the lower-right
corner of the glass.

Copies are blank. The sealing tape might not have been
removed from the print cartridge.

Remove the print cartridge from the product,
pull out the sealing tape, and reinstall the
print cartridge.

The original might have been loaded
incorrectly.

In the ADF, load the original with the narrow
side leading into the ADF and the side to be
scanned facing up.

On the flatbed scanner, make sure that the
original document is placed face-down with
the upper-left corner of the document at the
lower-right corner of the glass.

The media might not meet
HP specifications.

Use media that meets HP specifications.
See Paper and print media on page 45.

The print cartridge might be defective. Replace the print cartridge. See Print
cartridge on page 159.

The wrong original was copied. The ADF might be loaded. Make sure that the ADF is empty.

Copies are reduced in size. The product settings might be set to reduce
the scanned image.

On the control panel, press Reduce/
Enlarge and verify that it is set to
Original=100%.
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Scan problems

Solve scanned-image problems

Problem Cause Solution

The scanned image is of poor
quality.

The original might be a second-generation
photo or picture.

● To eliminate the patterns, try reducing
the size of the image after scanning.

● Print the scanned image to see if the
quality is better.

● Verify that the resolution settings are
correct for the type of scan job that you
are performing. See Scanner
resolution and color on page 87.

● For best results, use the flatbed
scanner for scanning rather than the
automatic document feeder (ADF).

The image that appears on the screen might
not be an accurate representation of the
quality of the scan.

● Try adjusting your computer monitor
settings to use more colors (or levels of
gray). Typically, you make this
adjustment by opening Display in
Windows Control Panel.

● Try adjusting the resolution settings in
the scanner software. See Scanner
resolution and color on page 87.

The original might have been loaded
incorrectly.

Use the media guides when you load the
originals into the ADF. See Load paper and
print media on page 49.

The scanner might be dirty. Clean the scanner. See Clean the scanner
glass on page 88.

The graphics settings might not be suitable
for the type of scan job that you are
performing.

Try changing the graphics settings. See
Scanner resolution and color on page 87.
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Problem Cause Solution

Part of the image did not scan. The original might have been loaded
incorrectly.

Use the media guides when you load the
originals into the ADF. See Load originals for
scanning on page 82.

A colored background might be causing
images in the foreground to blend into the
background.

Try adjusting the settings before you scan
the original or enhancing the image after you
scan the original.

The original is longer than 381 mm (15
inches).

The maximum scannable length is 381 mm
(15 inches) when you use the automatic
document feeder (ADF) input tray. If the
page exceeds the maximum length, the
scanner stops. (Copies can be longer.)

CAUTION: Do not try to pull the original
from the ADF; you might damage the
scanner or your original. See Clear jams
from the ADF on page 177.

The original is too small. The minimum size that the flatbed scanner
supports is 25 x 25 mm (1 x 1 inch). The
minimum size that the ADF supports is 127
x 127 mm (5 x 5 inches). The original might
be jammed. See Clear jams from the ADF
on page 177.

The media size is incorrect. In Scan settings, make sure that the input
media size is large enough for the document
that you are scanning. .

The scan takes too long The resolution or color level is set too high. Change the resolution and color settings to
the correct settings for your job. See
Scanner resolution and color on page 87.

The software is set to scan in color. The system default is color, which takes
longer to scan even when scanning a
monochrome original. If you acquire an
image through TWAIN or WIA, you can
change the settings so that the original
scans in grayscale or black-and-white. See
the product software Help for details.

A print job or copy job was sent before you
tried to scan.

If someone sent a print job or copy job before
you tried to scan, the scan will start if the
scanner is not busy. However, because the
product and scanner share memory, the
scan might be slower.
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Scan-quality problems

Prevent scan-quality problems

The following are a few simple steps you can take to improve copy and scan quality.

● Use the flatbed scanner, rather than the automatic document feeder (ADF) input tray, to scan.

● Use high-quality originals.

● Load the media correctly. If the media is loaded incorrectly, it might skew, which causes unclear
images. See Load paper and print media on page 49 for instructions.

● Adjust the software settings according to how you plan to use the scanned page. See Scanner
resolution and color on page 87 for more information.

● If your product frequently feeds more than one page at a time, the separation pad might need to
be replaced. Contact HP. See www.hp.com/support/LJM2727 or the support flyer that came in the
product box.

● Use or make a carrier sheet to protect your originals.

Solve scan-quality problems

Problem Cause Solution

Blank pages The original might have been loaded upside
down.

In the automatic document feeder (ADF), put
the top end of the stack of originals into the
ADF input tray, with the media stack face-up
and the first page to be scanned on top of
the stack.

On the flatbed scanner, place the original
document face-down with the upper-left
corner of the document at the lower-right
corner of the glass.

Too light or dark The resolution and color levels may be set
incorrectly.

Verify that you have the correct resolution
and color settings. See Scanner resolution
and color on page 87.

Unwanted lines Ink, glue, correction fluid, or an unwanted
substance might be on the glass.

Clean the flatbed scanner surface. See
Clean the scanner glass on page 88.

The ADF glass might be dirty. Clean the scanner strip. See Clean the
scanner glass on page 88 (step 3).

Black dots or streaks Ink, glue, correction fluid, or an unwanted
substance might be on the glass.

Clean the flatbed scanner surface. See
Clean the scanner glass on page 88.

The power to the product might have
fluctuated.

Reprint the job.

Unclear text The resolution levels might be set
incorrectly.

Verify that the correct resolution settings are
correct. See Scanner resolution and color
on page 87.

Fax problems
To solve fax issues, see Solve fax problems on page 129.
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Optimize and improve image quality

Print-quality checklist
General print-quality problems can be solved by using the following checklist:

1. Make sure that the paper or print media that you are using meets specifications. See Paper and
print media on page 45. Generally, smoother paper provides better results.

2. If you are using a special print media such as labels, transparencies, glossy, or letterhead, ensure
that you have printed by type. See Change the print driver to match the media type and size
on page 54.

3. Print a configuration page and supplies status page at the product control panel. See Information
pages on page 142.

◦ Check the supplies status page to see if any supplies are low or empty. No information is
provided for non-HP print cartridges.

◦ If the pages do not print correctly, the problem is with the hardware. Contact HP. See
www.hp.com/support/LJM2727 or the support flyer that came in the product box.

4. Print a demo page from HP ToolboxFX. If the page prints, the problem is with the printer driver.
Try printing from another printer driver. For example, if you are using the PCL 6 printer driver, print
from the PS printer driver.

◦ Use the Add Printer Wizard in the Printers (or Printers and Faxes in Windows XP) dialog
box to install the PS driver.

5. Try printing from a different program. If the page prints correctly, the problem is with the program
from which you were printing.

6. Restart the computer and the product and try printing again. If the problem is not resolved, see
General print-quality issues on page 190.

Manage and configure printer drivers
Print-quality settings affect how light or dark the print is on the page and the style in which the graphics
are printed. You can also use the print-quality settings to optimize the print quality for a specific media
type.

You can change the settings in the product properties to accommodate the types of jobs that you are
printing. The following settings are available, depending on the printer driver that you are using:

● 600 dpi

● Custom: This setting produces the same resolution as the default setting, but you can change the
scale patterns.

NOTE: Changing the resolution can change the formatting of your text.

Temporarily change print-quality settings

To change the print-quality settings only for the current software program, open the properties through
the Print Setup menu in the program that you are using to print.
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Change print-quality settings for all future jobs

NOTE: For Macintosh instructions, see Change printer-driver settings for Macintosh on page 28.

For Windows 2000:

1. In the Windows system tray, click Start, select Settings, and then click Printers.

2. Right-click the product icon.

3. Click Properties or Printing Preferences.

4. Change the settings, and click OK.

For Windows XP:

1. In the Windows system tray, click Start, click Control Panel, and then click Printers and Faxes.

2. Right-click the product icon.

3. Click Properties, or click Printing Preferences.

4. Change the settings, and click OK.

For Windows Vista:

1. In the Windows system tray, click Start, click Control Panel, and then, under Hardware and
Sound, click Printer.

2. Right-click the product icon.

3. Click Properties, or click Printing Preferences.

4. Change the settings, and click OK.
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Solve convenience stapler problems
The convenience stapler is designed to be free of staple jams. To reduce the risk of staple jams, make
sure that you staple 20 or fewer pages of media (80 g/m2 or 20 lb) at a time.

Problem Cause Solution

The convenience stapler does not staple
pages.

The stapler door is not completely
closed.

The convenience stapler has a staple
jam.

Make sure that the stapler door is
completely closed.

Clear the staple jam. See Clear jams
from the convenience stapler (HP
LaserJet M2727nfs mfp only)
on page 188.

Solve connectivity problems
Solve direct-connection problems

If the product is experiencing connection issues while directly connected to a computer, complete the
following steps:

1. Make sure that USB cable is no longer than 2 meters (6 feet).

2. Make sure that both ends of the USB cable are connected.

3. Make sure that the cable is a USB 2.0 Hi-Speed-certified cable.

4. If the error persists, use a different USB cable.

Network problems

Verify that the product is on and online
Check the following items to make sure the product is ready to print.

1. Is the product plugged in and turned on?

Make sure that the product is plugged in and turned on. If the problem persists, you might have a
defective power cable, power source, or product.

2. Is the product Ready light on?

If the light is blinking, you might need to wait until the current job is completed.

3. Is the product control-panel display blank?

● Make sure the product is turned on.

● Make sure the product is installed correctly.

4. Does a message other than Ready appear on the product control-panel display?

● See your product documentation for a complete list of control panel messages and corrective
actions.
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Resolve communication problems with the network
Check the following items to verify that the product is communicating with the network. This information
assumes you have already printed a network configuration page (see Information pages
on page 142).

1. Are there any physical connection problems between the workstation or file server and the product?

Verify that the network cabling, connections, and router configurations are correct. Verify that the
network cable lengths meet network specifications.

2. Are the network cables connected properly?

Make sure that the product is attached to the network using the appropriate port and cable. Check
each cable connection to make sure it is secure and in the right place. If the problem continues,
try a different cable or ports on the hub or transceiver. The amber activity light and the green link
status light next to the port connection on the back of the product should be lit.

3. Are the product link speed and duplex settings set correctly?

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting).

4. Can you "ping" the product IP address?

Use the command prompt to ping the product from the computer. For example:

ping 192.168.45.39

Ensure that the ping displays round-trip times.

If you are able to ping the product, verify that the IP address configuration for the product is correct
on the computer. If it is correct, delete and then add the product again.

If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

5. Have any software programs been added to the network?

Make sure they are compatible and that they are installed correctly with the correct printer drivers.

6. Are other users able to print?

The problem may be workstation-specific. Check the workstation network drivers, printer drivers,
and redirection.

7. If other users are able to print, are they using the same network operating system?

Check your system for proper network operating system setup.

8. Is your protocol enabled?

Check the status of your protocol on the network configuration page. See Information pages
on page 142. You can also use the embedded Web server or HP ToolboxFX to check the status
of other protocols. See HP ToolboxFX on page 144.
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Solve software problems
Solve common Windows problems 

Error message:

"General Protection FaultException OE"

"Spool32"

"Illegal Operation"

Cause Solution

Close all software programs, restart Windows, and try again.

Select a different printer driver. If the device PCL 6 printer
driver is selected, switch to the PCL 5 or HP postscript level 3
emulation printer driver, which can be done from a software
program.

Delete all temp files from the Temp subdirectory. Determine
the name of the directory by opening the AUTOEXEC.BAT file
and looking for the statement "Set Temp =". The name after
this statement is the Temp directory. It is usually C:\TEMP by
default, but can be redefined.

See the Microsoft Windows documentation that came with the
computer for more information about Windows error
messages.

Solve common Macintosh problems
Table 12-3  Problems with Mac OS X v10.3 and Mac OS X v10.4

The printer driver is not listed in Printer Setup Utility.

Cause Solution

The product software might not have been installed or was installed
incorrectly.

Make sure that the PPD is in the following hard drive folder:
Library/Printers/PPDs/Contents/Resources/

<lang>.lproj, where “<lang>” represents the two-letter language
code for the language that you are using. If necessary, reinstall the
software. See the getting started guide for instructions.

The Postscript Printer Description (PPD) file is corrupt. Delete the PPD file from the following hard drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where “<lang>” represents the two-letter language code for the
language that you are using. Reinstall the software. See the getting
started guide for instructions.

The product name, IP address, or “Rendezvous” or “Bonjour” host name does not appear in the printer list box in the Printer Setup
Utility.

Cause Solution

The product might not be ready. Make sure that the cables are connected correctly, the product is on,
and the ready light is on. If you are connecting through a USB or
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The product name, IP address, or “Rendezvous” or “Bonjour” host name does not appear in the printer list box in the Printer Setup
Utility.

Cause Solution

Ethernet hub, try connecting directly to the computer or use a different
port.

The wrong product name, IP address, or "Rendezvous" or "Bonjour"
host name is being used.

Check the product name, IP address, or "Rendezvous" or "Bonjour"
host name by printing a configuration page See Information pages
on page 142. Verify that the name, IP address, or "Rendezvous" or
"Bonjour" host name on the configuration page matches the product
name, IP address, or "Rendezvous" or "Bonjour" host name in the
Printer Setup Utility.

The interface cable might be defective or of poor quality. Replace the interface cable. Make sure to use a high-quality cable.

A print job was not sent to the product that you wanted.

Cause Solution

The print queue might be stopped. Open the print queue, and then click Start Jobs.

The wrong product name or IP address is being used. Another
product with the same or similar name, IP address, or "Rendezvous"
or "Bonjour" host name might have received your print job.

Check the product name, IP address, or "Rendezvous" or "Bonjour"
host name by printing a configuration page See Information pages
on page 142. Verify that the name, IP address, or "Rendezvous" or
"Bonjour" host name on the configuration page matches the product
name, IP address, or "Rendezvous" or "Bonjour" host name in the
Printer Setup Utility.

An encapsulated PostScript (EPS) file does not print with the correct fonts.

Cause Solution

This problem occurs with some programs. ● Try downloading the fonts that are contained in the EPS file to
the product before printing.

● Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.

Cause Solution

This error occurs when the software for USB printers is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.

Table 12-3  Problems with Mac OS X v10.3 and Mac OS X v10.4 (continued)

ENWW Solve software problems 209



When connected with a USB cable, the product does not appear in the Macintosh Printer Setup Utility after the driver is selected.

Cause Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting

● Check that your Macintosh supports USB.

● Verify that your Macintosh operating system is Mac OS X v10.3
or Mac OS X v10.4.

● Ensure that your Macintosh has the appropriate USB software
from Apple.

Hardware troubleshooting

● Check that the product is turned on.

● Verify that the USB cable is connected correctly.

● Check that you are using the appropriate high-speed USB cable.

● Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

● Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain and connect the cable directly to the USB port on
the host computer.

NOTE: The iMac keyboard is a nonpowered USB hub.

Solve PostScript (PS) errors
The following situations are PS language specific and may occur when several product languages are
being used.

NOTE: To receive a printed or screen displayed message when PS errors occur, open the Print
Options dialog box and click the selection next to the PS Errors section. You can also use the embedded
Web server.

Table 12-4  PS errors

Issue Cause Solution

The job prints in Courier (the product's
default typeface) instead of the typeface
you requested.

The requested typeface is not
downloaded. A personality switch may
have been performed to print a PCL job
just before the PS printing job was
received.

Download the desired font and send the
print job again. Verify the type and
location of the font. Download to the
product if applicable. Check with the
software documentation.

A legal page prints with clipped margins. Print job too complex. You may need to print your job at
600 dots per inch, reduce the complexity
of the page, or install more memory.

A PS error page prints. Print job may not be PS. Make sure the print job is a PS job. Check
to see whether the software program
expected a setup or PS header file to be
sent to the product.

Table 12-3  Problems with Mac OS X v10.3 and Mac OS X v10.4 (continued)
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Issue Cause Solution

Limit Check Error Print job is too complex. You may need to print your job at
600 dots per inch, reduce the complexity
of the page, or install more memory.

VM Error Font Error Select unlimited downloadable fonts
from printer driver.

Range Check Font Error Select unlimited downloadable fonts
from printer driver.

Table 12-4  PS errors (continued)

ENWW Solve software problems 211



212 Chapter 12   Problem solve ENWW



A Accessories and ordering information

● To order supplies in the U.S., go to www.hp.com/sbso/product/supplies.

● To order supplies worldwide, go to www.hp.com/ghp/buyonline.html.

● To order supplies in Canada, go to www.hp.ca/catalog/supplies.

● To order supplies in Europe, go to www.hp.com/go/ljsupplies.

● To order supplies in Asia-Pacific, go to www.hp.com/paper/.

● To order accessories, go to www.hp.com/go/accessories.
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Supplies
Product name Description Part number

Black print cartridge Average yield for the standard print
cartridge is approximately 3,000 pages.
Average yield for the extended-life print
cartridge is approximately 7,000 pages.
Actual yield depends on use.

Standard: Standard: Q7553A

Extended life: Extended life: Q7553X

Memory
Product name Description Part number

Memory upgrades (DIMMs) 64 MB CB421A

128 MB CB422A

256 MB CB423A

Cable and interface accessories
Product name Description Part number

USB cable 2-meter standard USB-compatible
device connector

C6518A

3-meter standard USB-compatible
device connector

C6520A

Fax cord Two-wire phone cord adapter 8121-0811

HP Wireless Printing Upgrade Kit Printer adapter for wireless point-to-point
printing.

Q6259A

Paper-handling accessories
Product name Description Part number

Optional tray 3 250-sheet input tray for standard sizes. Q7556A

Stapler cartridge pack 1,500-staple capacity Q7432A
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User-replaceable parts
Product name Description Part number

Separation pad and pickup rollers Replace when the product is picking up
multiple sheets or no sheets. Trying
different paper did not resolve the
problem.

Contact HP Customer Care to order
parts.

Automatic document feeder (ADF) Replace when the ADF is damaged or
not working correctly.

Contact HP Customer Care to order
parts.
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B Service and support

Hewlett-Packard limited warranty statement
HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet M2727nf and M2727nfs One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in materials
and workmanship after the date of purchase, for the period specified above. If HP receives notice of such defects
during the warranty period, HP will, at its option, either repair or replace products which prove to be defective.
Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of purchase,
for the period specified above, due to defects in material and workmanship when properly installed and used. If
HP receives notice of such defects during the warranty period, HP will replace software which does not execute
its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, within a
reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a refund of
the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject to
incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b)
software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) operation
outside of the published environmental specifications for the product, or (e) improper site preparation or
maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER
WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or
provinces do not allow limitations on the duration of an implied warranty, so the above limitation or exclusion might
not apply to you. This warranty gives you specific legal rights and you might also have other rights that vary from
country/region to country/region, state to state, or province to province. HP's limited warranty is valid in any country/
region or locality where HP has a support presence for this product and where HP has marketed this product. The
level of warranty service you receive may vary according to local standards. HP will not alter form, fit or function
of the product to make it operate in a country/region for which it was never intended to function for legal or regulatory
reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR
SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS
SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL
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(INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR
OTHERWISE. Some countries/regions, states or provinces do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

Customer self repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Print cartridge limited warranty statement
This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the device product or (c) exhibit wear
from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP Customer Care
Online Services

For 24-hour access to updated HP device-specific software, product information, and support
information through an Internet connection, go to the Web site: www.hp.com/support/LJM2727.

HP Instant Support Professional Edition (ISPE) is a suite of Web-based troubleshooting tools for desktop
computing and printing products. Go to instantsupport.hp.com.

Telephone support
HP provides free telephone support during the warranty period. For the telephone number for your
country/region, see the flyer that shipped with the device, or visit www.hp.com/support/. Before calling
HP, have the following information ready: the product name and serial number, the date of purchase,
and a description of the problem.

Software utilities, drivers, and electronic information
www.hp.com/go/LJM2727_software

The Web page for the drivers is in English, but you can download the drivers themselves in several
languages.

HP direct ordering for accessories or supplies
● United States: www.hp.com/sbso/product/supplies.

● Canada: www.hp.ca/catalog/supplies

● Europe: www.hp.com/go/ljsupplies

● Asia-Pacific: www.hp.com/paper/

To order genuine HP parts or accessories, go to the HP Parts Store at www.hp.com/buy/parts (U.S. and
Canada only), or call 1-800-538-8787 (U.S.) or 1-800-387-3154 (Canada).

HP service information
To locate HP-Authorized Dealers, call 1-800-243-9816 (U.S.) or 1-800-387-3867 (Canada).

Outside the United States and Canada, call the customer support number for your country/region. See
the flyer that shipped in the box with the device.

HP service agreements
Call 1-800-HPINVENT (1-800-474-6836 (U.S.)) or 1-800-268-1221 (Canada). Or, go to the HP
SupportPack and CarepaqTM Services Web site at www.hpexpress-services.com/10467a.

For extended service, call 1-800-446-0522.

220 Appendix B   Service and support ENWW

http://www.hp.com/support/LJM2727
http://instantsupport.hp.com
http://www.hp.com/support/
http://www.hp.com/go/LJM2727_software
http://www.hp.com/sbso/product/supplies
http://www.hp.ca/catalog/supplies
http://www.hp.com/go/ljsupplies
http://www.hp.com/paper/
http://www.hp.com/buy/parts
http://www.hpexpress-services.com/10467a


HP ToolboxFX
To check the device status and settings and view troubleshooting information and online documentation,
use the HP ToolboxFX. You must have performed a full software installation in order to use the
HP ToolboxFX. See HP ToolboxFX on page 144.

HP support and information for Macintosh computers
Go to www.hp.com/go/macosx for Macintosh OS X support information and HP subscription service for
driver updates.

Go to www.hp.com/go/mac-connect for products that are designed specifically for the Macintosh user.

HP maintenance agreements
HP has several types of maintenance agreements that meet a wide range of support needs.
Maintenance agreements are not part of the standard warranty. Support services may vary by area.
Check with your local HP dealer to determine the services available to you.

On-site service agreements
To provide you with the level of support best suited to your needs, HP has on-site service agreements
with a selection of response times.

Next-day on-site service
This agreement provides support by the next working day following a service request. Extended
coverage hours and extended travel beyond HP’s designated service zones are available on most on-
site agreements (for additional charges).

Weekly (volume) on-site service
This agreement provides scheduled weekly on-site visits for organizations with many HP products. This
agreement is designated for sites using 25 or more workstation products, including devices, plotters,
computers, and disk drives.

Repacking the device
If HP Customer Care determines that your device needs to be returned to HP for repair, follow the steps
below to repack the device before shipping it.

CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.
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To repack the device

1. Remove and retain any DIMMs cards that you have purchased and installed in the device. Do not
remove the DIMM that came with the device.

CAUTION: Static electricity can damage DIMMs. When handling DIMMs, either wear an antistatic
wrist strap, or frequently touch the surface of the DIMM antistatic package and then touch bare
metal on the device. To remove the DIMMs, see Memory DIMMs on page 160.

2. Remove and retain the print cartridge.

CAUTION: It is extremely important to remove the print cartridge before shipping the device. A
print cartridge that remains in the device during shipping will leak and entirely cover the device
engine and other parts with toner.

To prevent damage to the print cartridge, avoid touching the roller on it, and store the print cartridge
in its original packing material or so that it is not exposed to light.

3. Remove and retain the power cable, interface cable, and optional accessories.

4. If possible, include print samples and 50 to 100 sheets of paper or other print media that did not
print correctly.

5. In the U.S., call HP Customer Care to request new packing material. In other areas, use the original
packing material, if possible. Hewlett-Packard recommends insuring the equipment for shipment.

Extended warranty
HP Support provides coverage for the HP hardware product and all HP-supplied internal components.
The hardware maintenance covers a 1- to 3-year period from date of the HP product purchase. The
customer must purchase HP Support within the stated factory warranty. For more information, contact
the HP Customer Care Service and Support group.
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C Specifications

This section contains the following information about the product:

● Physical specifications

● Electrical specifications

● Power consumption

● Environmental specifications

● Acoustic emissions
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Physical specifications
Table C-1  Physical specifications

Product Height Depth Width Weight

HP LaserJet M2727nf 690 mm (27.2 inches) 650 mm (25.6 inches) 500 mm (19.7 inches) 17.2 kg (37.8 lb)

HP LaserJet M2727nfs 780 mm (30.7 inches) 650 mm (25.6 inches) 500 mm (19.7 inches) 20.5 kg (44.9 lb)

Electrical specifications
CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Table C-2  Electrical specifications

Item 110-volt models 230-volt models

Power requirements 110 to 127 V (+/- 10%)

50 / 60 Hz (+/- 2 Hz)

220 to 240 V (+/- 10%)

50 / 60 Hz (+/- 2 Hz)

Rated current 4.9 A 2.9 A

Power consumption
Table C-3  Power consumption (average, in watts)1  

Product model Printing2 Copying2 Ready/Sleep3 Off

HP LaserJet M2727nf 410 W 410 W 13 W <0.1 W

HP LaserJet M2727nfs 410 W 410 W 13 W <0.1 W

1 Values are based on preliminary data. See www.hp.com/support/LJM2727 for current information.
2 Power reported is highest values measured using all standard voltages.
3 Instant on fuser technology.
4 Recovery time from Ready/Sleep to start of printing = 8.5 seconds.
5 Maximum heat dissipation for all models in Ready mode = 45 BTU/hour
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Environmental specifications
Table C-4  Environmental specifications1 

Recommended Operating Storage

Temperature 15° to 32.5° C

(59° to 90.5° F)

15° to 32.5° C

(59° to 90.5° F)

–20° to 40° C

(–4° to 104° F)

Relative humidity 10% to 80% 10% to 80% 95% or less

1 Values are subject to change.

Acoustic emissions
Table C-5  Acoustic emissions 

Sound Power Level Declared per ISO 92961

Printing (26 ppm) LWAd = 6.4 Bels (A) [64 dB (A)]

Ready Inaudible

Sound Pressure Level - Bystander Position Declared per ISO 92961

Printing (26 ppm) LpAm = 50 dB(A)

Ready Inaudible

1 Values are based on preliminary data. See www.hp.com/support/LJM2727 for current information.
2 Configuration tested: HP LaserJet M2727nf printing simplex using A4 paper at 26 ppm.
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D Regulatory information

This section contains the following regulatory information:

● FCC compliance

● Environmental product stewardship program

● Telephone Consumer Protection Act (United States)

● IC CS-03 requirements

● EU statement for telecom operation

● New Zealand telecom statements

● Declaration of conformity

● Safety statements
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FCC compliance

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If it is not installed and used in accordance with the instructions, it may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by Hewlett-
Packard could void the user's authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.

This equipment complies with FCC rules, Part 68. On the back of this equipment is a label that contains,
among other information, the FCC registration number and ringer equivalence number (REN) for this
equipment. If requested, this information must be provided to the telephone company. The REN is used
to determine the quantity of devices which may be connected to the telephone line. Excessive RENs
on the telephone line may result in the devices not ringing in response to an incoming call. In most, but
not all, areas, the sum of the RENs should not exceed five (5.0). To be certain of the number of devices
that may be connected to the line, as determined by the total RENs, contact the telephone company to
determine the maximum REN for the calling area.

This equipment uses the following USOC jacks: RJ11C.

An FCC-compliant telephone cord and modular plug is provided with this equipment. This equipment is
designed to be connected to the telephone network or premises wiring using a compatible modular jack
which is Part 68 compliant. This equipment cannot be used on telephone company-provided coin
service. Connection to Party Line Service is subject to state tariffs. If this equipment causes harm to the
telephone network, the telephone company will notify you in advance that temporary discontinuance of
service may be required. If advance notice is not practical, the telephone company will notify the
customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if
you believe it is necessary. The telephone company may make changes in its facilities, equipment,
operations, or procedures that could affect the operation of the equipment. If this happens, the telephone
company will provide advance notice in order for you to make the necessary modifications in order to
maintain uninterrupted service. If trouble is experienced with this equipment, please see the numbers
in the front of this manual for repair and (or) warranty information. If the trouble is causing harm to the
telephone network, the telephone company may request you remove the equipment from the network
until the problem is resolved. The following repairs can be done by the customer: Replace any original
equipment that came with the device. This includes the print cartridge, the supports for trays and bins,
the power cord, and the telephone cord. It is recommended that the customer install an AC surge arrestor
in the AC outlet to which this device is connected. This is to avoid damage to the equipment caused by
local lightning strikes and other electrical surges.
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Environmental product stewardship program
Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready/Sleep mode, which saves natural resources and saves
money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:

http://www.hp.com/hpinfo/globalcitizenship/environment/productdesign/ecolabels.html

Toner consumption
EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use
This device’s manual/automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet
Partners. Multilingual program information and instructions are included in every new HP LaserJet print
cartridge and supplies package. You help reduce the toll on the environment further when you return
multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.
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Return and recycling instructions

United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (two to eight cartridges)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape up to eight single boxes together using strapping or packaging tape (up to 70 lbs).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from the http://www.hp.com/
recycle or 1-800-340-2445 (holds up to eight HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit http://www.ups.com. If you are returning via USPS label, give the
package to a U.S. Postal Service carrier or drop off at a U.S.Postal Service Office. For more information,
or to order additional labels or boxes for bulk returns, visit http://www.hp.com/recycle or call
1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to
change without notice.

Non-US returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new printer supply item) or visit
http://www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:
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HP LaserJet M2727

Type Carbon monofluoride lithium

Weight 0.8 g

Location On formatter board

User-removable No

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by contacting the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
globalcitizenship/environment.

ENWW Environmental product stewardship program 231

http://www.hp.com/recycle
http://www.eiae.org
http://www.hp.com/go/msds
http://www.hp.com/hpinfo/globalcitizenship/environment/index.html
http://www.hp.com/hpinfo/globalcitizenship/environment/index.html


For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment/index.html.
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Telephone Consumer Protection Act (United States)
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including fax machines, to send any message unless such message clearly
contains, in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business, other entity, or individual
sending the message and the telephone number of the sending machine or such business, other entity,
or individual. (The telephone number provided cannot be a 900 number or any other number for which
charges exceed local or long-distance transmission charges.)

IC CS-03 requirements
Notice: The Industry Canada label identifies certified equipment. This certification means the equipment
meets certain telecommunications network protective, operational, and safety requirements as
prescribed in the appropriate Terminal Equipment Technical Requirement document(s). The
Department does not guarantee the equipment will operate to the user’s satisfaction. Before installing
this equipment, users should ensure that it is permissible for the equipment to be connected to the
facilities of the local telecommunications company. The equipment must also be installed using an
acceptable method of connection. The customer should be aware that compliance with the above
conditions may not prevent degradation of service in some situations. Repairs to certified equipment
should be coordinated by a representative designated by the supplier. Any repairs or alterations made
by the user to this equipment, or equipment malfunctions, may give the telecommunications company
cause to request the user to disconnect the equipment. Users should ensure for their own protection
that the electrical ground connections of the power utility, telephone lines, and internal metallic water
pipe system, if present, are connected together. This precaution can be particularly important in rural
areas.

CAUTION: Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority, or electrician, as appropriate. The Ringer Equivalence Number
(REN) of this device is 0.7.

Notice: The Ringer Equivalence Number (REN) assigned to each terminal device provides an indication
of the maximum number of terminals allowed to be connected to a telephone interface. The termination
on an interface may consist of any combination of devices subject only to the requirement that the sum
of the Ringer Equivalence Number of all the devices does not exceed five (5.0). The standard connecting
arrangement code (telephone jack type) for equipment with direct connections to the telephone network
is CA11A.
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EU statement for telecom operation
This product is intended to be connected to the analog Public Switched Telecommunication Networks
(PSTN) of European Economic Area (EEA) countries/regions. It meets requirements of EU R&TTE
Directive 1999/5/EC (Annex II) and carries appropriate CE conformity marking. For more details, see
Declaration of Conformity issued by the manufacturer in another section of this manual. However, due
to differences between individual national PSTNs, the product may not guarantee unconditional
assurance of successful operation on every PSTN termination point. Network compatibility depends on
the correct setting being selected by the customer in preparation of its connection to the PSTN. Please
follow the instructions provided in the user manual. If you experience network compatibility issues,
please contact your equipment supplier or Hewlett-Packard help desk in the country/region of operation.
Connecting to a PSTN termination point may be the subject of additional requirements set out by the
local PSTN operator.

New Zealand telecom statements
The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted
that the item complies with minimum conditions for connection to its network. It indicates no endorsement
of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance
that any item will work correctly in all respects with another item of Telepermitted equipment of a different
make or model, nor does it imply that any product is compatible with all of Telecom’s network services.

This equipment may not provide for the effective hand-over of a call to another device connected to the
same line.

This equipment shall not be set up to make automatic calls to the Telecom “111” Emergency Service.

This product has not been tested to ensure compatibility with the FaxAbility distinctive ring service for
New Zealand.
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Declaration of conformity
Declaration of Conformity
according to ISO/IEC 17050-1 and EN 17050-1
Manufacturer's Name: Hewlett-Packard Company       DoC#: BOISB-0602-01-rel.1.0
Manufacturer's Address: 11311 Chinden Boulevard,

Boise, Idaho 83714-1021, USA
declares, that the product

Product Name: HP LaserJet M2727 nf and M2727nfs
Regulatory Model Number2) BOISB-0602-01

Including: Q7556A—Optional 250-Sheet Input Tray
Product Options: ALL
Print Cartridges: Q7553A / Q7553X
conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN55022:2006 – Class B1)

EN 61000-3-2:2000 +A2
EN 61000-3-3:1995 +A1
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

TELECOM: ES 203 021; FCC Title 47 CFR, Part 683)

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the
R&TTE Directive 1999/5/EC (Annex II), and carries the CE-Marking accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name
or the product number(s).

3) Telecom approvals and standards appropriate for the target countries/regions have been applied to this product, in addition to those listed
above.

Boise, Idaho , USA

July 2007

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe,, Herrenberger Strasse 140, , D-71034, Böblingen, (FAX: +49-7031-14-3143)

USA Contact: Product Regulations Manager, Hewlett-Packard Company,, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, , (Phone:
208-396-6000)
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Safety statements
Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

EMI statement (Korea)
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Laser statement for Finland
Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet M2727nf, M2727nfs, laserkirjoitin on käyttäjän kannalta turvallinen luokan 1 laserlaite.
Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen ulkopuolelle.
Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (1994) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet M2727nf, M2727nfs - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia kohteita.
Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi
huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän
käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman
erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.

Substances table (China)
电 产 污 办根据中国 子信息 品 染控制管理 法的要求而出台

Table D-1  质有毒有害物 表

部件名称 质有毒有害物 和元素

铅  (Pb) 汞 (Hg) 镉  (Cd) 铬六价  (Cr(VI)) 溴溴多 苯 (PBB) 溴 醚多 二苯
(PBDE)

打印引擎 X O X X O O

复 组印机 件 X O O O O O

控制面板 O O O O O O

塑料外壳 O O O O O O

组格式化板 件 X O O O O O

碳粉盒 X O O O O O
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O: 类表示在此部件所用的所有同 材料中， 质所含的此有毒或有害物 均低于 SJ/T11363-2006 的限制要
求。

X: 类表示在此部件所用的所有同 材料中， 种 质至少一 所含的此有毒或有害物 高于 SJ/T11363-2006 的限
制要求。

NOTE: 引用的“环保使用期限” 产是根据在正常温度和湿度条件下操作使用 品而确定的。
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Glossary

ADF Automatic document feeder. The ADF is used to automatically feed originals into the product for copying,
scanning, or faxing.

browser Short for Web browser, a software program that is used to locate and open Web pages.

collate The process of printing a multiple-copy job in sets. When collate is selected, the product prints an entire
set before printing additional copies. Otherwise, the product prints the specified number of copies of one page
before printing the subsequent pages.

comma (,) A comma in a fax dial sequence indicates that the product will pause at that point in the dialing
sequence.

contrast The difference between the dark and light areas of an image. The lower the number value, the more
closely the shades resemble each other. The higher the number, the more the shades appear separate from each
other.

dedicated line A single telephone line that is used exclusively for either voice calls or fax calls.

DIMM Dual inline memory module, a small circuit board that holds memory. A single in-line memory module
(SIMM) has a 32-bit path to the memory, whereas a DIMM has a 64-bit path.

distinctive ring A service offered by some telephone companies in some countries/regions that allows two or
three phone numbers to be set up on the same telephone line. Each phone number has a different ring pattern,
and the fax machine can be configured to recognize the distinctive ring of the fax number.

dots per inch (dpi) A measurement of resolution that is used for printing. Generally, more dots per inch result
in a higher resolution, more visible detail in the image, and a larger file size.

DSL Digital subscriber line, a technology that enables a high-speed, direct connection to the Internet through
telephone lines.

e-mail (electronic mail) An abbreviation for electronic mail. Software that can be used to electronically transmit
items over a communications network.

fax An abbreviation of facsimile. The electronic encoding of a printed page and the transmission of the electronic
page over a telephone line. The product software can send items to electronic fax programs, which require a
modem and fax software.

fax functions Fax-related tasks that are done from the control panel or software that affect only the current job,
or are done only once before returning to the Ready state, such as clearing memory. These functions are in their
own section in the control-panel menu.

fax settings Fax-related items that, when set or changed, continue to use the choice made until changed again.
An example would be the number of times set for the product to redial a busy number. These settings are in their
own section of the control panel menu.
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file format The way the contents of a file are structured by a program or group of programs.

grayscale Shades of gray that represent light and dark portions of an image when color images are converted
to grayscale; colors are represented by various shades of gray.

halftone An image type that simulates grayscale by varying the number of dots. Highly colored areas consist of
a large number of dots, while lighter areas consist of a smaller number of dots.

HP Director A software screen that is used when working with documents. When the document is loaded into
the automatic document feeder (ADF) and the computer is connected directly to the product, the HP Director
appears on the computer screen to initiate faxing, copying, or scanning.

HP ToolboxFX HP ToolboxFX is a program that provides access to the product management and
troubleshooting tools, embedded Web server, and product documentation. HP ToolboxFX does not support
Macintosh operating systems.

ISDN Integrated Services Digital Network (ISDN) is a suite of internationally adopted standards for end-to-end
digital communication over the public telephone network.

link A connection to a program or device that can be used to send information from the product software to other
programs, such as e-mail, electronic fax, and OCR links.

optical character recognition (OCR) software OCR software converts an electronic image of text, such as a
scanned document, into a form that word processor, spreadsheet, and database programs can use.

pixels per inch (ppi) A measurement of resolution that is used for scanning. Generally, more pixels per inch
result in a higher resolution, more visible detail in the image, and a larger file size.

printer driver A printer driver is a program that software programs use to gain access to a product’s features.
A printer driver translates a software program’s formatting commands (such as page breaks and font selection)
into a printer language (such as PostScript or PCL), and then sends the print file to the product.

private branch exchange (PBX) A small telephone switching system that typically is used by large businesses
or universities to connect all telephone extensions within the organization. A PBX also connects to the public
switched telephone network (PSTN) and may be either manual or dial, depending on the method used by
extensions to place incoming or outgoing calls. Normally, the equipment is owned by the customer rather than
leased from the telephone company.

public switched telephone network (PSTN) The worldwide dial-up telephone network or a portion of that
network. Users are assigned unique phone numbers, which allow them to connect to the PSTN through local
telephone exchange companies. Often, this phrase is used when referring to data or other non-telephone services
carried over a path initially established using normal telephone signaling and ordinary switched long-distance
telephone circuits.

Readiris An optical character recognition (OCR) program that was developed by I.R.I.S. and that is included
with the product software.

resolution The sharpness of an image, measured in dots per inch (dpi). The higher the dpi, the greater the
resolution.

shared line A single telephone line that is used for both voice and fax calls.

surge protector A device that protects a power supply and communications lines from electrical surges.

TWAIN An industry standard for scanners and software. By using a TWAIN-compliant scanner with a TWAIN-
compliant program, a scan can be initiated from within the program.
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URL Uniform resource locator, the global address of documents and resources on the Internet. The first part of
the address indicates what protocol to use, the second part specifies the IP address or the domain name where
the resource is located.

USB Universal serial bus (USB) is a standard that was developed by the USB Implementers Forum, Inc., to
connect computers and peripherals. USB is designed to concurrently connect a single computer USB port to
multiple peripherals.

watermarks A watermark adds background text to a document that is being printed. For example, “Confidential”
can be printed in the background text of a document to indicate that the document is confidential. A selection can
be made from a set of predefined watermarks, and the font, size, angle, and style can be changed. The product
can place the watermark on the first page only or all pages.

WIA Windows Imaging Architecture (WIA) is an imaging architecture that is available in Windows Me and
Windows XP. A scan can be initiated from within these operating systems by using a WIA-compliant scanner.
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A
accessibility features 3
accessories

part numbers 214
acoustic emissions 225
activity log, fax

troubleshooting 140
ad hoc groups, sending faxes

to 121
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scan destinations
(Windows) 85

ADF
jams 177
locating 4
page sizes supported 136
part number 215

alert messages 170
alerts, setting up 144
answer mode, setting 111
answering machines, connecting

fax settings 110
authorized dealers 220
automatic document feeder

loading for scanning 82
automatic document feeder (ADF)

capacity 68
jams 177
load for copying 68
locating 4
page sizes supported 136
part number 215

autoreduction settings, fax 113

B
background shading,

troubleshooting 191
bands and streaks,

troubleshooting 191
batteries included 230

billing codes, fax
using 109

bins, output
jams, clearing 185
locating 4

black and white scanning 88
blank copies,

troubleshooting 200
blank pages

printing 59
troubleshooting 196

blank scans, troubleshooting 203
blocking faxes 114
booklet settings

Windows 57
books

copying 76
scanning 90

busy signals, redialing
options 106

C
cables

part numbers 214
USB, troubleshooting 197

call report, fax
troubleshooting 140

caller-ID boxes, connecting 96
calling cards 120
Canadian DOC regulations 236
canceling

copy jobs 70
faxes 116
print job 56
scan jobs 86

cartridge-door release, locating 4
cartridges

HP fraud hotline 158
part numbers 214
recycling 158,  229

replacing 159
reusing 159
status, checking 157
status, viewing with

HP ToolboxFX 144
storing 158
warranty 219

cartridges, print
Macintosh status 34

characters, troubleshooting 192
cleaning

automatic document
feeder 163

exterior 165
glass 88,  165
lid backing 164
paper path 162
scanner glass 72
scanner strip 73,  164

collating copies 71
color

scanning settings 88
color, scanning settings 87
comparison, product models 1
configuration page

printing 142
contacting HP 220
contrast settings

copy 73
fax 107

control panel
cleaning page, printing 162
HP ToolboxFX system

settings 151
menus 11
messages,

troubleshooting 170
scanning from (Macintosh) 35
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settings 23,  28
supplies status, checking

from 157
control-panel

troubleshooting display
problems 176

convenience stapler
jams, clearing 188
specifications 3
supplies, part numbers 214

copying
books 76
canceling 70
changing default number 69
collating 71
contrast, adjusting 73
double-sided 78
draft setting 74
edge-to-edge 74
enlarging 70
light/dark settings 73
loading ADF 68
loading flatbed scanner 68
media settings 74
media sizes 74
media types 74
media, troubleshooting 199
mixed-size originals 78
multiple copies 69
one-sided to two-sided 78
one-touch 69
photos 76
quality, adjusting 72
quality, troubleshooting 198
reducing 70
restore default settings 76
setup menu 12
size, troubleshooting 200
tray selection 51
troubleshooting 200
two-sided setting,

changing 79
two-sided to two-sided 78
two-sided, manually 79

cover pages 32,  59
creases, troubleshooting 193
crooked pages 193,  195
curled media 193
custom-size copies 70

custom-size paper settings
Macintosh 32

customer support
online 220
repacking device 221

D
dark copying 198
darkness, contrast settings

copy 73
fax 107

defaults, restoring 169
delaying fax sending 126
deleting faxes from memory 117
demo page, printing 142
density, print

changing settings 57
destinations, add scan

Windows 85
device discovery over

network“ 39
device polling 151
device status

Macintosh Services tab 34
dial-tone detection settings 106
dialing

fax 15
from a telephone 126
manually 120
pauses, inserting 100
prefixes, inserting 105
redial manually 122
redialing automatically,

settings 106
tone or pulse settings 108
troubleshooting 137

dimensions
media 47

DIMMs
adding 160
part numbers 214

disposal, end-of-life 230
distinctive-ring settings 112
Documentation tab,

HP ToolboxFX 148
dots per inch (dpi)

fax 107,  108
specifications 3

dots, troubleshooting 190
double-sided copying 78

double-sided printing
automatic, Windows 63
manual, Windows 63

dpi (dots per inch)
fax 107,  108
faxing 15
scanning 87
specifications 3

drivers
Macintosh settings 32
Macintosh,

troubleshooting 208
operating systems

supported 7
presets (Macintosh) 32
settings 23,  28
shortcuts (Windows) 62
specifications 3
supported 22
Windows settings 62

duplex printing
automatic, Windows 63
manual, Windows 63

duplexer
jams, clearing 183

E
e-mail

setting alerts in
HP ToolboxFX 145

e-mail alerts, setting up 144
e-mail, scanning to

Macintosh 35
resolution settings 88
Windows 86

EconoMode setting 61
edge-to-edge printing 74
electrical specifications 224
electronic faxes

receiving 112
sending 124

embedded Web server 25,  30
embedded Web server (EWS)

features 153
end-of-life disposal 230
enlarging documents

copying 70
environmental specifications 225
environmental stewardship

program 229
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EPS files, troubleshooting 209
error messages

control panel 170
critical 174

error messages, fax 129
error report, fax

printing 134
error-correction setting, fax 135
errors, PostScript 210
EU statement for telecom

operation 234
European Union, waste

disposal 231
event log 144
express software installation 7
extended warranty 222
extension phones

receiving faxes from 115
sending faxes from 126

F
factory-set defaults, restoring 169
faded print 190
fax

ad hoc groups 121
answer mode 16,  111
autoreduction 113
billing codes 109
blocking 114
canceling 116
contrast setting 107
delaying sending 126
deleting from memory 117
detect-dial-tone settings 106
dial prefixes 105
dialing, tone or pulse 108
error messages 129
error report, printing 134
error-correction 135
extension phone

receiving 115
factory-set defaults,

restoring 169
forwarding 111
glass-size setting 108
group-dial entries 123
jams, troubleshooting 176
manual dialing 120
pauses, inserting 100
polling 103

receive log 148
receiving from software 112
receiving when you hear fax

tones 128
redial manually 122
redial settings 106
reports 13
reports, printing all 133
reports, troubleshooting 140
reprinting from memory 127
resolution 107,  108
ring patterns 112
ring type 16
rings-to-answer 110
security, password

protection 103
security, private receive 104
send by using speed dial 122
send log 148
sending from a telephone 126
sending from software 124
silence-detect mode 113
speed dials 122
stamp-received 114
troubleshooting receiving 138
troubleshooting sending 136
V.34 setting 135
volume settings 105

fax date, setup
use control panel 97
use HP Fax Setup Wizard 98

fax header, setup
use control panel 97
use HP Fax Setup Wizard 98

fax ports, locating 5
fax reports, printing 13
Fax tab, HP ToolboxFX 145
fax time, setup

use control panel 97
use HP Fax Setup Wizard 98

faxing
from a computer

(Macintosh) 36
FCC compliance 228
features

product 3
feeding problems,

troubleshooting 195
file, scanning to

Macintosh 35

Finnish laser safety
statement 237

firmware updates 165
first page

blank 59
use different paper 32,  59

Fit to Page setting, fax 113
flatbed scanner

default glass-size, setting 108
folder, scanning to 86
fonts

printing font lists 142
selecting 65

forwarding faxes 111
fraud hotline 158
fuser

error 174
media guidelines 58
warranty 219

G
General Protection FaultException

OE 208
glass, cleaning 88,  165
glass-size setting 108
glossary of terms 239
gray background,

troubleshooting 191
grayscale scanning 88
group-dial entries

creating 102
deleting 102
editing 102
sending faxes to 123

H
Help tab, HP ToolboxFX 148
HP Customer Care 220
HP fraud hotline 158
HP Instant Support Professional

Edition (ISPE) 220
HP LaserJet Scan (Windows) 83
HP SupportPack 222
HP ToolboxFX

device information 149
Documentation tab 148
Fax tab 145
Help tab 148
Network Settings tab 152
opening 144
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Print Settings tab 151
Status tab 144
supplies status, checking

from 157
System Settings tab 149

HP Web Jetadmin 25,  154
HP-Authorized Dealers 220
HP-UX software 26
humidity specifications

environment 225

I
IC CS-03 requirements 233
Illegal Operation errors 208
image quality

copy, troubleshooting 198
HP ToolboxFX settings 150
print, troubleshooting 190,

204
scans, troubleshooting 201,

203
information pages

configuration 41
network configuration 41

input tray
loading media 50

installation, software
express 7
recommended 6
types (Windows) 24

installing
Macintosh software for direct

connections 29
Macintosh software on

networks 29
Windows software 6,  24

Instant Support Professional
Edition (ISPE) 220

interface ports
cables, ordering 214
locating 5
types included 3

international dialing 120
IP address

automatic configuration 42
Macintosh,

troubleshooting 208
manual configuration 42
protocols supported 39

J
jams

ADF, clearing 177
causes of 176
duplexer, clearing 183
fax, clearing 177
locating 177
output-bin, clearing 185
preventing 189
print cartridge area,

clearing 187
stapler, clearing 188
trays, clearing 180

Jetadmin, HP Web 25,  154

K
Korean EMI statement 236

L
landscape orientation, setting 61
laser safety statements 236,  237
LaserJet Scan (Windows) 83
lid, cleaning 164
light copying 198
light print, troubleshooting 190
lightness

copy contrast 73
faded print,

troubleshooting 190
fax contrast 107

lines, troubleshooting
copies 198
printed pages 191
scans 203

link speed settings 42
Linux 26
Linux drivers 7
Linux software 26
loading

staples 156
loading media

optional tray 3 50
tray 1 49
tray 2 50

logs, fax
error 134
printing all 133
troubleshooting 140

loose toner, troubleshooting 192

M
Macintosh

Configure Device 30
driver settings 28,  32
drivers supported 7
drivers, troubleshooting 208
faxing 36
faxing from 124
installing printing system for

direct connections 29
installing printing system for

networks 29
Intel Core Processor 6
PPC 6
print settings 28
problems, solving 208
removing software 30
resize documents 32
scanning from control

panel 35
scanning from TWAIN-

compliant software 84
scanning page-by-page 35
scanning to e-mail 35
scanning to file 35
support 221
supported operating

systems 6,  28
USB card,

troubleshooting 209
Macintosh Configure Device 30
Macintosh driver settings

custom-size paper 32
Services tab 34
watermarks 33

maintenance agreements 221
manual dialing 120
manual redial 122
material restrictions 230
Material Safety Data Sheet

(MSDS) 231
media

ADF, sizes supported 136
copy settings 74
curled, troubleshooting 193
custom-size, Macintosh

settings 32
default size for tray 51
document size, selecting 60
fax autoreduction settings 113
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first page 32,  59
HP ToolboxFX settings 150
jams 176
orientation, setting 61
pages per sheet 33
pages per sheet, Windows 64
printing on special media 58
select size and type 54
size, changing 75
size, selecting 60
source, selecting 60
stapling 155,  156
supported sizes 47
troubleshooting 194
type, changing 75
type, selecting 60
wrinkled 193

memory
deleting faxes 117
error messages 172
installing 160
part numbers 214
reprinting faxes 127

menu
control panel, access 11
Copy setup 12
Fax functions 11
Fax Job status 11
Fax setup 14
Network config 19
Reports 13
Service 19
System setup 17

menu map
printing 143

mercury-free product 230
messages

control panel 170
critical 174

Microsoft Word, faxing from 125
model

comparison 1
number, locating 5

modems, connecting 96
multiple pages per sheet 33,  64

N
n-up printing

Windows 64

network
configuring 19,  37
device polling 151
IP address configuration 42
link speed settings 42
operating systems

supported 38
product discovery 39
protocols supported 39
troubleshooting 206

Network config menu 19
network configuration page 41
network port

locating 5
setting up 40

network report, printing 143
Network Settings tab,

HP ToolboxFX 152
networks

HP Web Jetadmin 154
Macintosh installation 29

New Zealand telecom
statements 234

next-day on-site service 221
noise specifications 225
number of copies, changing 69

O
OCR software 85
on-site service agreements 221
on/off switch, locating 4
online support 220
operating environment,

specifications 225
operating systems supported 6,

7,  22,  28
operating systems, networks 38
optical character recognition

software 85
ordering supplies and

accessories 214
orientation, setting 61
output bins

locating 4
output quality

copy, troubleshooting 198
HP ToolboxFX settings 150

print, troubleshooting 190,
204

scans, troubleshooting 201,
203

outside lines
dial prefixes 105
pauses, inserting 100

P
packaging device 221
page-by-page scanning

(Macintosh) 35
pages

blank 196
excessive curl 195
misfeeding 195
not printing 197
skewed 193,  195

pages per sheet
Windows 64

paper
ADF, sizes supported 136
copy settings 74
curled, troubleshooting 193
custom-size, Macintosh

settings 32
document size, selecting 60
fax autoreduction settings 113
first page 32,  59
HP ToolboxFX settings 150
jams 176
pages per sheet 33
size, changing 75
size, selecting 60
source, selecting 60
stapling 155
supported sizes 47
supported types 54
troubleshooting 194
type, changing 75
type, selecting 60
wrinkled 193

paper input trays
feeding problems,

troubleshooting 195
part numbers

cables 214
memory 214
supplies 214
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trays 214
user-replaceable parts 215

parts, user-replaceable 215
password protection 103
pauses, inserting 100
PCL drivers

operating systems
supported 7

peer-to-peer printing
disclaimer 38

phone book, fax
adding entries 122
deleting all entries 100
HP ToolboxFX tab 146
importing 99

phone numbers
HP fraud hotline 158

phones
receiving faxes from 115,  128

phones, connecting extra 97
phones, downstream

sending faxes from 126
photos

copying 76
scanning 91
scanning, troubleshooting 201

physical specifications 224
pick-up rollers, ordering 215
pixels per inch (ppi), scanning

resolution 87
polling faxes 103
polling, device 151
portrait orientation, setting 61
ports

cables, ordering 214
locating 5
troubleshooting

Macintosh 209
types included 3

PostScript driver, HP ToolboxFX
settings 152

PostScript, errors 210
power

requirements 224
power consumption 224
power switch, locating 4
PPDs, Macintosh 208
ppi (pixels per inch), scanning

resolution 87
prefixes, dial 105

presets (Macintosh) 32
print cartridge area jams,

clearing 187
print cartridges

door release, locating 4
HP fraud hotline 158
Macintosh status 34
part numbers 214
recycling 158,  229
replacing 159
reusing 159
status, checking 157
status, viewing with

HP ToolboxFX 144
storing 158
warranty 219

print density
changing settings 57

print job
canceling 56

print media
supported 47

print quality
HP ToolboxFX settings 150
troubleshooting 190,  204

Print Settings tab,
HP ToolboxFX 151

printer drivers
Macintosh,

troubleshooting 208
specifications 3

printing
configuration page 142
connect to a network 40
demo page 142
direct connection to

computer 38
double-sided (duplex),

Macintosh 34
double-sided, Windows 63
edge-to-edge 74
font lists 142
Macintosh 32
menu map 143
network report 143
on different media size 60
shortcuts 62
supplies status page 142
troubleshooting 197

usage page 142
USB connection 38

priority, settings 23,  28
private receive 104
problem solving

Macintosh problems 208
PostScript errors 210

problem-solving
Windows issues 208

product
model comparison 1
serial number, locating 5

protocol settings, fax 135
protocols, networks 39
PS Emulation drivers 22
pulse-dialing 108

Q
quality

copy settings 72
copy, troubleshooting 198
HP ToolboxFX settings 150
print settings (Macintosh) 32
print settings (Windows) 205
print, troubleshooting 190,

204
scans, troubleshooting 201,

203

R
Readiris OCR software 85
receiving faxes

answer mode, setting 111
autoreduction settings 113
blocking 114
error report, printing 134
from extension phone 115
from software 112
log, HP ToolboxFX 148
polling 103
reprinting 127
ring patterns, settings 112
rings-to-answer settings 110
silence-detect mode 113
stamp-received setting 114
troubleshooting 138
when you hear fax tones 128

recommended software
installation 6
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recycling
HP printing supplies returns and

environmental program 230
recycling supplies 158
redial

manually 122
redialing

automatically, settings 106
redistribute toner 159
reducing documents

copying 70
regulatory information 228
removing Macintosh software 30
removing software

Windows 24
repacking device 221
repetitive defects,

troubleshooting 194
replacing print cartridges 159
reports

configuration page 13,  142
demo page 13,  142
fax 13
menu map 13,  143
network report 14,  143
PCL 6 font list 14
PCL font list 14
PS font list 14
service page 14
supplies status page 14,  142
usage page 14,  142

reports, fax
error 134
printing all 133
troubleshooting 140

reports, product
configuration page 41
network configuration page 41

reprinting faxes 127
resize documents

Macintosh 32
resizing documents

copying 70
resolution

fax 107,  108
scanning 87
specifications 3

restoring factory-set defaults 169
ring patterns 112

ring tones
distinctive 112

rings-to-answer setting 110
rollers, ordering 215

S
safety statements 236,  237
scale documents

Macintosh 32
scaling documents

copying 70
Scan to button, setting up 85
scanner

glass cleaning 88
glass, cleaning 72
load for copying 68
loading for scanning 82
strip, cleaning 73

scanning
black and white 88
blank pages,

troubleshooting 203
books 90
canceling 86
color 87
file formats 87
from control panel 84
from control panel

(Macintosh) 35
from HP LaserJet Scan

(Windows) 83
grayscale 88
loading ADF 82
loading flatbed scanner 82
methods 83
OCR software 85
page-by-page (Macintosh) 35
photos 91
quality, troubleshooting 201,

203
resolution 87
speed, troubleshooting 202
to e-mail (Macintosh) 35
to e-mail (Windows) 86
to file (Macintosh) 35
to file (Windows) 86
to folder (Windows) 86
to program (Windows) 86
TWAIN-compliant software 84
WIA-compliant software 84

scatter, troubleshooting 194
sending faxes

ad hoc groups 121
billing codes 109
canceling 116
delaying 126
error report, printing 134
forwarding 111
from downstream

telephone 126
from software 124
group-dial entries 123
log, HP ToolboxFX 148
manual dialing 120
speed dial 122
troubleshooting 136

separation pad, ordering 215
serial number, locating 5
service

critical error messages 174
HP ToolboxFX settings 151
HP-Authorized Dealers 220
part numbers 214
repacking device 221

service agreements 221
Service menu 19
Services tab

Macintosh 34
settings

configuration page 41
driver presets (Macintosh) 32
drivers 23,  28
factory-set defaults,

restoring 169
HP ToolboxFX 149
network configuration page 41
network printing 40
priority 23,  28
shortcuts (Windows) 62

shipping device 221
shortcuts 62
shortcuts, printing 62
silence-detect mode 113
size 224
size, copy

reducing or enlarging 70
troubleshooting 200

size, media
tray selection 54
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sizes, media
Fit to Page setting, faxing 113

skewed pages 193,  195
slow speed, troubleshooting

faxing 140
scanning 202

smeared toner,
troubleshooting 191

software
components 6
direct connection installation,

Macintosh 29
embedded Web server 25,

30
express installation 7
HP ToolboxFX 25,  144
HP Web Jetadmin 25
Linux 26
Macintosh Configure

Device 30
network installation,

Macintosh 29
Readiris OCR 85
receiving faxes 112
recommended installation 6
scanning from TWAIN or

WIA 84
sending faxes 124
settings 23,  28
Solaris 26
supported operating

systems 6,  22,  28
uninstalling Macintosh 30
UNIX 26
Windows 25
Windows components 21

Solaris software 26
special media

guidelines 48
special paper

guidelines 48
specifications

acoustic emissions 225
electrical 224
environmental 225
physical 224
product features 3

specks, troubleshooting 190

speed
fax, troubleshooting 140
scanning, troubleshooting 202

speed dials
creating 101
deleting 101
deleting all 100
editing 101
programming 122

Spool32 errors 208
spots, troubleshooting 190
staple cassette

loading 156
specifications 3

staple cassette, part
numbers 214

stapler
jams, clearing 188
loading staples 156
locating 4
supplies, part numbers 214
troubleshooting 206

staples, loading 156
stapling 155,  156
status

alerts, HP ToolboxFX 144
fax job 11
Macintosh services tab 34
supplies, checking 157
viewing with

HP ToolboxFX 144
Status tab, HP ToolboxFX 144
storing

environmental
specifications 225

print cartridges 158
streaks, troubleshooting 191
supplies

HP fraud hotline 158
recycling 158,  229
replacing print cartridges 159
reusing 159
status page, printing 142
status, checking 157
status, viewing with

HP ToolboxFX 144
storing 158

supply-status, Services tab
Macintosh 34

support
online 220
repacking device 221

supported media 47
SupportPack, HP 222
System Settings tab, 149
System setup menu 17

T
TCP/IP

operating systems
supported 38

protocols supported 39
technical support

online 220
repacking device 221

Telephone Consumer Protection
Act 233

telephone numbers
HP fraud hotline 158

telephones
receiving faxes from 115,  128

telephones, connecting extra 97
telephones, downstream

sending faxes from 126
temperature specifications

environment 225
terminology 239
text, troubleshooting 192
tone-dialing 108
toner

loose, troubleshooting 192
saving 61
scatter, troubleshooting 194
smeared, troubleshooting 191
specks, troubleshooting 190

Toolbox. See HP ToolboxFX
transfer unit warranty 219
tray 1

jams, clearing 180
loading 49
locating 4

tray 2
jams, clearing 180
loading 50
locating 4

tray 3
jams, clearing 180
loading 50
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locating 4
part number 214

trays
capacity 54
copying, changing

selection 51
default media size 51
double-sided printing 34
double-sided printing,

Windows 63
feeding problems,

troubleshooting 195
jams, clearing 180
locating 4
part numbers 214

troubleshooting
blank pages 196
blank scans 203
checklist 168
configuration page,

printing 41
control panel messages 170
control-panel display 176
copy quality 198
copy size 200
copying 200
critical error messages 174
curled media 193
dialing 137
EPS files 209
faded print 190
fax error-correction

setting 135
fax reports 140
feeding problems 195
jams 176
lines, copies 198
lines, printed pages 191
lines, scans 203
loose toner 192
network configuration page,

printing 41
networks 206
pages not printing 197
pages too dark 198
pages too light 198
paper 194
print quality 190
receiving faxes 138
repetitive defects 194

scan quality 201,  203
sending faxes 136
skewed pages 193,  195
speed, faxing 140
staple jams 188
stapler 206
text 192
toner scatter 194
toner smear 191
toner specks 190
USB cables 197
wrinkles 193

TWAIN-compliant software,
scanning from 84

types, media
HP ToolboxFX settings 150
tray selection 54

U
unblocking fax numbers 114
uninstalling

Windows software 24
uninstalling Macintosh

software 30
UNIX 26
UNIX software 26
usage page, printing 142
USB port

locating 5
Macintosh installation 29
troubleshooting 197
troubleshooting

Macintosh 209
type included 3

Use different paper/covers 59
user-replaceable parts 215

V
V.34 setting 135
vertical lines,

troubleshooting 191
vertical white or faded

stripes 198
voltage requirements 224
volume

settings 18
volume, adjusting 105

W
warning messages 170

warranty
Customer self repair 218
extended 222
print cartridge 219
product 217
transfer unit and fuser 219

watermarks 33,  61
wavy paper, troubleshooting 193
Web sites

customer support 220
HP Web Jetadmin,

downloading 154
Macintosh customer

support 221
Material Safety Data Sheet

(MSDS) 231
weekly on-site service 221
weight 224
white or faded stripes,

troubleshooting 198
WIA-compliant software, scanning

from 84
Windows

add scan-to destinations 85
driver settings 23,  62
drivers supported 7,  22
faxing from 124
pages per sheet 64
problem-solving issues 208
scanning from TWAIN or WIA

software 84
scanning to e-mail 86
scanning to folder 86
software components 21,  25
supported operating

systems 6,  22
Windows driver settings

booklets 57
Word, faxing from 125
wrinkles, troubleshooting 193
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